INTRODUCTION

This document is for Consultant and State Employees responsible for working on Capital Projects. This manual covers the preparation, review, and delivery of capital project documents across the whole project timeline from project initiation to project completion. This manual also covers design phase scheduling.

Questions or inquiries regarding the subject matter can be forwarded to the following contacts:

William Pratt P.E.
Transportation Principal Engineer
AEC Applications
william.pratt@ct.gov
860.594.3320

Bruce Bourgoin P.E.
Transportation Supervising Engineer
AEC Applications
bruce.bourgoin@ct.gov
860.594.2760

Mathew Calkins P.E.
Transportation Supervising Engineer
AEC Applications
mathew.calkins@ct.gov
860.594.2988

Revision History

Digital Project Development Manual Revision History
Table of Contents

Table of Contents .................................................................................................................. 3

DEFINITIONS .......................................................................................................................... 7

SECTION 1 PREREQUISITES AND POLICIES ........................................................................ 9

SECTION 2 CTDOT DOCUMENT MANAGEMENT SYSTEM ............................................... 10

2.1 ProjectWise .................................................................................................................... 10

2.2 ProjectWise Project Container for an Active Capital Project ........................................ 12

2.3 ProjectWise Project Folder Structure and Required Documents for Capital Projects ...... 12

2.4 Asset Areas in Projectwise ............................................................................................. 17

2.5 Setting Documents to Final Status in Projectwise ........................................................ 17

SECTION 3 DIGITAL PROJECT PROCESSES ....................................................................... 18

3.1 Processes by Project Phase ............................................................................................. 18

3.2 Digital Project Process Maps ........................................................................................ 22

3.2.1 PPI Form ................................................................................................................... 22

3.2.2 Digital Reviews ........................................................................................................ 23

3.2.3 FDP Contract Plan Processing ................................................................................ 24

3.2.4 Addenda Plans ......................................................................................................... 25

3.2.5 Design Initiated Change Order (DCO) Plans ............................................................ 26

3.2.6 Contractor Submittals ............................................................................................... 27

3.2.7 Paper Plan Order Form ........................................................................................... 27

SECTION 4 DOCUMENT PREPARATION AND FORMAT .......................................................... 28

4.1 Contract Plan Grouping .................................................................................................. 28

4.2 Contract Plan Format ..................................................................................................... 31

4.3 CTDOT For Information Only Sheets .......................................................................... 33

4.4 CTDOT Standard Plan Sheets ...................................................................................... 33

4.5 Contract Special provisions ........................................................................................... 35

4.6 Estimates and Quantity Calculations ............................................................................ 36

4.7 Environmental Permits .................................................................................................. 36

4.8 Contractor Submittals .................................................................................................... 37

4.9 Engineering Reports ...................................................................................................... 37

4.10 Project Administration and Project Correspondence Documents ............................... 38

4.11 Project Location (Geo-Spatial Boundary or Route ID and Mileage) ......................... 39

4.12 Design Calculations ...................................................................................................... 39

4.13 Electronic Engineering Data (EED) ............................................................................. 39

4.14 Contract Plan Drawing and Sheet Numbering .............................................................. 40

4.14.1 Drawing Number ..................................................................................................... 40

4.14.2 Final Plan Page Labels and Sheet Numbers ............................................................ 40

4.14.3 Addendum and Design Initiated Change Order Page Labeling and Sheet Numbers .... 45

4.15 Consolidating Contract Plan Discipline Subsets ............................................................ 47

4.15.1 When a Set File is Created and Updated .................................................................. 47

4.15.2 Creating a Set File .................................................................................................... 48

4.15.3 Updating a Set File ................................................................................................... 55

SECTION 5 DIGITAL SIGNATURES FOR CONTRACT AND OTHER ENGINEERING DOCUMENTS ................................................................. 59

5.1 Graphic Image of Signature ............................................................................................ 60

5.1.1 Contract Plans .......................................................................................................... 60

5.1.2 Engineering Reports .................................................................................................. 61

5.1.3 Working Drawings ..................................................................................................... 64

5.1.4 Other Documents ...................................................................................................... 65

5.2 Creating Graphic Image of Signature: .......................................................................... 66

5.2.1 In House CTDOT or Non-Professional Engineering Signature: ................................. 66

5.2.2 For Consultant Staff PE Stamp: ............................................................................... 66

5.3 Setting Digital Signature Appearance Preferences ......................................................... 67

5.4 Watermarking Plans with Graphic Image of Signature ................................................ 69

5.5 Digital Signature Fields ................................................................................................ 71

5.5.1 Bluebeam - Creating Digital Signature Form Fields .................................................. 72

5.6 Applying Digital Signatures ........................................................................................... 73

5.6.1 Applying Digital Signatures to 01_General Subset (FDP and Addendum Subsets) ........ 73

5.6.2 Applying a Digital Signatures to 02_Revisions Subset ............................................... 76

5.6.3 All Other Discipline Subsets - Single Signature ......................................................... 77

5.6.4 Standard Drawing Subsets – Single Signature ............................................................ 77

5.6.5 All Other Discipline Subsets – Multi-Signatures ......................................................... 77

5.6.6 Working Drawings ..................................................................................................... 78

5.6.7 Engineering Reports .................................................................................................. 78

5.6.1 Bridge Load Ratings .................................................................................................. 78
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>FDP Submittal to Processing</td>
<td>83</td>
</tr>
<tr>
<td>6.2</td>
<td>Uploading Documents</td>
<td>85</td>
</tr>
<tr>
<td>6.3</td>
<td>PDF Checker – Contract Plans</td>
<td>90</td>
</tr>
<tr>
<td>7.1</td>
<td>Addenda</td>
<td>94</td>
</tr>
<tr>
<td>7.2</td>
<td>Design Initiated Change Order (DCO)</td>
<td>97</td>
</tr>
<tr>
<td>7.3</td>
<td>02-Revisions Subset</td>
<td>102</td>
</tr>
<tr>
<td>7.4</td>
<td>Placing Stamps on Affected Sheets – Revised, or Deleted Sheets</td>
<td>106</td>
</tr>
<tr>
<td>8.1</td>
<td>As-Built Revisions (Digital Comments) Workflow</td>
<td>109</td>
</tr>
<tr>
<td>8.2</td>
<td>As-Built Markup of Contract Plans</td>
<td>110</td>
</tr>
<tr>
<td>8.3</td>
<td>Applying As-Built Comments to Contract Plans</td>
<td>111</td>
</tr>
<tr>
<td>8.4</td>
<td>Notifications</td>
<td>125</td>
</tr>
<tr>
<td>9.1</td>
<td>Introduction</td>
<td>126</td>
</tr>
<tr>
<td>9.2</td>
<td>Contractor Submittal Review Process (CTDOT/Consultant)</td>
<td>126</td>
</tr>
<tr>
<td>10.1</td>
<td>Introduction</td>
<td>144</td>
</tr>
<tr>
<td>10.2</td>
<td>Prerequisites</td>
<td>146</td>
</tr>
<tr>
<td>10.3</td>
<td>Digital Review Workflow</td>
<td>147</td>
</tr>
<tr>
<td>10.4</td>
<td>Phase 1 – Digital Document Preparation</td>
<td>148</td>
</tr>
<tr>
<td>10.5</td>
<td>Phase 2 – Set Up Digital Review</td>
<td>154</td>
</tr>
<tr>
<td>10.6</td>
<td>Phase 3 – Invitation to Review Session</td>
<td>159</td>
</tr>
<tr>
<td>10.7</td>
<td>Phase 4 – Digital Review</td>
<td>160</td>
</tr>
<tr>
<td>10.8</td>
<td>Phase 5 – Closing the Digital Review</td>
<td>174</td>
</tr>
</tbody>
</table>
DEFINITIONS

**ACD** – The attribute applied to a revision requested by the Processing unit to an ADP discipline subset.

**ACD2** – The attribute applied to a revision requested by the Processing unit to an ACD discipline subset.

**ADP** – The attribute applied to an Addendum discipline subset.

**ATLAS** – This tool is used to manage the location of various assets, projects, and investigations.

**Bluebeam** – PDF software similar to Adobe Acrobat. Bluebeam software will be required to package and markup all Shop Drawing Submittals.

**CIM** – Civil Integrated Management

**CSI** – Construction Special provisions Institute

**DCD** – The attribute applied to a revision requested by the Processing unit to an FDP discipline subset.

**DCD2** – The attribute applied to a revision requested by the Processing unit to a DCD discipline subset.

**Discipline Subset** – A multi-page PDF document that includes all the contract plan sheets for a discipline. Example would be all the structures sheets would be packaged in (1) multi-page PDF document.

**DCO** – The attribute applied to a design initiated change order discipline subset.


**EED** – Electronic Engineering Data

**Engineer of Record** – The engineer’s digital signature that is applied to the discipline subsets. For CTDOT staff this would be the Principal Engineer.

**FDP** – The attribute applied to a final design plans discipline subset.

**FIO** – The attribute applied to a “for information only” discipline subset.

**FPL** – The attribute applied to an advertised FDP discipline subset.

**Project Manager** – Lead designer on the project. For CTDOT staff this would be the TE 3 or Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.

**Projectwise** - CTDOT is currently using Bentley’s Projectwise as a data management software for digital projects and asset document storage. Projectwise allows the CTDOT, and authorized business partners to access its data anywhere internet access is available.
Set File – Is a consolidated viewer file that is created using Bluebeam. When this file is opened all of the contract plans, FDP, Addendum, Change Orders, are sorted by their page labels in the correct order.
Section 1 Prerequisites and Policies

The following details various requirements and policies that need to be followed when working on a Capital projects for the Connecticut Department of Transportation (CTDOT).

Software Requirements
2. PDF Software – CTDOT has standardized on Bluebeam for our PDF software and shall be the only PDF software supported by the Connecticut Department of Transportation for the processes set forth in this manual.
   a. Bluebeam Revu was used in the production of all figures and procedures in this manual. A license of Bluebeam Revu version 16.5 or higher must be purchased to perform all the procedures in this manual.
   b. A CTDOT Bluebeam profile has been created that includes a standard set of tools in the tool chest. This profile can be found in Appendix A of this manual.

Digital Signatures Requirements
1. All contract plans, working drawings, and applicable engineering reports submitted to the Department shall be digitally signed by a CT licensed Engineer or CT licensed Architect in accordance with this manual.
2. Digital contract plans, in the following stages: Final Design Plans (FDP), Design Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be digitally signed in conformance with this manual.
   a. Digital signatures must meet the requirements of Adobe’s Certified Document Services (CDS) or Adobe Approved Trusted List (AATL).
   b. AATL and AATL vendor information is provided at the following website: https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html
   c. Trial CDS/AATL Signatures will not be accepted by the Department, a signature must be purchased from one of the CDS/AATL Vendors.
3. Bluebeam Revu or Extreme is required for all digital signature processes. After contract plans have been advertised, the digital signature is not allowed to be removed.

CAD Standards
1. Standard Computer Aided Design (CAD) Applications shall conform to those listed here CTDOT CAD Standards Website
2. This manual is designed to be used with the latest CTDOT Digital Design Environment.

Policies
1. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using the [Digital Submission Procedure set forth in this Manual] has the same force and effect for the purposes of the Consulting Engineer’s agreement with the State as a signature and seal of a Connecticut Licensed Professional Engineer or Architect as set forth in § 20-300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the Connecticut General Statutes, as applicable. Nothing in this DPD serves as an authorization for, or endorsement of, the use of this [Digital Submission Procedure] generally by the Consulting Engineer, its subcontractor(s), or any Connecticut Licensed Professional Engineer or Architect with respect to other work it performs for the State or work it performs for other clients.
2. When on call consultants are used for CTDOT projects, the title sheet shall be digitally signed by CTDOT following the procedure in Section 5.6.1 of this manual.
3. When a document reaches a final status a “Final Status” shall be placed on the document. This will lock for editing and ensure document retention.
Section 2 CTDOT Document Management System

CTDOT is currently using Bentley’s ProjectWise as a data management software for CTDOT Capital Projects and CTDOT Assets. ProjectWise has the ability to store documents and associated business data in one centralized location and allows the CTDOT, and its authorized business partners access its data anywhere internet access is available. Projectwise access is available to all CTDOT employees, consultant engineers, contractors, municipalities, utility companies, or any other supporting agencies that work on Capital Projects or Assets for CTDOT.

The following form can be filled out to gain access to the CTDOT’s Projectwise Site: ProjectWise New User Form

Each user working at a consultant firm, contractor, municipality, utility company, and other supporting agency is given a unique user name. If a person leaves a firm, it is the firm’s responsibility to notify CTDOT so we can disable that person’s account.

The following links allow the user to change their password or reset the password if it is forgotten or lost:

- Change Projectwise Password
- Forgot or Lost Projectwise Password

2.1 ProjectWise

There are two ways to access CTDOT’s Projectwise site: Either Projectwise Thin Client (Web Version) or Projectwise Explorer Client (thick client – installed software).

**Projectwise Thin Client**

Thin client is a web based version of Projectwise, which does not require any software installation. All that is required to access Projectwise over the web is a user name and password supplied by CTDOT. Thin client allows access to the CTDOT dataset anywhere internet access is available. To use Thin Client, follow this document for the initial setup. This only needs to be done once: Thin Client First Time Set Up

After the above settings document has been followed, use this link to access Projectwise Thin Client: https://ctdot.projectwiseonline.com

**Projectwise Thick Client**

The thick client conversely requires the installation of the Projectwise client software. In addition to performing all the functions of thin client; thick client has the addition functionality:

- Delta file transfer – Improves speed of downloads
- Managed workspaces – Eliminates the need to install the CTDOT DDE
- Attributing multiple documents at once

Download Projectwise Explorer Client from Bentley using your select ID. Once Projectwise is installed on your computer use this document to connect to the datasource: Connecting to Datasource Using Thick Client
Projectwise Apps
Users can also get to CTDOT’s Projectwise datasource using the various applications. These applications require a URL to connect to a Projectwise datasource. The table below lists the server URL for each application:

<table>
<thead>
<tr>
<th>Applications</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projectwise</td>
<td>ctdot-ws.projectwiseonline.com/pwmobileaccess</td>
</tr>
<tr>
<td>WorkSite</td>
<td><a href="https://Ctdot-ws.projectwiseonline.com/ws">https://Ctdot-ws.projectwiseonline.com/ws</a></td>
</tr>
<tr>
<td>Projectwise Edge</td>
<td></td>
</tr>
</tbody>
</table>

Access in Projectwise
Access to content in Projectwise is set at the folder level based on the group a user is in. The following details, at a high level, the access for the various groups. Section 2.3 of this document provides more information for the folders mentioned below:

- **CTDOT Employees** - Access to all projects and all asset content.
- **Consultants and CE & I Firms**
  - **Active Projects** – Can only access projects that the firm is working on.
  - **Legacy Projects** – Access to all the legacy projects.
  - **Assets** – Access for asset content if firm is pre-qualified to work on that asset based on CTDOT’s pre-qualified consultant lists.
- **Contractors**
  - No Access to Projectwise
- **Municipalities**
  - **Active Projects** – Can only access projects in their town.
  - **Legacy Projects** – Access to all the legacy projects.
  - **Assets** – No access to asset content.
- **Utility Companies**
  - **Active Projects** – Can only access projects that a firm is working on.
  - **Legacy Projects** – Access to all the legacy projects.
  - **Assets** – No access to asset content.
- **Other Supporting Agencies**
  - **Active Projects** – Can only access projects that an agency is working on.
  - **Legacy Projects** – Access to all the legacy projects.
  - **Assets** – No access to asset content.
2.2 Projectwise Project Container for an Active Capital Project

Projectwise is setup to automatically create a project container for any project that is added to the Obligation Plan. This automatic process runs on a nightly basis. CTDOT employees will have access to all projects, but access for consultants, municipalities or other agencies must be requested by the Consultant Liaison Engineer. The Consultant Liaison Engineer can request access for these groups by emailing: Julie.Annino@ct.gov

2.3 Projectwise Project Folder Structure and Required Documents for Capital Projects

This section details the Projectwise project folder structure and the required project documents that must be submitted for each project. Section 3 of this manual details the processes for each contract document. The figure below shows the folder structure for a Capital Project: If the project container does not look like the following, contact DOT.AECapplications@ct.gov

```
  CT DOT Project Template Jan 2011
    100 Contract Plans (PDF)
    110 Contract Documents
    120 Contractor Submittals (PDF)
    130 Final Engineering Reports
    131 Engineering Reports Confidential
    140 Project Administration
    141 Project Administration Confidential
    142 Project Administration Correspondence
    150 Quantity Calculations
    151 Final Design Calculations
    160 Project Photos
    170 ROW Files
    210 Construction
      01 - Project Documents
      02 - Internal Documents
      03 - Measurements and Payments
    220 FHWA
    230 Contract Administration
    240 Contract Development
    241 Contract Development Confidential
    210 Milestone Submissions
      20% Review
      60% Review
      90% Review
      100% Review
    320 Permit Development
    330 Design Data
      DOT Confidential
      Environmental Planning
    40 Facilities
      Highway Ops
      Highways
      Hydraulics
      Landscape
      Maintenance
      Public Trans
      Rights of Way
      Soils
      Structure Bridge
      Traffic
      Utilities
    2 Z Project Data
    500 Survey
      01 Central Survey
      02 District Survey
      03 Consultant Survey
      04 Survey Transfer
    500 Project Initiation Documents
```

Figure 1 - Capital Project Folder Structure
Note: In the case where two or more projects are combined or advertised as (1) project, all contract documents for these projects will be submitted into the lowest numbered project in Projectwise.

<table>
<thead>
<tr>
<th>Projectwise Folder Structure and List of Project Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>100_Contract Plans (PDF)</strong> – This folder contains only final Contract Plans, which includes the following:</td>
</tr>
<tr>
<td>There shall not be any working documents uploaded into this folder.</td>
</tr>
<tr>
<td>- Final plans</td>
</tr>
<tr>
<td>- Addendum plans</td>
</tr>
<tr>
<td>- Design Initiated Change Order plans</td>
</tr>
<tr>
<td>- As-Built plans</td>
</tr>
<tr>
<td>- Electronic Engineering Data (EED) – Final Prepared by AEC Applications</td>
</tr>
<tr>
<td><strong>110_Contract Documents (PDF)</strong> – This folder shall only contain the following final documents. There shall not be any working documents uploaded into this folder.</td>
</tr>
<tr>
<td>- Signed Contract</td>
</tr>
<tr>
<td>- Environmental Permit Applications/Approvals</td>
</tr>
<tr>
<td>- Pre-Bid Questions and Answers</td>
</tr>
<tr>
<td>- Contract Special Provisions – Final, Addendum, and Change Order special provisions</td>
</tr>
<tr>
<td>- State and Federal Minimum Wage Rates and Classifications.</td>
</tr>
<tr>
<td>- SOM (Source of Materials)</td>
</tr>
<tr>
<td>- Insurance documents</td>
</tr>
<tr>
<td>- Pre-Award DBE Review – Specific Contractor</td>
</tr>
<tr>
<td>- Bonds</td>
</tr>
<tr>
<td><strong>120_Contractor Submittals (PDF)</strong> – This folder contains the following:</td>
</tr>
<tr>
<td>- Working drawings</td>
</tr>
<tr>
<td>- Shop drawings</td>
</tr>
<tr>
<td>- Product data submittals</td>
</tr>
<tr>
<td>- RFCs</td>
</tr>
<tr>
<td><strong>121_Contractor RFIs</strong> – This folder contains the following:</td>
</tr>
<tr>
<td>- RFIs</td>
</tr>
<tr>
<td><strong>122 Contractor Closeout Documents</strong> – This folder contains contractor closeout documents.</td>
</tr>
<tr>
<td>- Operation and Maintenance Manuals</td>
</tr>
<tr>
<td>- Warranties</td>
</tr>
<tr>
<td><strong>130_Engineering Reports</strong> – This folder contains all the final engineering reports. There shall not be any working documents uploaded into these folders.</td>
</tr>
<tr>
<td>- Hydraulic</td>
</tr>
<tr>
<td>- Hydraulic Report and Hydraulic Report Data</td>
</tr>
<tr>
<td>- Scour Report and Scour Report Data</td>
</tr>
<tr>
<td>- Floodway Report and Floodway Report Data</td>
</tr>
<tr>
<td>- Final Drainage Reports and Final Drainage Report Data</td>
</tr>
<tr>
<td>- USGS Bridge and Channel Assessment Reports</td>
</tr>
<tr>
<td>- Miscellaneous Technical Data, Studies, Investigations or Reports</td>
</tr>
<tr>
<td>- Environmental Compliance</td>
</tr>
<tr>
<td>- Task 110</td>
</tr>
<tr>
<td>- Task 210</td>
</tr>
<tr>
<td>- Task 310</td>
</tr>
<tr>
<td>- Underground Storage Tank System Closure Reports</td>
</tr>
<tr>
<td>- Bridge</td>
</tr>
<tr>
<td>- Load Rating</td>
</tr>
<tr>
<td>- Geotechnical</td>
</tr>
<tr>
<td>- Geotechnical Report Project files - including test boring, laboratory testing data file, and computations</td>
</tr>
</tbody>
</table>
**Projectwise Folder Structure and List of Project Documentation**

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>131_Engineering Reports Confidential</strong></td>
<td>This folder is only seen by a select number of people.</td>
</tr>
<tr>
<td>• Bid Analysis</td>
<td></td>
</tr>
<tr>
<td><strong>140_Project_Administration_Documents</strong></td>
<td>This folder is for final permanent milestone project administration documents. These project administration documents can be defined as, but not limited to, deliverables such as agreements, project approvals, project scope, regulatory documents, design phase schedules, etc. There shall not be any draft documents uploaded into this folder.</td>
</tr>
<tr>
<td>• Agreements – Utility, Railroad, Municipal, etc.</td>
<td></td>
</tr>
<tr>
<td>• Categorical Exclusion</td>
<td></td>
</tr>
<tr>
<td>• Certification Acceptance Checklist</td>
<td></td>
</tr>
<tr>
<td>• Commitment list</td>
<td></td>
</tr>
<tr>
<td>• Consultant Selection Documents – Scope of Services, Notice to Proceed, etc.</td>
<td></td>
</tr>
<tr>
<td>• Construction Incidental Cost Establishment Report</td>
<td></td>
</tr>
<tr>
<td>• DBE/SBE Approval with percentage, participation level</td>
<td></td>
</tr>
<tr>
<td>• Design Approval</td>
<td></td>
</tr>
<tr>
<td>• Design Exceptions</td>
<td></td>
</tr>
<tr>
<td>• Design Phase Microsoft Project Schedule</td>
<td></td>
</tr>
<tr>
<td>• Environmental Impact Study – EIS</td>
<td></td>
</tr>
<tr>
<td>• Final Design Report</td>
<td></td>
</tr>
<tr>
<td>• Finding of No Significant Impact - FONSI</td>
<td></td>
</tr>
<tr>
<td>• Lighting Agreement</td>
<td></td>
</tr>
<tr>
<td>• Record of Decision – ROD</td>
<td></td>
</tr>
<tr>
<td>• Rehabilitation Study Report</td>
<td></td>
</tr>
<tr>
<td>• Risk Management Documents</td>
<td></td>
</tr>
<tr>
<td>• RPM – Request for Project Memorandum</td>
<td></td>
</tr>
<tr>
<td>• Sidewalk Maintenance Agreement</td>
<td></td>
</tr>
<tr>
<td>• Standalone Transportation Management Plan Document, taken from the final design report</td>
<td></td>
</tr>
<tr>
<td>• Stewardship Agreement</td>
<td></td>
</tr>
<tr>
<td>• Structure Type Study</td>
<td></td>
</tr>
<tr>
<td>• Waiver to Obligate Funds</td>
<td></td>
</tr>
<tr>
<td>• White Papers</td>
<td></td>
</tr>
<tr>
<td><strong>141_Project Administration Confidential</strong></td>
<td>This folder shall be used for documents that only CTDOT should have access to.</td>
</tr>
<tr>
<td>• Consultant Payroll information</td>
<td></td>
</tr>
<tr>
<td><strong>142_Project Administration Correspondence</strong></td>
<td>This folder is for all final project correspondence documents. This is defined as any request memos, response memos, letters, etc, and does not include any documents that are defined in the 140_Project Administration folder. This folder shall not include any working/draft documents.</td>
</tr>
<tr>
<td>• Meeting Minutes</td>
<td></td>
</tr>
<tr>
<td>• Request Memos – Survey Request, Design Reviews, Support unit design.</td>
<td></td>
</tr>
<tr>
<td>• Response Memos – Response to the Request Memos</td>
<td></td>
</tr>
<tr>
<td><strong>150_Quantity Calculations</strong></td>
<td>This folder is where all the final quantity calculations for contract items shall be stored.</td>
</tr>
<tr>
<td><strong>151_Final Design Calculations</strong></td>
<td>This folder is where all the final design calculations shall be stored.</td>
</tr>
<tr>
<td><strong>160_Project Photos</strong></td>
<td>This folder is where all project photos shall be stored. Both engineering and construction photos shall be stored in this folder.</td>
</tr>
<tr>
<td><strong>170_ROW and GIS Files</strong> -**</td>
<td>This folder is where the final property maps shall be stored until they are uploaded into the IRMS. Also the project polygons and parcel polygons file shall be stored here.</td>
</tr>
<tr>
<td><strong>210_Construction Folders</strong></td>
<td>See Construction Documentation for more information</td>
</tr>
<tr>
<td>• 01 – Project Documents</td>
<td></td>
</tr>
<tr>
<td>o Semi and Monthly Payment Estimates</td>
<td></td>
</tr>
</tbody>
</table>
**Projectwise Folder Structure and List of Project Documentation**

- Construction Orders with Backup
- Copies of Cost-Plus Sheets with backup
- All Delivery Tickets, Bituminous Concrete, Processed Aggregate Base, Concrete, etc.
- Material Certifications, etc. (All Laboratory Reports)
- Nuclear Density Test and Data Sheets (CON-125, 133)
- Pile Driving Logs (CON-87)
- Environmental Correspondence, Logs, etc.
- Utility Forms (CON-40 and 41)
- Contractor Payrolls
- EEO/AA Reports (30-60-90s)
- Labor Wage Checks (CON-131)
- Hazardous Waste Manifests
- Stores Requisitions and Transfer Vouchers
- Purchase Orders and Requisitions
- Correspondence
- Consultants Billings with Backup
- Computer Disks - properly labeled
- Any Other Related Records
- Town Correspondence File - Includes:
  - General Material
  - Request for and response to matters concerning highway, bridge, signing, lighting, etc. by town officials
  - Written commitments to first officials and/or elected, appointed state, federal officials
  - Mapping Prepared by district or filed with district

- **02 - Internal Documents**
  - Consultant Ratings
  - Other Sensitive Documents

- **03 – Measurements and Payments**
  - Field Books (all) Volumes 1,2,3,& 4s

220_FHWA – This folder is used by the FHWA for their purposes

230_Contract Administration – This folder is used by the CTDOT Contracts unit.

240_Contract Development – This folder contains the paper plan order form and the location where the Designer uploads the following supplemental contract documents:

- All contract special provisions and Notice to Contractors (NTC), in word format, both final and addendum special provisions
- Estimator Proposal Estimate
- Calendar Day Estimate
- Electronic Engineering Data Files uploaded by the Designer

241_Contract Development Confidential – This folder contains the final engineers estimate and calendar day estimate developed by the cost estimating unit.

- Final Engineers Estimate
- Final Calendar Day Estimate

310_Milestone_Submissions – The designer shall submit all milestone submission documents into this folder. This includes plans, special provisions, reports, estimates, etc. This folder has sub-folders for 30%, 60%, 90%, and 100% submissions

320_Permit_Development – This folder can be used to store documents for the development of permits. Note: At FDP, the permit applications and approvals must be uploaded into the 240 Contract Documents folder. The processing unit then adds the permits and applications to the contract and uploads the contract into the 110 Contract Documents folder.
### Projectwise Folder Structure and List of Project Documentation

- Permits Needs Determination Form (PNDF)
- Wetland Flagging Coordination
- Natural Diversity Database (NDDB) Coordination
- CTDEEP Fisheries Correspondence
- LEAN Meeting Minutes
- Project Manager Meeting (PMM) Minutes
- Permit Review Comments
- Responses to Permit Review Comments

#### 330_Design_Data
- This area is used for working on documents such as letters, memos, etc. and working on CAD files. Under this folder there are discipline specific sub-folders that provide each discipline an area prepare their design documents. The DOT Confidential subfolder shall be used to work on draft confidential documents.

#### 500_Survey
- **01_Central_Surveys** – This folder is where the approved survey files will be stored for use by design.
- **02_District_Surveys** – This folder is used by the district survey units. The files stored in this folder are considered working files.
- **03_Consultant_Survey** – This folder is used to store consultant survey information.
- **04_Survey_Transfer** – This folder is used by District Survey units to transfer their completed survey files to Central Surveys. Central Surveys will review the files in this folder and then when they are found acceptable, the files will be transferred into the 01_Central Survey folder for use by design.

#### 600_Project_Initiation_Documents
- This folder is where any project initiation documents can be stored. This would include any plans developed by the Project Concepts unit or any other documents created in the project concepts phase.
2.4 Asset Areas in Projectwise

Projectwise is also being used to store all asset related documentation and asset information. The following details the assets and documents are being stored for that asset:

- **02.0 – Assets – Bridges**
  - Inspection Reports
  - Fracture Critical Reports
  - Maintenance Memos
  - Load Ratings not performed for a Capital Project

- **02.1 – Assets – Bridges (under 20’ Town owned)**
  - Inspection Reports

- **02.2 – Assets – Signal Intersections**
  - Signal Plans – Active and Legacy

- **02.3 – Assets – Sign Structures**
  - Inspection Reports

- **02.4 – Assets – Towns**
  - Office State Traffic Administration (OSTA) documents
  - Bridge Safety Town Letters

- **02.5 – Assets – Buildings**
  - Building Inspection Reports

- **02.6 – Assets Radio Towers**
  - Inspection Reports

- **02.7 – Asset – Railroad Crossing Signals**
  - Inventory document that provides detail for the crossing.
  - Photos

2.5 Setting Documents to Final Status in Projectwise

Once a document has reached its final status, where no more editing is required and it is ready for permanent storage a final status will be applied to the document as shown below:

1. Right click on the file and select Change State>Set Final Status.

This will lock the file so no one can delete it. If a user needs to remove the final status contact DOT.AECApplications@ct.gov
### Section 3  Digital Project Processes

#### 3.1 Processes by Project Phase

The following shows the processes included in this manual separated by project phase. Also included in this table is a link to the process map that corresponds to each document/process:

<table>
<thead>
<tr>
<th>Project Initiation Phase</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPI Process</td>
<td>● See section 14 of this manual.</td>
</tr>
<tr>
<td>Project Schedule</td>
<td>● Project Schedule should be set up in accordance with Section 11</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Preliminary Design Phase</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preliminary Contract Plans</td>
<td>● Plans shall be grouped in accordance with Section 4.1</td>
</tr>
<tr>
<td></td>
<td>● Plans shall be formatted in accordance with Section 4.2</td>
</tr>
<tr>
<td>Preliminary Contract Special Provisions</td>
<td>● Contract Special Provisions shall be prepared in accordance with Section 4.5</td>
</tr>
<tr>
<td>Cost Estimate</td>
<td>● Cost Estimates shall be prepared in accordance with Section 4.6</td>
</tr>
<tr>
<td>Preliminary Design (30%) Review</td>
<td>● Design Reviews shall be accomplished in accordance with Section 10</td>
</tr>
<tr>
<td>Project Schedule</td>
<td>● Project Schedule should be set up in accordance with Section 11</td>
</tr>
<tr>
<td>Permit Applications/Documents</td>
<td>● Shall be uploaded and formatted in accordance with Section 4.7</td>
</tr>
<tr>
<td>Rehabilitation Study Reports</td>
<td>● Shall be uploaded and formatted in accordance with Section 4.9</td>
</tr>
<tr>
<td>Structure Type Studies</td>
<td>● Shall be uploaded and formatted in accordance with Section 4.9</td>
</tr>
<tr>
<td>Categorical Exclusion</td>
<td>● Shall be uploaded and formatted in accordance with Section 4.10</td>
</tr>
<tr>
<td>Design Exception</td>
<td>● Shall be uploaded and formatted in accordance with Section 4.10</td>
</tr>
<tr>
<td>Design Approval Letter</td>
<td>● Shall be uploaded and formatted in accordance with Section 4.10</td>
</tr>
<tr>
<td>Project Correspondence</td>
<td>● Shall be uploaded and formatted in accordance with Section 4.10</td>
</tr>
<tr>
<td>Project Polygon</td>
<td>● Shall be prepared and uploaded in accordance with section 4.11</td>
</tr>
</tbody>
</table>
## Final Design Phase

<table>
<thead>
<tr>
<th>Document/Process</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Plans</td>
<td>• Plans shall be grouped in accordance with <a href="#">Section 4.1</a></td>
</tr>
<tr>
<td></td>
<td>• Plans shall be formatted in accordance with <a href="#">Section 4.2</a></td>
</tr>
<tr>
<td>Contract Special Provisions</td>
<td>• Special Provisions shall be prepared in accordance with <a href="#">Section 4.5</a></td>
</tr>
<tr>
<td>Engineering Reports</td>
<td>• Engineering Reports shall be prepared in accordance with <a href="#">Section 4.9</a></td>
</tr>
<tr>
<td>Project Schedule</td>
<td>• Project Schedule should be set up in accordance with <a href="#">Section 11</a></td>
</tr>
<tr>
<td>Cost Estimate</td>
<td>• Preliminary Cost Estimates shall be prepared in accordance with <a href="#">Section 4.6</a></td>
</tr>
<tr>
<td>Permit Applications/Approvals</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.7</a></td>
</tr>
<tr>
<td>Design Calculations</td>
<td>• Design Calculations shall be submitted in accordance with <a href="#">Section 4.13</a></td>
</tr>
<tr>
<td>Semi Final (60%) and Final Design (90%) Reviews</td>
<td>• Design Reviews shall be accomplished in accordance with <a href="#">Section 10</a></td>
</tr>
<tr>
<td>Quantity Calculations</td>
<td>• Quantity Calculations shall be submitted in accordance with <a href="#">Section 4.6</a></td>
</tr>
<tr>
<td>Final Design Report</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a></td>
</tr>
<tr>
<td>Final Design Statement</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a></td>
</tr>
<tr>
<td>Sidewalk Maintenance Agreement</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a></td>
</tr>
<tr>
<td>Lighting Agreement</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a></td>
</tr>
<tr>
<td>DBE/SBE Goals</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a></td>
</tr>
<tr>
<td>Commitment List</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a></td>
</tr>
<tr>
<td>Waivers</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a></td>
</tr>
<tr>
<td>Standalone Transportation Management Plan</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a></td>
</tr>
<tr>
<td>Project Correspondence</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a></td>
</tr>
<tr>
<td>Document/Process</td>
<td>Requirements</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------</td>
</tr>
<tr>
<td><strong>FDP</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Contract Plans   | • Plans shall be grouped in accordance with Section 4.1  
|                  | • Plans shall be formatted in accordance with Section 4.2  
|                  | • Plans shall be checked by the PDF checker in accordance with Section 6.2 |
| Contract Special Provisions | • Special Provisions shall be prepared in accordance with Section 4.5 |
| Proposal Estimate | • Preliminary Cost Estimates shall be prepared in accordance with Section 4.6 |
| Federal Estimate | • Preliminary Cost Estimates shall be prepared in accordance with Section 4.6 |
| Calendar Day Estimate | • Calendar Day Estimate shall be prepared in accordance with Section 4.6 |
| Permit Applications/Approvals | • Shall be uploaded and formatted in accordance with Section 4.7 |
| Ordering Paper Copies of Contract Documents | • Paper copies of contract documents can be ordered in accordance with Section 3.2.11 |
| EED              | • Shall be prepared and uploaded in accordance with Section 4.14 |
| Project Polygon  | • Shall be prepared and uploaded in accordance with section 4.11 |
| **DCD**          |              |
| Contract Plans   | • Plans shall be grouped in accordance with Section 4.1  
|                  | • Plans shall be formatted in accordance with Section 4.2  
<p>|                  | • Plans shall be checked by the PDF checker in accordance with Section 6.2 |
| Contract Special Provisions | • Special Provisions shall be prepared in accordance with Section 4.5 |
| Proposal Estimate | • Preliminary Cost Estimates shall be prepared in accordance with Section 4.6 |
| Federal Estimate | • Preliminary Cost Estimates shall be prepared in accordance with Section 4.6 |
| Calendar Day Estimate | • Preliminary Cost Estimates shall be prepared in accordance with Section 4.6 |
| Permit Applications/Approvals | • Shall be uploaded and formatted in accordance with Section 4.7 |
| <strong>Addendum</strong>     |              |
| Contract Plans   | • Plans shall be prepared in accordance with Section 7.1 |
| Contract Special Provisions | • Special Provisions shall be prepared in accordance with Section 7.1.5 |
| EED              | • Shall be prepared and uploaded in accordance with Section 4.13 |
| <strong>Award Phase</strong>  |              |
| Signed Contract  | • Signed Contract will be uploaded into Projectwise in accordance with section xx. |</p>
<table>
<thead>
<tr>
<th>Document/Process</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contractor Submittals</td>
<td>• Contractor submittals shall be uploaded in accordance with <a href="#">Section 9</a></td>
</tr>
<tr>
<td>Contract Plans</td>
<td>• Plans shall be prepared in accordance with <a href="#">Section 7.2</a></td>
</tr>
<tr>
<td>Contract Special Provisions</td>
<td>• Special Provisions shall be prepared in accordance with <a href="#">Section 7.2.5</a></td>
</tr>
<tr>
<td>DCO Memo</td>
<td>• DCO memo shall be prepared in accordance with <a href="#">Section 7.2.6</a></td>
</tr>
<tr>
<td>Plan As-Builts</td>
<td>• Plan As-Builts shall be accomplished in accordance with <a href="#">Section 8</a></td>
</tr>
<tr>
<td>Project Correspondence</td>
<td>• Shall be uploaded and formatted in accordance with <a href="#">Section 4.10</a></td>
</tr>
<tr>
<td>EED</td>
<td>• Shall be prepared and uploaded in accordance with <a href="#">Section 4.13</a></td>
</tr>
<tr>
<td>Project Polygon</td>
<td>• Shall be prepared and uploaded in accordance with <a href="#">section 4.11</a></td>
</tr>
</tbody>
</table>
3.2 Digital Project Process Maps

This section provides high level process maps for the procedures detailed in this manual.

3.2.1 PPI Form

Click Here for Formatting and Submittal Requirements
3.2.2 Digital Reviews

Click here to go to the Digital Review Section

Digital Reviews

Creates review documents and upload into the 310_Review Documents folder in Projectwise.

Create a Bluebeam Studio Review session that includes all the necessary documents located in the 310_Review Documents folder in Projectwise.

Send out invitation to participate in the Bluebeam Studio Review Session

Join review session and comment on review documents.

Close Bluebeam Studio Review session. When the session is closed all the review comments are transferred to the documents stored in the 310_Review Documents folder in Projectwise.

Add resolutions to all comments placed on the review documents located in the 310_Review Documents folder in Projectwise.
3.2.3 FDP Contract Plan Processing

Click Here for Formatting and Submittal Requirements

---

Final Design Plans (Discipline Subsets)

Submit FDP subsets into the 100 Contract Plans Folder in Projectwise.

Change FDP subsets to the Processing State and mark up with comments as necessary.

Revision Required

Yes

Create a new subset(s) with the required changes and submit DCD, DCD2, etc., subsets into the 100 Contract Plans Folder in Projectwise.

Change DCD subsets to the Processing State, perform a document compare between the FDP and DCD subsets and mark up with comments as necessary.

Revision Required

Yes

No

State Designed Project

Yes

Change the Sub-Category Attribute on all the subsets to PTL and delete all previous subset versions (FDP, DCD, etc.)

No

Change the state of all the subsets into the Manager and Engineering Admin State and notify the designer that the title sheet of the project can be digitally signed.

Title sheet is signed and the designer notifies Processing

Change the state of all the subsets into the Contracts state and notify Contracts that the subsets have been approved for Advertising

Change the state of the subsets to the Advertise state and export the files out to be posted to the DAS Portal for Advertising.

Designer

Processing

Contracts

---

3.2.4 Addenda Plans

Click Here for Formatting and Submittal Requirements

Addendum Plans (Discipline Subsets)

- Submit ADP subsets into the 100 Contract Plans Folder in Projectwise.
- Change ADP subsets to the Processing State and mark up with comments as necessary.
  - Revision Required
    - Yes
      - Create a new subset(s) with the required changes and submit ACD, ACD2, etc. subsets into the 100 Contract Plans Folder in Projectwise.
    - No
      - Change ACD subsets to the Processing State, perform a document compare between the ADP and ACD subsets and mark up with comments as necessary.
  - Revision Required
    - Yes
      - Change the Sub-Category Attribute on all the subsets to AOP and delete all previous subset versions (ACD, ACD2, etc.)
    - No
      - Change the state of all the subsets into the Contracts state and notify Contracts that the subsets have been approved for Advertising
        - Notify the designer that the subsets have been approved for Advertising and the Red Xs can be placed on the revised sheets.
        - Place Red Xs on the revised sheets.
  - Change the state of the subsets to the Advertise state and export the files out to be posted to the DAS Portal for Advertising
3.2.5 Design Initiated Change Order (DCO) Plans

Click Here for Formatting and Submittal Requirements

**Design Initiated Change Order (DCO) Plans (Discipline Subsets)**

- Submit DCO subsets into the 100 Contract Plans Folder in Projectwise.
- When the DCO plans are to be released to the contractor, the state of the plans shall be changed to Contractor.
- Notify the Contractor and Designer that the DCO plans have are available.

Place red Xs on the revised sheets.

Open DCO Plans from Projectwise

Designer  Construction  Contractor
3.2.6 Contractor Submittals

See section 9 for detailed instructions. Process maps for Shop Drawings, Working Drawings, Product Data Sheets, and RFIs are in development.

3.2.7 Paper Plan Order Form

The Paper Plan Order Form was created to allow each unit in the Department to order contract plans and special provisions for DOT Projects. This form is located in each project in Projectwise and each unit in the Department that needs paper copies of contract plans and special provisions is required to update this form for their paper needs. This form is then used by the Department’s Engineering Records unit to make the prints and send them out.

Any Addendum or Change Order that is submitted for a project will be printed and sent out using the information indicated on the form. Addendums will be printed and sent out automatically. When a Change Order is submitted, the designer must notify Engineering records that a Change Order has been submitted and that paper copies of the Change Order need to printed and sent to the applicable units indicated on the Paper Plan Order Form.

This following shows the procedure for how the Paper Plan Order Form is filled out and the prints are made. Contact Information for Engineering Records:  **Print Shop: 860-594-3086 Plan and Specification Printing**

<table>
<thead>
<tr>
<th>Step</th>
<th>Project Stage</th>
<th>Group</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FDP</td>
<td>Processing</td>
<td>After the contract plans and special provisions have been submitted for FDP an email is sent to each unit in the Department that requires paper copies of contract plans and special provisions.</td>
</tr>
<tr>
<td>2</td>
<td>FDP</td>
<td>Units</td>
<td>Open the Paper Plan Order Form from Projectwise and fill out the form for their unit’s needs. Save the form and check the form back into Projectwise.</td>
</tr>
<tr>
<td>3</td>
<td>DCD</td>
<td>Processing</td>
<td>At DCD, lock the form by placing it in the Processing state.</td>
</tr>
<tr>
<td>4</td>
<td>Advertise</td>
<td>Contracts</td>
<td>Notify Engineering Records that the project is going to be advertised and they can print the required paper copies indicated on the Paper Plan Order Form.</td>
</tr>
<tr>
<td>5</td>
<td>Advertise</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form.</td>
</tr>
<tr>
<td>6</td>
<td>All Addendums</td>
<td>Contracts</td>
<td>Notify Engineering Records that an Addendum is going to be advertised and they can print the required paper copies indicated on the Paper Plan Order Form for this Addendum. Make sure to tell Engineering Records which subsets are included in the Addendum.</td>
</tr>
<tr>
<td>7</td>
<td>All Addendums</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form for the Addendum. Make sure to print all the subset that were affected by the Addendum including the 02-Revisions subset.</td>
</tr>
<tr>
<td>8</td>
<td>All Change Orders</td>
<td>Lead Designer</td>
<td>Notify Engineering Records that a Change Order has been submitted and they can print the required paper copies indicated on the Paper Plan Order Form. Make sure to tell Engineering Records which subsets are included in the Change Order. If a unit is not listed on the Paper Plan Order Form, give Engineer Records those units’ contact information so those units’ can receive a copy of the Change Order.</td>
</tr>
<tr>
<td>9</td>
<td>All Change Orders</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form for the Change Order and for any other units’ requested by the Lead Designer. Make sure to print all the subsets that were affected by the Change Order including the 02-Revisions subset.</td>
</tr>
</tbody>
</table>
Section 4  Document Preparation and Format

4.1 Contract Plan Grouping

Contract plans shall be grouped, by discipline into individual multiple page PDF files called discipline subsets. The project manager is tasked with determining the discipline subset numbering and grouping and whether to use a single volume or multiple volumes for the project. The number of sheets in a discipline subset shall contain a maximum of 150 sheets. The following details each of these options:

**Single volume** digital contracts are used when each discipline or consulting firm designing the project is responsible for 3 subsets or less. The following is an example of a single volume project.

Note: The first and second subsets shall always be 01-General and 02-Revisions. The 03 subset does not always need to be 03-Highways, the 04 does not always need to be 04-Structure, etc. FIO subsets shall be numbered at the end of the project before the standard subsets. The Standards subsets shall not be numbered.

**Multiple volumes** are used if the project has 1 or more of the following characteristics:

a. The majority of the discipline/firm designers are responsible for more than 3 subsets each. This allows the individual designers to number their subsets independently of the other disciplines.

b. There are multiple sites on the project. Splitting these sites up into volumes will provide better organization of the project.

c. Combining multiple projects into one project.

The larger the project is, typically the more subsets will be required and their labels will be more specific. The subsets shall be split up by volume and each volume shall be controlled by its assigned designer. For example, all the subsets designed by the highway designer shall be in the same volume (02) and each subset shall have a unique subset number.

Note: The first and second subsets when using multiple volumes shall always be 01.01-General and 01.02-Revisions. The 01.03 subset does not always need to be 01.03-Highways, the 01.04 does not always need to be 01.04-Structure, etc. FIO subsets shall be numbered at the end of the project before the standard subsets. The Standards subsets shall not be numbered.

**Combining Projects**

In the event 2 or more projects are combined into one project, the following shall be done:

- Each project shall be given its own volume.
- The lowest project shall always be volume 1.
- Each project shall have its own title sheet, which reference each other with a note.
- There shall only be (1) Revisions subset. This subset shall be in volume 1 and named 01.02 – Revisions.
- The Revisions subset shall be the responsibility of the project manager on the projects.
- Each project shall have its own detailed estimate sheets.
- There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when the projects are combined.
- There shall not be any duplicate special provisions after the projects are combined.
- There shall only be (1) calendar day chart.
The next two figures show examples of the single volume and multiple volume options.

**Single Volume Option**

<table>
<thead>
<tr>
<th>Label (Discipline Subset)</th>
<th>File contents (but not limited to)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-General</td>
<td>Title Sheet</td>
</tr>
<tr>
<td></td>
<td>Detail Estimate Sheet</td>
</tr>
<tr>
<td>02-Revisions</td>
<td>Index of Revisions Sheets</td>
</tr>
<tr>
<td>03-Highways</td>
<td>Index of Plans</td>
</tr>
<tr>
<td></td>
<td>Survey Data</td>
</tr>
<tr>
<td></td>
<td>Alignments</td>
</tr>
<tr>
<td></td>
<td>ROW</td>
</tr>
<tr>
<td></td>
<td>Typ Sections</td>
</tr>
<tr>
<td></td>
<td>Misc Details</td>
</tr>
<tr>
<td></td>
<td>Intersect Grading</td>
</tr>
<tr>
<td>04-Structure</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>All Structure Sheets</td>
</tr>
<tr>
<td></td>
<td>Note: Multiple subsets may be required for multiple Sites</td>
</tr>
<tr>
<td></td>
<td>Ex: 04_Structure_Br.No.1266</td>
</tr>
<tr>
<td>05-Traffic</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>Signing</td>
</tr>
<tr>
<td></td>
<td>Pavement Markings</td>
</tr>
<tr>
<td></td>
<td>MPT</td>
</tr>
<tr>
<td></td>
<td>Traffic Signal Plans</td>
</tr>
<tr>
<td></td>
<td>Etc.</td>
</tr>
<tr>
<td>06-Environmental</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>All Environmental Compliance Sheets required</td>
</tr>
<tr>
<td>07-Utility</td>
<td>Utility Design plans. For example 07_AT &amp; T, 07_CL &amp; P, 07_MDC, etc.</td>
</tr>
<tr>
<td>08-CL&amp;P FIO**</td>
<td>CL &amp; P For Information Only plans</td>
</tr>
<tr>
<td>09-AT&amp;T FIO**</td>
<td>AT &amp; T For Information Only plans</td>
</tr>
<tr>
<td>CTDOT Highway STD</td>
<td>CTDOT Highway Design Standard Index and Sheets required</td>
</tr>
<tr>
<td>CTDOT Traffic STD</td>
<td>CTDOT Traffic Engineering Standard Index and Sheets required</td>
</tr>
</tbody>
</table>

* If a discipline has to be broken up into more than one subset, keep the label the same with the addition of “1” at the end of the first subset, “2” at the end of the second subset, etc.

** For Information only discipline subset shall be submitted as individual pdf files based on the entity providing the information only.

**Figure 3 Typical Highway Project Discipline Subset Contents**
### Multiple Volume Option

<table>
<thead>
<tr>
<th>Label (Discipline Subset)</th>
<th>File contents (but not limited to)</th>
<th>Designer/Firm</th>
</tr>
</thead>
<tbody>
<tr>
<td>01.01-General</td>
<td>Title Sheet, Detail Estimate Sheet</td>
<td>Lead</td>
</tr>
<tr>
<td>01.02-Revisions</td>
<td>Index of Revision Sheets</td>
<td>Lead</td>
</tr>
<tr>
<td>01.03-WtInd Re-establish</td>
<td>Wetland Reestablishment plans</td>
<td>Designer 1</td>
</tr>
<tr>
<td>01.04-Stg Acc.</td>
<td>Staging and Access Plans</td>
<td>Designer 1</td>
</tr>
<tr>
<td>02.01-Typ Sections</td>
<td>Typical Sections</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.02-Alignments</td>
<td>Alignment Geometry</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.03-Plan</td>
<td>Plans</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.04-Profiling</td>
<td>Profiles</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.05-ROW Brk</td>
<td>Right of Way Breakout</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.06-Drain</td>
<td>Drainage Plans</td>
<td>Designer 2</td>
</tr>
<tr>
<td>03.01-Retaining Wall 1</td>
<td>Retaining wall details</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.02-Retaining Wall 2</td>
<td>Retaining wall details</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.03-Bridge 00456</td>
<td>Bridge_456</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.04-Bridge 01983</td>
<td>Bridge_1983</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.05-Bridge 01984</td>
<td>Bridge_1984</td>
<td>Designer 3</td>
</tr>
<tr>
<td>04.01-Stage 1</td>
<td>Stage Construction Details 1</td>
<td>Designer 4</td>
</tr>
<tr>
<td>04.02-Stage 2</td>
<td>Stage Construction Details 2</td>
<td>Designer 4</td>
</tr>
<tr>
<td>04.03-Stage 3</td>
<td>Stage Construction Details 3</td>
<td>Designer 4</td>
</tr>
<tr>
<td>05.01-SPM</td>
<td>Signing and Pavement Marking Site 1</td>
<td>Designer 5</td>
</tr>
<tr>
<td>05.02-SPM</td>
<td>Signing and Pavement Marking Site 2</td>
<td>Designer 5</td>
</tr>
<tr>
<td>05.03-SPM</td>
<td>Signing and Pavement Marking Site 3</td>
<td>Designer 5</td>
</tr>
<tr>
<td>06.01-IMS</td>
<td>IMS Plans and Details Site 1, 2, 3</td>
<td>Designer 6</td>
</tr>
<tr>
<td>07.01-Env 1</td>
<td>Environmental Details Site 1</td>
<td>Designer 7</td>
</tr>
<tr>
<td>07.02-Env 2</td>
<td>Environmental Details Site 2</td>
<td>Designer 7</td>
</tr>
<tr>
<td>07.03-Env 3</td>
<td>Environmental Details Site 3</td>
<td>Designer 7</td>
</tr>
<tr>
<td>08.01-*Utility</td>
<td>Utility Design plans. For example 07_AT &amp; T, 07_CL &amp; P, 07_MDC, etc.</td>
<td>Designer 8</td>
</tr>
<tr>
<td>09.01-CL&amp;P FIO</td>
<td>CL &amp; P For Information Only plans</td>
<td>Designer 8</td>
</tr>
<tr>
<td>09.02-AT&amp;T FIO</td>
<td>AT &amp; T For Information Only plans</td>
<td>Designer 8</td>
</tr>
<tr>
<td>CTDOT Highway STD</td>
<td>*CTDOT Highway Design Standard Index and Sheets required</td>
<td>Designer 1</td>
</tr>
<tr>
<td>CTDOT Traffic STD</td>
<td>CTDOT Traffic Engineering Standard Index and Sheets required</td>
<td>Designer 5</td>
</tr>
</tbody>
</table>

*Figure 4 – Multiple Design Firms CTDOT Project Subsets*
4.2 Contract Plan Format

Digital contract plans (preliminary, semi-final, FDP, ADP, DCO, etc.) shall be formatted in accordance with the following:

1. Contract Plans shall be in submitted to CTDOT in PDF format
2. PDF Plans must be sized either 36” x 24” for projects created before June 2007 or sized 34” x 22” for projects created after June 2007
3. PDF plans shall be measurable to scale in the PDF
4. PDF plans shall be able to be printed to paper and scaled appropriately
5. Text must be searchable
6. All levels must have the ability to be displayed on or off, unless approved otherwise.
7. All information on the digital contract PDF plans shall have been created from MicroStation or an approved alternate. The only information that shall be added to the plans using a PDF editing software are as follows:
   - Page labels (see Section 4.14.2)
   - Sheet numbers (see Section 4.14.2)
   - Watermarks and flatten comments (see Section 5.4)
   - Any digital signature fields (see Section 5.5)
   - Digital Signature (see Section 5.6)
8. Discipline subsets shall be published directly from a CAD application. Scanned images or raster image formats will not be accepted with the exception of For Information Only sheets, these can be scanned. See Publishing CAD Files for more instructions on how to publish from Microstation.
9. Each discipline subset shall contain bookmarks; one for each page.
10. The first page of each subset shall be a subset cover sheet, this includes FIO subsets. This cover sheet shall contain both; an index of drawings contained within the subset that includes both drawing numbers and drawing titles and the form field place holder(s) which receives the digital signatures. This table must include the subset name and number displayed as a heading in the table as shown in the figure below.

---

![Figure 5 Discipline Subset Bookmarks, Index of Drawings, and Signature fields](image)

---

Issued 3/2019  
31  
Version 4.04
11. The first page of the subset 01_General shall be the CTDOT digital project title sheet which includes an index of the subsets contained within the project, sheet count totals for all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for applying the digital signature(s) (see section Section 5.5). Consultants will need to delete the CTDOT signature blocks on the title sheet and place a digital signature placeholder as detailed in section Section 5.5. CTDOT engineers can find the digital title sheet in the seed files on our W: drive.

12. The 01_General subset shall include all detailed estimate sheets.

13. The 02_Revisions subset must be included in each digital project and there shall only be (1) revisions subset.

14. Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See Section 7.3. These revision sheets are used for tracking all sheet changes due to addenda and design initiated change order (DCO) with respect to the entire project. These sheets are originally blank and unsigned, and shall be managed and updated as needed by the Project Manager. The CTDOT Revision Contract Sheet can be obtained here:

- CTDOT Designed Projects - 02-Revisions Subset
- Consultant Designed Projects - 02-Revisions_CE_Subset

15. Plans For Information Only (FIO) shall be submitted digitally, in individual subsets based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For Information Only”. The subset numbers shall be selected by the lead designer so that the FIO subsets are last. Each sheet shall be numbered correctly, see Section 4.14.2. Upload and attribute in accordance with Section 6.1.

16. Utility drawings shall be submitted in accordance with the following:
   - Utility plans For Information Only (FIO) shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc. These subsets do not require a digital signature, but each sheet shall be labeled; “For Information Only”. FIO utility subsets shall be numbered so that they are the last subsets. Example Labels; 10_CL&P_FIO, 11_AT&T_FIO. These subsets must have page labels assigned, see Section 4.14.2
   - Utility company designed plans that include work being done by the State’s Contractor shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc. These subsets do not require a digital signature. Example Labels; 10_CL&P, 11_AT&T. These subsets must have page labels assigned, see Section 4.14.2
   - Utility plans that are designed by a Consultant firm that include work being done by the States Contractor shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc., and shall be digitally signed in accordance with this manual. Example Labels; 10_CL&P, 11_AT&T. These subsets must have page labels assigned, see Section 4.14.2

17. CTDOT Standard sheets shall also be delivered digitally. See Section 4.4 for how to prepare and submit CTDOT Standard Sheets.

18. Footers, displaying the sheet number, shall be placed on each page of each PDF subset. See Section 4.14.2, “Sheet Numbering”.

19. As-built information shall be digitally applied to the contract subsets by District Personnel after the job is complete using Bluebeam. See Section 8.

20. Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section, but do not need to be digitally signed. These review documents shall be uploaded into the 310_Milestone Submission folders in Projectwise in accordance with Section 6.1.

21. A Bluebeam set file shall be created at FDP and updated for any addendums or change orders in accordance with Section 4.15.2.
22. Contract Plan subsets, FDP, DCD, DCD2, ADP, and DCO, must be checked by the Discipline Subset PDF Checker in accordance with Section 6.2.

### 4.3 CTDOT For Information Only Sheets

Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For Information Only”. The first sheet of each FIO subset shall be a subset cover sheet. These sheets shall be placed on a border and numbered in accordance with section 4.14.2.

The subset numbers shall be selected by the Project Manager so that the FIO subsets are last. See Section 6.1 for uploading and attributing FIO Plans. Information only sheets may be scanned, but must conform to the following:

- Minimum Size 22”x34”
- Minimum dpi = 300.

This link shows an optional procedure that can be used to create a For Information Only subset that uses Bluebeam: Preparing a For Information Only Subset.

### 4.4 CTDOT Standard Plan Sheets

Standard sheets shall also be delivered digitally into Projectwise. The following shows how to obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital project.

1. Download the latest standards from the following link for the project: CTDOT Standard Drawings Website
2. Upload the standard subset into Projectwise in accordance with Section 6.1.
3. Next open up the standards from Projectwise by double clicking on it. Once it opens click on the index sheet.

![Figure 6 - Preparing the Standard Subsets](image)
4. Then enter the project number and check the standards to be included in the project.

5. Delete the standards that are not included in the project as shown below:

6. Next digitally sign all index sheets in accordance with Section 5.6.4.

7. Then upload the standards into the 100_Contract Plans folder in Projectwise in accordance with Section 6.1 of this manual.
4.5 Contract Special provisions

1. Digital Contract Special provisions shall be submitted in MS Word format and in accordance with the Departments policies and procedures for Contract Development. CSI special provisions shall be submitted in pdf format.

2. Preliminary special provisions and CSI special provisions shall be combined into (1) pdf document and then uploaded to the applicable folder under the 310_Review Documents folder under the project in Projectwise.

3. FDP and Addendum special provisions and CSI special provisions shall be submitted to CTDOT in accordance with the following:
   - For projects where a consultant is the Project Manager on the project, the Specification and CSI special provisions in WORD format shall be submitted in (1) zipped folder.
   - For projects where a CTDOT design unit is the Project Manager on the project, the Specification and CSI special provisions in WORD format shall be submitted in individual zipped folders per discipline.
   - Addendum special provisions shall be submitted in WORD Format in a zipped folder. Each page of the specification section shall be marked in the bottom right corner of the footer with “Addendum No. Y”, where “Y” equals the addendum number. Also a line shall be placed on the right side indicating where language was changed in the specification.
   - Special provisions shall be submitted in a zipped folder for the following submissions: FDP, revised FDP special provisions, Addendum special provisions, and revised addendum special provisions. Revised FDP and revised addendum submissions shall only include the revised special provisions.
   - FDP, revised FDP special provisions, Addendum special provisions, and revised addendum special provisions shall be uploaded into the 240 Contract Development folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table of this manual.

4. Design Initiated Change Order special provisions shall be prepared and submitted in accordance with the following:
   - On each sheet of the revised specification, “C#” and the date shall be placed in the bottom right corner of the footer. An example would be “Rev. C1 - mm/dd/yy”.
   - For projects where a consultant is the Project Manager on the project, the Specification and CSI special provisions in WORD format do not need to be uploaded into Projectwise.
   - For projects where a CTDOT design unit is the Project Manager on the project, the DCO Specification and DCO CSI special provisions in WORD format shall be submitted in individual zipped folders per discipline.
   - The project manager shall combine all the DCO specifications into (1) multi-page PDF document.
   - The consultant or state design Project Manager shall upload the Design Initiated Change Orders special provisions pdf file into the 110_Contract Documents folder under the project in Projectwise in accordance with Section 6.1 of this manual and attributed in accordance with Projectwise Attribute Table of this manual.
4.6 Estimates and Quantity Calculations

Estimates
Cost Estimates shall be prepared in accordance with the procedures detailed on this website: Cost Estimating

Preliminary cost estimates shall be uploaded into the 310_Milestone Submissions under the applicable project in accordance with Section 6.1 of this manual.

Final Proposal and Federal Estimates shall be uploaded into the 240_Contract Development folder under the applicable project in accordance with Section 6.1 of this manual.

Calendar Day estimates shall be uploaded into the 240_Contract Development folder under the applicable project in accordance with Section 6.1 of this manual.

Quantity Calculations
Quantity Calculations shall be formatted and submitted in accordance with the following:

- Shall be native PDF whenever possible.
- Scanned pages shall be readable and have a minimum resolution of 200 dpi.
- Pages in the PDF can be any size. 8.5” x 11” is recommended.
- Shall be uploaded into the 150_Quantity Calculations folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table of this manual. The final status shall also be applied as shown in section 2.5.

4.7 Environmental Permits
Environmental permit applications, permit approvals, and other permit documents shall be uploaded into Projectwise and formatted in accordance with the following:

Permit Need Determination Form (PNDF) and Other Permit Documents
- Shall be native PDF whenever possible.
- The PNDF shall be uploaded into the 320_Permit Development Folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table

Environmental Permit Applications:
- Shall be native PDF whenever possible.
- Scanned pages in the application must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- All pages, except plans sheets, shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
- Before FDP, each permit application shall be in an individual multi-page PDF file. Each permit shall be shall be then uploaded into the 320_Permit Development Folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with the Projectwise Attribute Table
- At FDP, the individual multi-page PDF files shall be uploaded into the 240_Contract Development folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with the Projectwise Attribute Table

Environmental Permit Approval
- Shall be native PDF whenever possible.
- Scanned pages in the permit must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- Shall be sized 8.5” x 11”.
- Before FDP, each permit approval shall be in an individual multi-page PDF file. Each permit shall be shall be then uploaded into the 320_Permit Development Folder under
Connecticut Department of Transportation – Digital Project Development Manual

the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table

- At FDP, the individual multi-page PDF files be uploaded into the 240_Contract Development folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table

4.8 Contractor Submittals

See Section 9 for format, submittal and review requirements for Contractor Submittals: Working Drawings, Shop Drawings, Product Data, RFI, and RFC.

4.9 Engineering Reports

Hydraulic, Scour, Floodway, and Final Drainage reports: Shall be formatted in accordance with the following:

- Shall be native PDF whenever possible.
- Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
- Shall be digitally signed and watermarked in accordance with Section 5 of this manual.
- Any data files that must accompany the PDF report shall be uploaded into Projectwise in a zipped folder.
- The reports and zipped folder for any data files shall be submitted into the 130_Engineering Reports folder under the applicable project in accordance with Section 6.1 of this manual. The final status shall also be applied as shown in section 2.5.
- Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in Projectwise.

Task 110, Task 220, Underground Storage Tank System Closure Reports: Shall be formatted in accordance with the following. The content of the report shall be in accordance with the Scope defined by the Division of Environmental Compliance:

- Shall be native PDF whenever possible.
- Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
- Shall be digitally signed in accordance with Section 5 of this manual.
- These reports shall be submitted into the 130_Engineering Reports folder under the applicable project in accordance with Section 6.1 of this manual. The final status shall also be applied as shown in section 2.5.
- Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in Projectwise.

Rehabilitation Study Reports and Type Study Reports: Shall be created and formatted in accordance with the Bridge Manual:

- Final reports shall be uploaded into the 140_Project Administration folder in Projectwise. The final status shall also be applied as shown in section 2.5.
- Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in Projectwise.

Bridge Load Ratings: Shall be created and formatted in accordance with the Bridge Load Rating Manual:

- Final load ratings shall be digitally signed in accordance with Section 5 of this manual.
- Final reports shall be uploaded into the 130_Engineering Reports folder in Projectwise. The final status shall also be applied as shown in section 2.5.
Connecticut Department of Transportation – Digital Project Development Manual

- Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in Projectwise.

**Geotechnical Reports:**
- Shall be native PDF whenever possible.
- Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
- These reports shall be submitted into the 130_Engineering Reports folder under the applicable project in accordance with Section 6.1 of this manual. The final status shall also be applied as shown in section 2.5.
- Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in Projectwise.

## 4.10 Project Administration and Project Correspondence Documents

**Project Administration Documents**
Final project administration documents shall be stored in the 140_Project Administration folder under the project in Projectwise in accordance with the following:
- Shall be in PDF Format.
- Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- The document must be uploaded into Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table of this manual. The final status shall also be applied as shown in section 2.5.

Note: The discipline attribute must match the author of the document. For example, if the Highway design unit sends out a memo for a design review, the discipline attribute on this document shall be HW.

- Draft project administration documents can also be created and worked on in Projectwise. These file shall be located under the user’s discipline 330_Design_Data folder under the project in Projectwise.

**Project Correspondence Documents**
Project correspondence documents shall be stored in the 142_Project Administration Correspondence folder under the project in Projectwise in accordance with the following:
- Shall be in PDF Format.
- Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
- The document must be uploaded into Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table of this manual. The final status shall also be applied as shown in section 2.5.

Note: The discipline attribute must match the author of the document. For example, if the Highway design unit sends out a memo for a design review, the discipline attribute on this document shall be HW.

This folder is for all final project correspondence documents. This is defined as any request memos, response memos, emails, letters, etc. and does not include any documents that are defined in the 140_Project Administration folder. This folder shall not include any working/draft documents. The final status shall also be applied as shown in section 2.5.

- Emails – The sender of the email is required to store a PDF of the email message in Projectwise.
- Letters
• Meeting Minutes
• Request Memos – Survey Request, Design Reviews, Support unit design.
• Response Memos – Response to the Request Memos

4.11 Project Location (Geo-Spatial Boundary or Route ID and Mileage)
The project location shall be prepared and submitted in accordance with section 13.

4.12 Design Calculations
Design Calculations for all structural elements on a project shall be formatted and submitted in accordance with the following:
• Shall be native PDF format whenever possible.
• Scanned pages shall be readable and have a minimum resolution of 125 dpi.
• Pages in the PDF can be any size. 8.5” x 11” page size is recommended.
• Shall be uploaded into the 151 – Final Design Calculations folder under the project in Projectwise in accordance with Section 6.1 and attributed in accordance with Projectwise Attribute Table of this manual. The final status shall also be applied as shown in section 2.5.

4.13 Electronic Engineering Data (EED)
Electronic Engineering Data shall be prepared and submitted in accordance with section 12.
4.14 Contract Plan Drawing and Sheet Numbering

4.14.1 Drawing Number

The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall consist of the discipline designator followed by a hyphen and the sheet number. Examples of discipline designators are HWY, PRO, IND, XSC, S, TR, A, E, etc.

The first sheet in a discipline subset shall have “01” in the drawing number as shown below:

![Figure 9 Contract Drawing Numbering](image)

4.14.2 Final Plan Page Labels and Sheet Numbers

Page labels and sheet numbers are applied to the discipline subset after the contract plans are published to PDF.

Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the number pages and header and footer tools within Bluebeam. Page labels and sheet numbers shall be applied to all submissions of contract plans.

The first sheet in every subset shall start out at 01. For example the first sheet in the 05-Traffic subset shall be 05.01.

![Figure 10 - Drawing and Sheet Numbering](image)

The page label and sheet number place holder shall be determined by the total estimated sheet count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100 sheets three place holders are necessary. For subsets less than 10 sheets, two placeholders shall be used i.e. 01.01 thru 01.04 for a four sheet subset.

The page labels and sheet numbers must be placed correctly because it is used to correctly assemble the contract plans into a properly ordered consolidated set that District Construction takes advantage of during construction of the project.

**Single Volume Projects:**

The page labels and sheet numbers, for single volume projects shall be a concatenation of the discipline subset number, a decimal point, and the sheet number. For example; the page labels...
and sheet numbers for subset “4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03, etc or Greater than 100 sheets 04.001, 04.002, 04.003 etc.
The Project Manager should determine the total number of subsets and give each discipline their corresponding subset number, see Section 4.1.

**Multi Volume Projects:**
For a multi volume project the page labels and sheet numbers shall be a concatenation of the volume number, a decimal point, the discipline subset number, a decimal point, and finally the sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.03.

Volume numbers shall be used on large projects. They are effective because the Project Manager only has to deliver to the other engineers their perspective volume numbers, allowing them to manage their subset numbers independently of the other discipline volumes and subset counts, see Section 4.1.

Subset numbers shall start at 01 for all volumes.
BLUEBEAM - Applying Page Labels and Sheet Numbers

To apply page labels and sheet numbers in Bluebeam follow the figures below:

1. First page labels must be applied to the discipline subset. Go to the thumbnail pane as shown below, right click on a thumbnail and select Number Pages:

   ![Figure 11 - Adding Page Labels]

   For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at once. In the case where there are 10 or more sheets in the subset the following will have to be done twice in order to get the correct number of place holders.

2. Select the correct style, insert correct prefix for the sheets being numbered, and apply to the correct pages. For example, if the 04 subset has 99 sheets the prefix shall be “04.0” for sheets 1-9 and “04.” For sheet 10 through 99.

   ![Figure 12- Page Labeling]
3. Now the pages will be labeled:

Figure 13 - Labeled Pages

4. Next we will apply the sheet numbers. From Bluebeam select the Document tab and then “Header & Footer”

Figure 14 - Header Footer Tool
5. Place the sheet numbers, as shown below: Note the margins may have to be adjusted as necessary. After you select the font, set the margins, and type in <<PageLabel>> as shown below. Then click save for save settings. The next time you are going to apply sheet numbers to a subset, you can simply select the saved settings. Then click OK.

![Figure 15 - Applying Header and Footer](image1)

![Figure 16 - Insert Sheet Numbers](image2)
4.14.3 Addendum and Design Initiated Change Order Page Labeling and Sheet Numbers

Page labels and sheet numbers for an Addendum need to have “.A##” at the end and Change Orders need to have “.C##” at the end (see Section 7 for addendum and change order sheet numbering requirements).

To apply page labels and sheet numbers in Bluebeam follow the figures below:
1. First page labels must be applied to each sheet in the addendum or change order. This can only be done one sheet at a time.
2. Go to the thumbnail pane as shown below and then double click on the page label. Then type in the correct page label for the sheet.

![Figure 17 - Adding Page Labels](image-url)
3. After all page labels have been applied, the sheet numbers can be applied. From Bluebeam select the Document tab and then “Header & Footer”.

![Image of Header Footer Tool](image18)

Figure 18 - Header Footer Tool

4. Select your sheet numbers saved settings from before and click OK. Note the margins and size may have to be adjusted as necessary.

![Image of Applying Header and Footer](image19)

Figure 19 - Applying Header and Footer

![Image of Applying Addendum or DCO Sheet Numbers](image20)

Figure 20 - Applying Addendum or DCO Sheet Numbers
4.15 Consolidating Contract Plan Discipline Subsets

The consolidation of the contract plan discipline subsets is accomplished using the Set feature in Bluebeam version 11 or newer. This feature creates a single viewer file called a “Set File” that allows users to take multiple digitally signed files, sort them by their sheet numbers, and view them in order without actually combining the files.

The project manager shall create a Set file for the project at DCD that contains all the discipline subsets, DO NOT include the highway and traffic standard subsets. When an Addendum or Change Order is required for the project, the project manager shall update the set file to include the Addenda or Change Order subsets.

The following shows when and how a set file will be created and updated throughout the life of a project.

See Appendix C for general use of a set file.

**Note:** Steps 1-5 of Appendix A must be followed to create and use the Set File feature in Bluebeam.

Also the PDF checker must be run on the subsets and they must receive a PASS status for the Set File to sort the subsets correctly. See section 6.3 information on the PDF checker.

4.15.1 When a Set File is Created and Updated

**Set File Creation**
1. The project manager shall create a set file of all the discipline subsets at DCD, see Section 4.15.2

**Set File Updates**
2. If any Addendum subsets are required for the project, these Addendum subsets shall be added to the set file by the project manager.
3. If any Design Initiated Change Order subsets are required for the project, these Design Initiated Change Order subsets shall be added to the set file by the project manager.

See section 4.15.3 for updating the set file.
4.15.2 Creating a Set File

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature in Bluebeam.

Also the PDF checker must be run on the subsets and they must receive a PASS status for the Set File to sort the subsets correctly. See section 6.3 information on the PDF checker.

After all the discipline subsets have been submitted into Projectwise for DCD the project manager shall create the project’s set file in accordance with the following:

1. Launch Bluebeam from the desktop icon on your computer.
2. Next Click on the Set Icon and select New Set as shown below:

![Figure 21 - Creating a Set File](image)
3. Then click Add and then Projectwise and OK as shown below:

![Figure 22 - Adding Files to the Set File](image1)

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except the standard subsets. Then click Open: After you click Open it may take a minute for Bluebeam to load all the files into the set, please be patient.

![Figure 23 - Adding Files to the Set File](image2)
5. Next Click on Relative Paths and then click options:

![Set File Options](image1)

**Figure 24 - Set File Options**

6. Next on the sorting tab, make sure all the options shown below are set:

![Set Options](image2)

**Figure 25 - Configuring the Set File**

- The Wildcard Syntax must be ?#
- Uncheck all of these things
7. Then on the Categories Tab make sure the categories are turned off:

![Figure 26 - Set File Categories](image)

8. Then on the Tags Tab make sure nothing is checked and then click OK:

![Figure 27 - Tags Tab](image)
9. Next click Save, this may take a while depending on how big the project is, please be patient. When the box pops up choose Projectwise and click OK:
10. Select the Advanced Wizard, and then on the Select target folder browse out to your project’s 100_Contract_Plans folder. Then click next until you get to the attributes page. Attribute the Set File as shown below:

Figure 29 - Attributing the Set File

11. Click OK after the set file has been saved into Projectwise:

Figure 30 - Creating a Set File
12. When the Tags box pops up just click OK:

![Set File Tag Dialog Box](image)

**Figure 31 - Set File Tag Dialog Box**

13. Now the set file has been created. As you see below all the sheets from the files are listed and crossed out accordingly. For use of the Set File see [Appendix C](#):

![Set File](image)

**Figure 32 - Set File**
4.15.3 Updating a Set File

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature in Bluebeam.

Also the PDF checker must be run on the subsets and they must receive a PASS status for the Set File to sort the subsets correctly. See section 6.3 information on the PDF checker.

The following will show how to update a set file. When an Addendum or Change Order is required for the project, the set file shall be updated by the project manager.

4.15.3.1 Adding a File to the Set File

1. Double click on the set file from Projectwise and open as shown below: This may take a while depending on how big the project is, please be patient.

![Image of opening a set file](Figure 33 - Opening a Set File)
2. Next click on the Set icon and click Add as shown below:

3. Next browse out to your project and select the files to add to the set and click Open. This may take a minute to add the additional file to the set so please be patient. After it finishes click OK.
4. Now the file will be added to the set, scroll down and you will see it.
### 4.15.3.2 Deleting a File from the Set

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature in Bluebeam.

1. Double click on the set file from Projectwise and open as shown below:

![Figure 37 - Opening a Set File](image)

2. Next click on the Set Icon. Then select the file to remove from the set and click delete:

![Figure 38 - Deleting a File from the Set File](image)
Connecticut Department of Transportation – Digital Project Development Manual

Section 5  Digital Signatures for Contract and Other Engineering Documents

The follow contract documents must be digitally signed when submitted to the Department in accordance with the following section:

- Contract Plans – FDP, Addendum, Change Orders
- Engineering Reports
  - Hydraulic Report
  - Scour Report
  - Floodway Report
  - Final Drainage Reports
  - Bridge Inspection Reports
  - Bridge Load Ratings
  - Task 110
  - Task 220
  - Underground Storage Tank System Closure Reports
- Working Drawings for Permanent and Temporary Structures – Plans and Calculations

This manual refers to digital signatures in two ways: certifying signatures, and signing signatures. The Engineer of Record or document signer will always digitally sign using a visible certifying signature. If multiple signatures are required per document, the second signer or sub-engineers shall always digitally sign using a visible signing signature after the primary signer or engineer has applied his certifying signature. Certifying signatures allow controlled changes, to the now certified document. These controlled changes include; allowing PDF digital comments, and the application of additional signatures. Signing signatures should always be accompanied by a note listing the sheets the signer is responsible for within a subset.

In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the first sheet of the document, regardless of the number of pages the document contains. This digital signature secures the entire document.

A graphic image of the signer’s signature must be created, and shall be used for the following purposes:

- It shall be attached to the digital signature and displayed when the digital signature is applied.
- It shall be placed as a watermark on all contract plan sheets a particular engineer of record is responsible for (digitally signing for).
- It shall be placed on the first sheet by the preparer and checker of an engineering report.
- The watermark shall be placed on all contract plan sheets and all plan sheets contained in a working drawing submittal.

A digital ID must be purchased in order to apply a digital signature. Digital ID’s must meet the special provisions of Adobe’s Certified Document Services (CDS) or Adobe Approved Trusted List (AATL). The necessary hardware and software needed to apply the required digital signatures may be purchased from the vendor list provided at the following website: http://www.adobe.com/security/partners_cds.html, additional information on Adobe’s CDS is also available at this website.

Before digitally signing any document Bluebeam must be set up as detailed in Appendix A.
5.1 Graphic Image of Signature

5.1.1 Contract Plans
The following figures display an example of both a state designer and a consultant designer’s digital signatures, and their accompanying graphic image(s) of their signature(s). See Section 5.2, for instructions on how to create a graphic image.

The consultant engineer’s graphic image must contain his companies name and address; his signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state employee’s graphic image must contain only his signature. See Below.

In addition to a digital signature being placed on the first sheet of any contract plan, working drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages be watermarked with a copy of the engineer of records graphic signature before they are digitally signed. Watermarks containing these signatures are applied using Bluebeam and are always placed in the border of contract plans and working drawings for permanent structures. This is to prove validation of a digital document if printed.
5.1.2 Engineering Reports

Hydraulic, Scour, Floodway, and Final Drainage Reports

The following shows the watermarks that need to be placed on the first sheet of a Hydraulic, Scour, Floodway, or Final Drainage Report by the Preparer and the Checker and the digital signature of the Approved Hydraulic Engineer. The digital signature must include the graphic image of the signer’s PE stamp and signature as shown below, Section 5.2, for instructions on how to create a graphic image. These reports shall be digitally signed in accordance with Section 5.6.7.

Figure 41 - Engineering Reports
Bridge Inspection Reports

The following shows how Bridge Inspection reports are to be digitally signed in the bottom right hand corner of the report. The digital signature must include the graphic image of the signer’s PE stamp and signature as shown below, Section 5.2, for instructions on how to create a graphic image. These reports shall be digitally signed in accordance with Section 5.6.7.

Inspection Type: Routine and Fracture Critical

BRIDGE NO. 08069R

08070 - BRIDGEPORT
MAINLINE
over
KOSSUTH STREET

Routine and Fracture Critical Inspection
5/27/2015
Inspected by: TranSystems

Digital Signature

Mathew J.
Calkins, P.E.
2015.08.20
10:37:09-04'00'

Figure 42 - Bridge Inspection Reports
**Bridge Load Ratings**
The following shows how Bridge Load Ratings are to be digitally signed. The digital signature must include the graphic image of the signer’s PE stamp and signature as shown below, Section 5.2, for instructions on how to create a graphic image. The load ratings shall be digitally signed in accordance with Section 5.6.1

![Bridge Load Rating Image](image)

*Figure 43 - Bridge Load Ratings*

**Environmental Compliance Reports**
The digital signature for the Task 110, Task 220, and Underground Storage Tank System Closure Reports must include a graphic image of the Professional engineer’s signature or a graphic
image of the signer’s signature where applicable, see section 5.2, for instructions on how to create a graphic image. These reports shall be digitally signed in accordance with section 5.6.7

5.1.3 Working Drawings

Working Drawings for Permanent and Temporary Structures

The following shows the digital signature and Professional Engineering watermark requirements for the engineer who prepares the working drawing submittal. These types of submittals shall be digitally signed in accordance with section 5.6.6. Note: Working Drawing for Temporary Structures only require that the first sheet in the submittal be digitally signed, watermarks are not necessary. See section 5.2 for instructions on how to create a graphic image.

Working Drawing Plans

The first plan sheet in the submittal shall have a digital signature and a watermark placed on it as shown below. All others sheets will only have the watermark. A place in the border of the plan sheets shall have a spot for this watermark.

![Working Drawing for Permanent Structures](image-url)

Figure 44 - Working Drawing for Permanent Structures
**Working Drawing Calculations**

The first sheet of the calculations shall have a digital signature as shown below:

![Image of a signed digital drawing](image_url)

**Figure 45 - Working Drawing for Permanent Structures**

### 5.1.4 Other Documents

Documents that do not require to be signed by a Professional Engineer shall have a graphic image of the signer’s signature attached to their digital signature. See [section 5.2](#) for instructions on how to create a graphic image.
5.2 Creating Graphic Image of Signature:

5.2.1 In House CTDOT or Non-Professional Engineering Signature:

The graphic signature will be used by CTDOT employees and signers that are not signing as a Professional Engineer.

CTDOT graphic signatures shall be created as follows:

1. Signer must sign a blank piece of paper.
2. Scan this signature.
3. Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.
4. Save the images, in PDF to an area on your PC.

Figure 46 (Example of CTDOT Graphic Image of Signature – Used with Digital Signature and as a Watermark)

5.2.2 For Consultant Staff PE Stamp:

Consultant Engineers shall create two different graphic signature images: one that shall accompany their digital signatures and a different one that shall be placed as a watermark on all the plan sheets the engineer is signing for.

This section shows an example of a Professional Engineer preparing their graphic image of their signature; Architect’s shall follow this section when they are preparing their digital signature. **Graphic Appearance Attached to Digital Signature**

The graphic signature that accompanies the digital signature only needs to include the designer’s signature and P.E. Stamp, and shall be created as follows:

1. Stamp and Sign a blank piece of paper.
2. Scan this signature.
3. Crop the image to approximately 250 pixels wide by 250 pixels high.
4. Save the image, in PDF to an area on your PC or server, where you can easily access it for later use in the signature set-up procedure.

Figure 47 ((Example of Consultant Engineer Graphic image of Signature – Applied to 1st page only with digital signature)
Graphic Appearance used as a Watermark

In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a watermark shall also include the designer’s company name and address, and shall be created as follows:

1. On blank paper – Print company name and address.
2. Place P.E. stamp next to company name and address.
4. Scan the image created in steps 1 thru 3 above.
5. Crop the image to approximately 500 pixels wide by 250 pixels high.
6. Save the image, in PDF to an area on your PC or server, where you can easily access it for later use in the watermarking procedure.

Figure 48 (Example of Consultant Engineer Graphic image of Signature – applied to all pages as a watermark)

Once the graphic images have been properly created and saved, the digital signature appearance preferences must be set as follows:

5.3 Setting Digital Signature Appearance Preferences:

Once the graphic signatures are created the digital signature appearance settings must be defined as follows:

Bluebeam Digital Appearance

1. Make sure your CDS USB token is inserted into the computer then in Bluebeam go to the Document tab and select Signatures>Digital ID's:

Figure 49 - Digital Appearance
2. Next click on your ID and click Manage Appearances:

(1) Select ID

(2) Click Manage Appearance

(3) Double Click

3. Next follow the figure below:

Figure 50 - Manage Appearances

Type in Name

Browse to graphic appearance

Make sure these settings are set as shown

Figure 51 - Setting the Digital Appearance

4. Now the digital appearance will be saved and can be used to digitally sign.
5.4 Watermarking Plans with Graphic Image of Signature

The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a copy of their graphic signature as a watermark on each sheet of each discipline subset, or working drawing submittal (Plans and Calculations) that they are responsible for. For Engineering Reports the preparer and checker of the report shall place a copy of their graphic signature as a watermark only on the cover of the report.

Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant Designed)

There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2. The following shows an example of a CTDOT signature, but the procedure is the same for a consultant when they are placing their PE stamp in the border or on the first sheet of an engineering report.

Watermarking Workflow:

Option 1

1. The watermark in Bluebeam is placed using the stamp function. First go to the Markup tab and select Stamp and then choose your stamp. If your Principal’s or PE stamp is not in the list follow Appendix A. If your stamp is in the list go to step 2.

2. Next place the stamp in the border on the first sheet.

Place stamp in this area in the border

Figure 52 - Placing Watermark
3. Next right click on the stamp and select “Apply to all pages”. If you are watermarking an engineering report you do not need to apply to all pages.

![Figure 53 - Placing Watermark on All Pages](image)

If more than one group has to watermark this subset, browse to the pages the other group is responsible for and delete the watermark. Then they can come in and place their watermark on these sheets.

**Flatten Markups**

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF document. Go to Document>Flatten Markups. Use the default settings and click OK.

1. After the watermarks have been placed on the subset, the watermarks must be “flattened” to the PDF document. Go to Document>Flatten Markups. Use the default settings and click OK.
5.5 Digital Signature Fields

**Contract Plans**
Digital signature fields are form fields created using Bluebeam, and are used to house the digital signatures. Digital Signature form fields shall be placed within the form field place holders. The form field place holders are cells that are placed in the MicroStation file on the title sheet and the subset cover sheets and on any Addendum or Change Order Subset. The figure below shows a CTDOT designed project with the form field place holders (circled) on the title sheet and the discipline subset cover sheet.

![Figure 54 - Digital Signature Fields](image)

The figure below shows a consultant designed project’s title sheet and discipline subset cover sheet with their form field place holders.

![Figure 55 - Consultant Watermarks](image)

Place holders determine the location and size of the digital signature form field.

Form field place holding cell library: [CT_Digital_Sigs.zip](#)

The digital signature place holder and form fields shall be created on the first page of each discipline subset for each required digital signature.

**Note:** All signature form fields need to be created for both certifying and signing signatures before any digital signatures is applied to the document.

**Contractor Submittals**
Contractor submittals will not be required to have a digital signature place holder.

**Engineering Reports**
Engineering reports will not be required to have a digital signature place holder.
5.5.1 Bluebeam - Creating Digital Signature Form Fields

The following example shows how to place the (3) digital signature form fields on the 01-General title sheet of a CTDOT designed project. For a discipline subset or a consultant designed 01-General title sheet, only one digital signature form field needs to be placed.

1. To place signature fields click X.

2. Next place three signature fields in the appropriate location and hit save as shown below:

![Figure 56 - Placing Signature Fields](image-url)
5.6 Applying Digital Signatures

This section describes how to apply digital signatures for contract plans, engineering reports, working drawing plans, and working drawing calculations.

**Contract Plans**

Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic Standard drawing subsets have unique requirements as described in the following sections.

CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded into projectwise because the Principal Engineer will be looking in projectwise to digitally sign documents.

Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of record, using a single visible *certifying* signature, applied to the signature form field located on the first page of each subset.

Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of Record who is responsible for the most sheets in the subsets. This engineer will apply a visible *certifying* signature in the top most form field. The next Engineer of Record shall apply their *signing* signatures in the subsequent form fields. This Engineer shall also include a reason, when applying their digital signatures, listing the pages they are responsible for.

Digital signatures must be applied to digital signature form fields, previously. See Section 5.5

**Engineering Reports**

Engineering Reports shall be digitally signed, by the Engineer of Record using a *certifying*. See Section 5.7 for instructions on how to apply a certifying signature to an engineering report.

5.6.1 Applying Digital Signatures to 01_General Subset (FDP and Addendum Subsets)

CTDOT DESIGNED PROJECTS:

The following procedure applies to both the 01_General subset at FDP and any 01_General_A# subset.

The project title sheet of the 01_General subset shall first be digitally signed by the lead discipline’s Principal Engineer, using a *certifying signature*. The Principal Engineer should make sure that all three digital signature form fields (blue boxes in the signature block) are placed before signing, as these forms cannot be added after the document is digitally certified. After processing has approved the 01_General subset for Advertising, the Manager, and the Transportation Engineering Administrator shall digitally sign the same sheet directly below the principal’s signature, using a *signing signature* while the plans are in the Manager and Engineer Admin. Sign state.

Processing shall notify the lead designer when the 01-General subset is placed in the Manager and Engineer Admin. Sign state. The lead designer shall then coordinate the digital signing by the Manager and Engineering Administrator of the 01_General subset. When both signatures are applied to the plans, the lead designer shall then notify processing that the 01-General subset has been signed.
See Section 5.7 Applying Digital Signature Workflows

Note: When digitally signing the 01_General subset all signers shall leave the reason code blank.

The following image shows a typical project title sheet from the 01_General subset that is digitally signed:

![Figure 57 - Title Sheet Digital Signatures](image)

CONSULTANT DESIGNED PROJECTS:
The project title sheet of the 01_General subset shall be digitally signed by the lead consultant, using a certifying signature.

See Section 5.7 Applying Digital Signature Workflows

![Figure 58 - Consultant Designed Title Sheet](image)
When more than one consultant works on a CTDOT digital project the project manager (prime consultant) shall apply a visible certifying signature to the first page of the 01_General subset. By applying this signature the prime consultant is accepting responsibility for the entire set of digital contract plans. However the individual subsets shall be signed by the corresponding firms.

Note: When applying certifying or signing signatures leave the reason code blank.
5.6.2 Applying a Digital Signatures to 02_Revisions Subset

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a CTDOT signature, but the workflows are the same.

This subset does not need to be signed at FDP. This subset must be signed when the sheet is filled out for an Addendum or design initiated change order, whichever comes first.

The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed by the lead designer, using a certifying signature.

1. The lead designer shall apply a **certifying signature** as described in section 5.7 Applying Digital Signature Workflows with the following EXCEPTION; the option “No Changes Allowed” must be selected to eliminate unauthorized changes after certifying the document. See the figure below:

![Figure 59 Certifying Dialog Box for 02_Revisions.pdf](image-url)
5.6.3 All Other Discipline Subsets - Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same.

Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the responsible design engineer. As shown below.

See section 5.7 Applying Digital Signature Workflows

![CTDOT Certified Plan Subset](image)

Figure 60 CTDOT Certified Plan Subset

5.6.4 Standard Drawing Subsets – Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same.

Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need to be digitally signed with a visible certifying signature, by the responsible design engineer that submits the subset to Projectwise. For example, in the case where the Traffic unit is submitting a Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the index sheets, not the Highway Principal Engineer.

See section 5.7 Applying Digital Signature Workflows

5.6.5 All Other Discipline Subsets – Multi-Signatures

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same for CTDOT designed projects.

Multiple signatures per a single subset are required where two or more disciplines/firms are responsible for one subset.

The lead designer that is responsible for most of the pages within a discipline subset shall digitally sign the subset using a certifying signature, and leave the reason code blank. See Section 5.7 Applying Digital Signature Workflows

Once certified by the subset lead, the remaining designers(s) shall digitally sign the same subset using a signing signature, and complete the reason code with a note stating which pages, contained in this subset, that they are responsible for. See table 2-1 below:

See Section 5.7 Applying Digital Signature Workflows
Table 1 Reason Codes for Prime and Sub Consultants

<table>
<thead>
<tr>
<th>Designer</th>
<th>Certify or Sign</th>
<th>Responsible Sheet Numbers</th>
<th>Reason Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead Designer</td>
<td>Certify</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sub-Designer 1</td>
<td>Sign</td>
<td>03.78 Thru 03.88</td>
<td>I am Signing for Sheet Nos. 03.78 thru 03.88</td>
</tr>
<tr>
<td>Sub-Designer 2 –</td>
<td></td>
<td>03.88 Thru 03.98</td>
<td>I am Signing for Sheet Nos. 03.88 thru 03.98</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5.6.6 Working Drawings

Working drawing submittals shall be digitally certified in accordance with section 5.7 Visible Digital Signature using a Certifying signature, of this manual.

5.6.7 Engineering Reports

Engineering Reports shall be digitally signed, by the applicable person using a certifying. See section 5.7 for instructions on how to apply a certifying signature to an engineering report. If a report needs to be digitally signed by more than one person, the first person must apply a certifying signature as shown in section 5.7 and any subsequent signature will be a signing signature as shown in section 5.7.

5.6.1 Bridge Load Ratings

Load Ratings shall be digitally signed, by the applicable person using a certifying signature with the No Changes Allowed option selected as shown below:

Figure 61 Certifying Load Ratings
5.7 Applying Digital Signature Workflows

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a CTDOT signature where the document is located in Projectwise, but the workflows are the same.

Certifying Signature:
1. Left click on the signature field and then update the settings as shown below. Examples below are for a CTDOT designed project’s title sheet and the first sheet of an Engineering Report:

**Discipline Subsets**

**Engineering Reports or Documents that Require (1) Digital Signature**

**FINAL HYDRAULIC REPORT**
FOR SOUTH MAPLE STREET BRIDGE
OVER SCANTIC RIVER
(Bridge No. 03972)

Enfield, Connecticut

PREPARED BY: Tectonic Engineering & Surveying Consultants PC
March 8, 2010

Prepared By: Date: 1/21/14
Mathew Calkin

Checked By: Date: 1/21/14
William Pratt

Click on the signature field to certify

**Figure 62 - Certifying Discipline Subsets**

**Figure 63 - Certifying Engineering Reports**
2. Next for document in located in Projectwise click Projectwise V8i as shown below and then click OK. If the document is located on your computer click My Computer list below:

Figure 64 - Certifying Signature

3. Then select yes to overwrite existing file as shown below for projectwise or if the document is located on your computer overwrite the existing file or save to a new location:

Figure 65 - Certifying Signature

4. If using Projectwise check the document back into Projectwise.
**Digital Signing Signature:**
Once the prime engineer applies his certifying signature the additional signing signatures can be applied by the sub-consultants as follows:

1. Left click on the signature field and then update the settings as shown below:

![Figure 66 - Signing Signaure Bluebeam](image)

2. Next for document in located in Projectwise click Projectwise V8i as shown below and then click OK. If the document is located on your computer click My Computer list below:

![Figure 67 - Open from Projectwise](image)
3. Then select yes to overwrite existing file as shown below for projectwise or if the document is located on your computer overwrite the existing file or save to a new location:

![Figure 68 - Overwriting a File](image)

4. If using Projectwise check the document back into Projectwise.
Section 6 Submitting Documents to CTDOT

This section details the procedures for submitting documents to Projectwise.

6.1 FDP Submittal to Processing

The files required to be submitted to Processing must be added to the set file stored in the 240_Contract Development folder as shown below. The set file creates a link to the document so documents can be stored in separate folders, but show up together. When files are added to a set file they are not moved, a link is created.

If there is not a set file in the 240_Contract Development folder in Projectwise contact DOT.AECApplications@ct.gov or follow these steps to create a set file in the 240 Contract Development folder:

1. Right click on the 240 folder, right click in the white area and select properties.
2. Then select Set->New

![Figure 69 - Creating a Set File](image-url)
After the file is created populate the set file as follows:

1. Open the Set file by double clicking on it.
2. Then browse out the folder where the documents are stored.
3. Then drag and drop the document(s) into the set file window as shown below:

![Figure 70 - Adding Files to the Set File](image-url)
6.2 Uploading Documents

6.2.1 ProjectWise (Thin Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in ProjectWise, but this procedure can be followed for uploading documents into any folder in ProjectWise.

1. Once logged into ProjectWise browse out to project and folder you need to upload into. Then go to View>Interfaces and select the “CTDOT_Doc_Code” Interface.

![Selecting the Interface](image_url)

Figure 71 - Selecting the Interface
2. Next select Document>Upload as shown below:

Figure 72 - Uploading Document into Projectwise (Thin Client)

3. Next browse out to the document you want to upload.

Figure 73 - Uploading a File to Projectwise
4. After the file uploads, right click on the file and select Properties:

![Right Click on the file and select Properties](Image)

**Figure 74 - Select Properties**

5. Then assign the applicable attributes from the tables in [Projectwise Attribute Table]: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.

![Select these attributes](Image)

**Figure 75 - Thin Client Attributes**
6.2.2 Uploading Documents – Projectwise (Thick Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in
Projectwise, but this procedure can be followed for uploading documents into any folder in
Projectwise.

1. Select the **Interface** “CTDOT_Doc_Code” as shown below, if the interface box is not
   shown go to View>Toolbars and select interface.

2. Drag and Drop files into the correct folder in the Project.

---

**Figure 76 - Uploading Into Projectwise (Thick Client)**
3. Select the “Advanced Wizard”
4. Click “Next” until you reach the figure below:
5. Then assign the applicable attributes from the tables in Projectwise Attribute Table: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.

7. On the create document page click next and the document will be uploaded into Projectwise.
8. Once the document is uploaded the user may need to click F5 (refresh) to see the file name update.
6.3 PDF Checker – Contract Plans

The Discipline Subset PDF Checker software was developed to check that Contract Plan Discipline Subsets are formatted and delivered to CTDOT correctly. This checker replaces the old requirements of attaching the discipline subset checklist to each subset and stamping each subset with the green QA/QC stamp. These two things are no longer required.

This checker is an add-on to Projectwise Thick Client and can only be run using Projectwise Thick Client. See Section 6.2.2 for the typical workflows for using the PDF Checker. This section provides details for Projectwise Thin Client users.

The following details what is checked with this software:

1. CAD Requirements have been completed correctly:
   a. Page Size (see Section 4.2)
   b. Searchable Text (see Section 4.2)
   c. Levels (see Section 4.2)

2. PDF post processing steps have been completed correctly:
   a. Page labels (see Section 4.14.2)
   b. Sheet numbers (see Section 4.14.2)
   c. Watermarks and flatten comments (see Section 5.4)
   d. Any digital signature fields (see Section 5.5)
   e. Digital Signature (see Section 5.6)

3. The subset was uploaded and attributed correctly in Projectwise.

After the PDF checker is run, an Excel report is created detailing what is incorrect on each subset. Things that are incorrect will show up red and include a note on what is incorrect. Also an attribute in Projectwise call Format Compliance will be set to PASS or FAIL when a document is run through the checker:

![Figure 78 - Format Compliance Attribute](image)

The PDF checker must be run on all discipline subsets that are submitted to CTDOT, which includes the following submittal types: FDP, DCD, DCD2, ADP, ACD, or DCO submittals.
6.3.1 Installing the PDF Checker

This step is for consultants only, DOT staff already have the checker installed.

1. Download the PDF checker executable from this link: [Discipline Subset PDF Checker](#)
2. Close Projectwise if it is open.
3. Run the executable.

6.3.2 Typical Workflow for using the PDF Checker

**CTDOT Designed Projects**
The following details the typical workflow for a CTDOT designed project:

1. Each discipline prepares their subset(s) and uploads their unsigned subsets into Projectwise in accordance with this manual.
2. Then the PDF Checker is run on the unsigned subset(s). By running the checker on the unsigned subsets, any errors can be found before the Principal digitally signs. Note: An error will be returned that a signature was not found and the Projectwise attribute will show FAIL.
3. If there are any other errors, other than the signature error, they shall be fixed. If the only error in the report is the signature error, then the plans can be digitally signed by the principal.
4. After the plans are digitally signed, run the PDF Checker again on the subset(s) to check the digital signature was applied correctly. If there are no errors then the check is complete. If there are any errors they shall be fixed and the PDF Checker rerun.
5. The project lead should check in Projectwise that all subsets have PASS in the Format Compliance attribute column.
6. The Processing unit will be looking for the Format Compliance attribute column to be set to PASS before they process the subset.

**Consultant Designed Projects**
The following details the typical workflow for a Consultant designed project:

1. Each consultant prepares their subset(s) and uploads their subsets into Projectwise in accordance with this manual.
2. Then the PDF Checker is run on the subset(s). If the consultant or sub-consultant does not have Projectwise Thick Client, contact your CTDOT Consultant Liaison or the lead consultant on the project to run the PDF Checker on those discipline subsets. Any error shall be fixed and the checker rerun until the report does not have any red errors.
3. The CTDOT Consultant Liaison or the lead consultant should check in Projectwise that all subsets have PASS in the Format Compliance attribute column.
4. The Processing unit will be looking for the Format Compliance attribute column to be set to PASS before they process the subset.
6.3.3 Using the PDF Checker

This software has the capability to check one subset at a time or multiple subsets. The following shows how to check multiple discipline subsets, but the procedure is the same for checking one subset.

1. Log into Projectwise.
2. Browse out to your project and open the 100_Contract_Plans folder.
3. Select a discipline subset(s) or all the subsets, right click and select DMSconform>PDF Check. Hold control or shift to select multiple subsets.

4. Click OK on the dialog box shown below:

![Figure 79 - Selecting the Subsets and Running the Checker](image)

Select all subsets, right click and select DMSconform>PDF Check

![Figure 80 - PDF Checker](image)
5. After the PDF Checker runs click Yes Report on the dialog box shown below. Note: The PDF Checker may take a few minutes to process depending on the size of the files it is checking.

![PDF Checker Report](image)

Figure 81 - PDF Checker Report

6. In the report, errors will show up in red and if you hover over a red piece of text it will show the details of what is incorrect. If any false errors show up in the report, please notify DOT.AECApplications@ct.gov with the project and document(s) you are having issues with. Example of false errors could be the page labels were applied to the subset but the report details they were not.

![PDF Checker Report](image)

Figure 82 - PDF Checker Report

The Format Compliance attribute will also be set when the checker is run. It will return a PASS or FAIL value as shown below:

![Format Compliance Attribute](image)

Figure 83 - Format Compliance Attribute

7. If there are no errors in the report and all document have PASS in the Format Compliance attribute, this process is complete. If there are errors, the errors shall be fixed and the checker rerun.
Section 7  Contract Plan and Special Provision Revisions (Addenda and Design Initiated Change Order)

7.1 Addenda
Contract plans that are revised or added due to addenda shall be submitted in digitally signed PDF discipline subsets containing only the changed sheets. The sheets being revised or deleted shall not be included in the Addenda submittal. The first sheet of each addendum subsets shall be digitally signed in a digital signature place holder, that is placed in Microstation as described in Section 5 of this manual. Addendum subsets DO NOT need an index of drawings sheet. Once digitally signed, the addendum subsets shall be submitted to CTDOT using Projectwise, as described in Section 6 of this manual.

Addenda sheets from different subsets cannot be combined and submitted as one subset, they must be submitted per their respected subsets.

The discipline Addenda subsets shall be attributed as follows, when uploaded into Projectwise (See Section 6): The addenda subset shall have the same Projectwise label as the original final plan subset with the addition of (_A##) added to the end, where the ## equals the addenda number. The sub-category attribute shall be ADP and ACD if the ADP plans are revised. See example below:

<table>
<thead>
<tr>
<th>PROJECTWISE LABEL ATTRIBUTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Discipline Subset:</td>
</tr>
<tr>
<td>Addenda Discipline Subset:</td>
</tr>
<tr>
<td>2nd Addenda</td>
</tr>
<tr>
<td>6th Addenda</td>
</tr>
</tbody>
</table>

The contract sheets (previously submitted final plans or earlier addenda plans), being revised by addenda shall NOT be modified except; the Engineer of Record shall place an addenda stamp on the affected sheets. This addenda stamp crosses out the entire sheet with a red X and adds the following note; "THIS SHEET REPLACED BY ADDENDUM NO."Y"; where "Y" equals the addenda number. This stamp is placed over digital signatures therefore; removal of the signatures is not required prior to placing the addenda stamp. For this process see Section 7.4.

WARNING – When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the project manager for all addenda, and submitted as described in Section 7.3.1. A new subset must be updated for each addendum.

A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants) shall be placed on all added or revised sheets. See Section 5.2

Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent to all applicable units following Section 3.2.12.
7.1.1 Revised Plans - Addenda

Microstation Processes
A note shall be placed, directly above the bottom right hand corner of the title block, on the replacement sheets stating “ADDENDUM NO. “Y”, where “Y” equals the addenda number. This note is a level in Microstation that needs to be turned on and edited.

For revised sheets the drawing numbers shall not be modified.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be placed somewhere on the line of the cloud. A like numbered triangle shall be placed in the revision block of the changed sheet, accompanied by a description of the revision itself. The revision number is specific to a particular sheet, and increases in consecutive order per revision and per addenda. If a sheet is changed for the first time under addenda five the revision number is 1 NOT 5. If it is changed again under addenda 7 the revision number becomes 2.

Note: If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a clear manner, do not void out the existing sheet and create a new sheet. In these instances, the designer shall place a cloud just inside the border of the revised addendum sheet.

Note: When preparing an Addendum that will change quantities on a project that includes a "Detailed Estimate Sheet", never revise the "Detailed Estimate Sheet." A "Detailed Estimate Sheet" is never included in an addendum. Also, the "Quantities" box shown on the General Plan sheet for any structure is never to be revised.

Bluebeam Processes
Sheet numbers for revised plans shall be as follows:
Original Final Plan Sheet;

- Original: 02.25
- Addenda 1: 02.25.A1

Previous Addenda Sheet;

- Original: 02.25.A2
- Addenda 4: 02.25.A4

If a sheet requires further revisions by a subsequent addendum, the addendum shall be prepared, as detailed above. The previously revised sheet shall now be stamped using Bluebeam after addendum approval, see Section 7.4.

7.1.2 New Sheets - Addenda

Microstation Processes
Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within the discipline subset, the new sheet shall be placed last, and numbered sequentially from the last sheet of the discipline subset. The total number of sheets noted on the project plans and discipline subsets stays the same. A note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number. This note shall be located directly above the right hand corner of the title block. This
note is a level in Microstation that needs to be turned on and edited. The revision block on the added sheet, shall not be filled out.

2. If the designer determines that the new sheet must go in a specific location within the discipline subset, the new sheet number shall be the number of the previous sheet followed by (-1.A#), where # is the Addendum Number. For example, if the new sheet must be placed in a discipline subset right after sheet 02.57, the new sheet shall be numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be 02.57-2.A1. The total number of sheets noted on the project plans stays the same. A note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number. This note shall be located directly above the right hand corner of the title block. This note is a level in Microstation that needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. As with the sheet number the drawing number of the new sheet shall be the drawing number of the previous sheet plus a decimal and the sheet count. For example, if the new drawing must be placed in the project plans right after drawing number S-5, the drawing number shall be S-5-1.

Bluebeam Processes

Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows:

Original Final Plan Sheet;

Original: 04.31
Addenda 3: 04.31-1.A3

Previous Addenda - Added Sheet;

Original: 03.24.A1
Addenda 4: 03.24-1.A4

Previous Addenda - Revised Sheet;

Original: 05.14-1.A1
Addenda 2: 05.14-1.A2

Previous Addenda - Added Sheet;

Original: 05.14-1.A1
Addenda 2: 05.14-2.A2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet number plus .A#, where # equals the addenda number.

Original Final Plan Sheet;

Original Last Sheet: 04.31
Addenda 3: 04.32.A3
7.1.3 Adding New Subset – Addenda

The new subset shall be submitted by an Addendum and be prepared the same way as an FDP discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed, directly above the right hand corner of the title block, on the sheets stating “NEW SHEET ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. This note is a level in Microstation that needs to be turned on and edited. The label attribute on the new subset shall contain an “_A##”. The first sheet of a new subset to the contract will be a subset cover sheet and contain an index of drawings. Also the DO NOT update the project title sheet in the General subset to show the addition of new subsets to the project.

7.1.4 Voiding Sheets

Sheets submitted within final design plan subsets and addenda subsets shall NOT be deleted; but shall voided by the engineer of record with an addenda stamp, using Bluebeam. This addenda stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED BY ADDENDUM NO."Y"; where "Y" equals the addendum number. See Section 7.4

7.1.5 Addenda Special provisions

Contract Special provisions that are revised or added due to addenda shall be submitted digitally in accordance with Section 4.5

7.1.6 Addendum CTDOT Standard Drawing Subsets

The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance with the following.

The Addendum for a standard subset shall only include the added sheets, do not include all the standards for the project. Follow Section 4.4 to prepare the standard subset, only include the added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise, add an “A##” to the end of the label attribute.

Update the 02-Revision subset to record this change.

7.2 Design Initiated Change Order (DCO)

Design Initiated Change Orders (DCO) are change order requests in which the designer alters the original contract by:

- A revision to an existing plan sheet(s) or specification(s)
- The addition of a new plan sheet(s) or specification(s)
- The deletion of an existing plan sheet(s) or specification(s)

The creation and management of DCO’s shall be as specified in this section.

Contract plans changed or added due to DCO’s shall be submitted in a digitally signed PDF discipline subset(s) containing only the added or changed sheets. The sheets being revised or deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset shall be digitally signed in a digital signature place holder, that is placed in Microstation as described in Section 5 of this manual, DO NOT ADD a cover sheet. Once digitally signed the DCO subset(s) shall be submitted, to the CTDOT, using Projectwise as described in Section 6 of this manual.
DCO sheets from different subsets cannot be combined and submitted as one subset.

The discipline DCO subsets shall be coded as follows, when uploaded into Projectwise (See Section 6): The DCO subset shall have the same Label Attribute as the original final plan subset with the addition of (_C###) added to the end, where the ### equals the DCO number. The sub-category attribute shall be DCO (Design Initiated Change Order) See Examples below:

<table>
<thead>
<tr>
<th>PROJECTWISE LABEL ATTRIBUTE</th>
<th>Original Discipline Subset: 04-Traffic</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCO Discipline Subset:</td>
<td>04-Traffic_C01</td>
</tr>
<tr>
<td>6th DCO</td>
<td>04-Traffic_C06</td>
</tr>
<tr>
<td>Original Addenda Subset:</td>
<td>04-Traffic_A03</td>
</tr>
<tr>
<td>DCO Discipline Subset:</td>
<td>04-Traffic_C01</td>
</tr>
<tr>
<td>3rd DCO</td>
<td>04-Traffic_C03</td>
</tr>
</tbody>
</table>

The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being revised by DCO shall NOT be modified except; the Engineer of record shall place a DCO stamp on the revised sheets using Adobe Acrobat. This digital DCO stamp crosses out the entire sheet with a red X and adds the following note; "THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO."Y" –mm/dd/yy; where "Y" equals the Design Initiated Change Order number. This stamp is placed over digital signatures therefore; removal of the signatures is not required prior to placing stamp. For this process see Section 7.4

WARNING – When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset shall be updated by the project manager for all DCO, and submitted as described in Section 7.3.2.

A watermark of the signer’s signature, signature only for (CTDOT), or PE Stamp for (Consultants) shall be placed on all DCO sheets. See Section 6.2

Paper copies for all change orders will be requested and sent to all applicable units’ following Section 3.2.12.

7.2.1 Revised Sheets – DCO

**Microstation Processes**

A note shall be placed, directly above the right hand corner of the title block, on the replacement sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design Initiated Change Order number. This note is a level in Microstation that needs to be turned on and edited.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be placed somewhere on the line of the cloud. A like numbered triangle shall be placed in the revision block of the changed sheet, accompanied by a description of the revision itself. The revision number is specific to a particular sheet, and increases in consecutive order per revision.
and per change to the sheet. If a sheet is changed for the first time under addenda #5 then change for DCO #1 revision number is 2 NOT 1. If it is changed again under DCO 2 the revision number becomes 3.

Details shown on the original PDF, but no longer required, shall not be deleted on the revised PDF, but shall be crossed out. Any details to be deleted shall be crossed out with an “X” on the revised sheet. Engineering judgment must be used to produce clear and concise information for the contractor.

If the number of changes to the sheet cannot be clouded in a clear and concise manner, the existing sheet should be voided in accordance with Section 7.2.4 and a new DCO sheet created in accordance with Section 7.2.2

**Bluebeam Processes**
Sheets for revised plans shall be as follows:

Original Final Plan Sheet;

<table>
<thead>
<tr>
<th>Original</th>
<th>02.25</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCO 1:</td>
<td>02.25.C1</td>
</tr>
</tbody>
</table>

Previous Addenda Sheet;

<table>
<thead>
<tr>
<th>Original</th>
<th>02.25.A2</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCO 4:</td>
<td>02.25.C4</td>
</tr>
</tbody>
</table>

Previous DCO Sheet;

<table>
<thead>
<tr>
<th>Original</th>
<th>02.25.C2</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCO 4:</td>
<td>02.25.C4</td>
</tr>
</tbody>
</table>

Drawing numbers shall not be modified on revised sheets.

Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp (Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section 5 of this document.

### 7.2.2 New Sheets – DCO

**Microstation Processes**
Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within a discipline subset, the new sheet shall be numbered sequentially from the last sheet of the discipline subset. The total number of sheets noted on the project plans and discipline subsets stays the same. A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” where “mm/dd/yy”
equals the month, day and year the change order request was submitted. This note shall be located directly above the title block. This note is a level in Microstation that needs to be turned on and edited.

2. If the designer determines that the new sheet belongs in a specific location within a discipline subset, the new sheet number shall be the number of the sheet it most closely relates to followed by (-1.C#). For example, if the new drawing should reside in the 03-Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet shall be numbered 03.57-1.C#.

The total number of sheets noted on the project plans stays the same. A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” where “mm/dd/yy” equals the month, day and year the change order request was submitted. This note shall be located directly above the bottom right hand corner of the title block. This note is a level in Microstation that needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. The drawing number of the new sheet shall be the drawing number of the sheet it most closely relates to followed by (-#). For example, if the new drawing must be placed in the project plans right after drawing number HWY-10, the drawing number shall be HWY-10-1.

**Bluebeam Processes**

Added sheet numbers, to a specific location, shall be as follows:

Original Final Plan Sheet;
Original: 04.31
DCO 3: 04.31-1.C3

Previous Addenda – Added Sheet;
Original: 03.24.A1
DCO 4: 03.24-1.C4

Previous DCO – Revised Sheet;
Original: 02.45.C1
DCO 2: 02.45.C2

Previous Addenda - Added Sheet;
Original: 05.14-1A1
DCO 2: 05.14-2.C2

Previous DCO – Added Sheet;
Original: 02.45-1.C1
DCO 2: 02.45-2.C2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet number plus C#, where # equals the Design Initiated Change Order Request number.

Original Final Sheet

Original Last Sheet: 04.35
DCO 4: 04.36.C4
7.2.3 New Subset – DCO
The new subset shall be submitted by DCO and be prepared the same way as an FDP discipline subset, with the addition of an C# in the sheet numbers and a note shall be placed, directly above the right hand corner of the title block, on the replacement sheets stating “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. "Y" – mm/dd/yy, where “Y” equals the Design Initiated Change Order number. This note is a level in Microstation that needs to be turned on and edited. The label attribute shall contain “_C##”. The first sheet of a new subset to the contract will be a subset cover sheet and contain an index of drawings.

7.2.4 Voided Sheets
Sheets submitted within final design plan subsets, addenda subsets, or design initiated change order subsets shall NOT be deleted; but shall be voided by the engineer of record, with a DCO stamp using Adobe Acrobat or Bluebeam. This DCO stamp crosses out the entire sheet with a red X and adds the following note; “VOIDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy; where "Y" equals the Design Initiated Change Order number. See Section 7.4

7.2.5 DCO Special provisions
Special provisions shall be created in accordance with the Departments policies and procedures for Contract Development. The Engineer shall also combine all special provisions into (1) PDF document and upload that into the 110_Contract Special provisions (PDF) folder in Projectwise following Section 4.5

7.2.6 DCO Memorandum from Designer to Construction
A DCO Memorandum from the Designer to Construction shall be prepared for all change orders and include the following. This memorandum shall not include any digitally signed DCO plans and/or DCO specifications. The digitally signed DCO plans shall be uploaded into the 100_Contract Plans folder in Projectwise and the DCO Specs. shall be uploaded into the 110_Contract folder in Projectwise:

- A detailed description and justifications of the changes requested.
- Identify the funding source if known.
- A listing of each new, revised, replaced and/or voided plan sheet(s).
- A listing of each new, revised, replaced and/or voided special provision(s).
- A list of the changes in the estimated quantities for the project (increase, decrease). The list should also include any item that is new to the project or any item that is deleted as a result of the revised work. Item numbers of items already in the project should be provided. Item numbers for items that are not currently in the contract should be provided if known.
- The estimated increase in cost or credit associated with the change order request.

The DCO Memorandum shall be submitted into Projectwise in accordance with Section 4.10

7.2.7 DCO CTDOT Standard Sheet Subsets
The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the following.

The DCO for a standard subset shall only include the added sheets, do not include all the standards for the project. Follow Section 4.4 to prepare the standard subset, only include the added sheets and check off only those sheets on the index sheets.
When uploading to Projectwise add an “C##” to the end of the label attribute.

Update the 02-Revision Subset to record this change.

### 7.3 02-Revisions Subset

The project manager is responsible for managing this subset. The subset can be downloaded from these links:

- CTDOT Designed Projects - [02-Revisions Subset](#)
- Consultant Designed Projects - [02-Revisions_CE_Subset](#)

Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions Sheet(s)”. These revision sheets are used for tracking all sheet changes due to addenda (ADP) and Design Initiated Change Order (DCO) with respect to the entire project. The 02-Revisions subset starts out as an un-signed blank place holder in the project. The figure below is an example of a blank 02-Revisions subset:

![Figure 84 - Blank 02-Revisions Subsets](#)

**ADDENDA:**

When the project requires an Addendum, the Project Manager must record these changes on a **NEW 02-Revisions_A##** subset, where A## equals the Addendum ##. New 02-Revisions subsets shall contain all previous Addendum information. For example, Addendum 4 shall include all changes made from Addendums 1, 2, 3 and 4.

Note: A New 02-Revisions subset is required for each addendum because there are times when multiple addendums are being submitted to processing for the same project. An example of this is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two addendum revision sheets must be submitted.
DESIGN INITIATED CHANGE ORDER:
When a project requires a Design Initiated Change Order (DCO), the following process shall be followed:

For each DCO, the Project Manager shall **AMMEND** the 02-Revisions subset. The 02-Revision subset shall always contain all previous Addendum information and the new DCO information. For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum information as well as the changes made for DCO #1.

The following figures are an example of the “Index of Revisions Sheet(s)” completed up to Addendum #3:

**Figure 85 - Index of Revisions Sheet**
Detail A from figure 1 shows the information typed in for a change to the contract plans. The project designer inputs the Addendum or DCO number, the sheet number, the date, a description of the change, the person who made the change, and checks the appropriate box for: new sheet added, revised sheet or deleted sheet.

**Figure 86 - Detail A**
Detail B from figure 1 shows the title block information.
7.3.1 02_Revisions Subset Workflow - Addenda

Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project Manager as follows:

1. The user will export/download the latest 02-Revisions subset out of Projectwise to their local computer.

2. With your digital signature USB key inserted within the USB, right click on the Signature Box and select Clear Signature as shown below, this is the first Addendum this step can be skipped since the subset will not have a signature on it:

![Figure 88 Clearing the Digital Signature](image)

3. Enter the information into form fields as described in [Section 7.3.4](#).

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the title block, where Y = the Addendum number.

5. Add new revision sheet each time previous sheet becomes full. Add note “NEW SHEET ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. Follow [section 7.3.3](#) of this document.

6. When finished sign using a certifying signature as shown in [Section 5.6.2](#).

7. Upload the document into Projectwise.

8. Attribute the subset: Main Category = CON, Sub-Category = ADP, Label = 02-Revisions_A##

9. Make the document description 02-Revisions_A##.
7.3.2 02_Revisions Subset Workflow - DCO

The following workflow shall be used by the Project Manager for recording DCOs to the 02-Revisions subset. In this workflow the user edits the subset in Projectwise, they do not have to export the document out and submit a new subset:

1. Check out the 02-Revisions subset from Projectwise.
2. With your digital signature USB key inserted within the USB, right click on the Signature Box and select Clear Signature as shown below, this is the first Addendum this step can be skipped since the subset will not have a signature on it:
   ![Figure 89 Clearing the Digital Signature](image)
3. Enter the information into form fields as described in section 7.3.4.
4. Edit the note above the title block with “DESIGN INITIATED CHANGE ORDER NO. Y - mm/dd/yy”
5. If a new revisions sheet is added, add the note above the title block with “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy”
6. Resign the 02-Revision subset in accordance with Section 5.6.2
7. In step 7 “Check In” the document into Projectwise

7.3.3 Adding a New Revisions Sheet to the 02_Revisions Subset

1. Download a new “Index of Revisions sheet” from Section 7.3.
2. Insert the new sheet into the existing 02-Revisions subset pdf. Update the title block information and update the sheet accordingly.

7.3.4 Filling Out Revision Index Sheet

To fill out a form field simply click on the box and begin typing. The first column is the Addendum or Design Initiated Change Order. The second column is the revised or new sheet number. The third column is the date, followed by a brief description that is similar to the description on the actual sheet being revised. Finally click in the appropriate check box per row to describe the action taken, new sheet, revised sheet, or sheet deleted. Note: The Engineer is not required to input changes numerically by Sheet No. If another changed sheet is added to an Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of Revisions Subset”.

---
7.4 Placing Stamps on Affected Sheets – Revised, or Deleted Sheets

A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that are affected by Addenda or Design Initiated Change Order. The stamp shall be placed using Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or in Markup>Stamps as shown below:

If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User Profile as shown in Appendix A. If you do not have the stamp in the Markups>Stamp area, see Appendix A – Bluebeam Stamps

WARNING – When placing the stamps, removing the digital signature is not allowed.
Table 4-1 below lists the notes that shall be used for addenda, construction order requests, and as built notes. These notes should be used in conjunction with the cross-out stamp.
The following shows how to apply the stamp to the sheet that needs to be crossed out for an Addendum or Change Order.

1. Select the stamp from the Tool chest or Markup>Stamps and place it:

![Addendum and Change Order Stamp](image)

**Figure 92 - Addendum and Change Order Stamp**

2. After the stamp is placed a box will pop up. Enter the applicable note from table 4-1 below in all caps as shown below:

![Enter Note for Addendum and Change Order Stamp](image)

**Figure 93 - Enter Note for Addendum and Change Order Stamp**

**Table 7-1 Modifications to Existing Sheets by Addendum, Construction Orders and As-Builts**

<table>
<thead>
<tr>
<th>Addendum Notes</th>
<th>Description of Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS SHEET REPLACED BY ADDENDUM NO. Y</td>
<td>The revised sheet is considered to replace, in total, the original sheet.</td>
</tr>
<tr>
<td>VOIDED BY ADDENDUM NO. Y</td>
<td>Sheet is voided by Addendum.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Design Initiated Change Order Notes</th>
<th>Description of Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy</td>
<td>Used for revisions to existing sheets. Changes must be noted only on the revised sheet.</td>
</tr>
<tr>
<td>VOIDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy</td>
<td>Use this for voiding of existing sheets.</td>
</tr>
</tbody>
</table>
3. The following shows a completed stamp.

Figure 94 Typical Sheet Replaced by Addendum 1

Figure 95 Typical Sheet Replaced by DCO
Section 8  As-Built Comments - Final Plans

As stated in the CTDOT’s Construction Manual chapter 1-313 “Final Revisions of Plans and Cross Sections”, it is the responsibility of either the Contracting Engineers (Consultant Inspectors) or State Forces (Office of Construction) to perform final as-built revisions of Contract Plans. As-Built revisions shall be recorded in accordance with Chapter 1-313 of the Construction Manual, amended as follows:

Final as-built revisions will be applied to the digitally signed PDF plans as a digital comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed over the top of the digital signature and its security, therefore, the original content of the PDF plans can never be altered. Because as-built comments are digital and placed over the top of the plans they are easily recognizable, searchable, and may be turned off if necessary.

As-built comments shall be applied to the latest sheet, whether it’s the original, addenda, or construction order plans, located in ProjectWise within the project’s 100_Contract Plans folder.

If additional As-Built information has been created, (information that cannot be placed on the digitally signed contract plans), these sheets shall be combined by subset number and uploaded into the 100_Contract Plans folder in Projectwise.

CAD drawings may be updated, at the discretion of each design office, to reflect any addenda, change orders, and as-built revisions for use in the future; however the original digitally signed as-built PDF plans shall not be replaced and shall be the PDF set for permanent records.

8.1 As-Built Revisions (Digital Comments) Workflow

Two methods for applying as-built revisions to the digital PDF plans are provided in the following sections; 5.1.1 and 5.1.2.

The first method, Section 5.1.1 Post Construction, district staff shall record as-built revisions on their record set (paper copies) during construction. Once construction is completed these revisions shall then be applied as comments to the digital PDF per the workflow in section 8.1.1.

The second method, using Section 5.1.2 Active As-Built, district staff shall record as-built revisions on their record set (paper copies), and shall apply them as comment to the final set of digital PDF plans on an intermittent bases, during construction. By using this method as-built information becomes available to all parties that have access to ProjectWise during the construction process, improving communication and transparency.
8.1.1 Post Construction As-Built

### As-Built Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>Personnel</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chief Inspector</td>
<td>Notify the Contracting Engineer or Designated District Staff that As-Builts can be applied to the Contract Plans.</td>
</tr>
<tr>
<td>2</td>
<td>Contracting Engineer</td>
<td>Apply As-Built revisions to the Contract Plans in accordance with <a href="#">Section 8.3</a>.</td>
</tr>
<tr>
<td>3</td>
<td>Contracting Engineer or</td>
<td>Notify all applicable personnel list in the <a href="#">Section 8.4.2</a> that the As-Builts have been completed for this project.</td>
</tr>
<tr>
<td></td>
<td>District Staff</td>
<td></td>
</tr>
</tbody>
</table>

8.2 As-Built Markup of Contract Plans

All as-built information will be placed using a few basic Bluebeam commenting tools. These tools include text tools, line and arrow tools, and stamp tools (all other tools will still be available under the main toolbar). These tools will be in the right-hand panel under “CTDOT As Built Tools” tool box when the CTDOT As-Builts Profile is selected (see [CTDOT Bluebeam Profile](#)):

![Figure 96 - As-Built Commenting Tool](#)
8.3 Applying As-Built Comments to Contract Plans

8.3.1 Before Using Bluebeam for As-Builts

All CTDOT users are required to complete the steps in Appendix A prior to applying as-built revisions. By completing these steps as-built revisions will be standardized across all CTDOT users. These steps only need to be completed the first time using Bluebeam or when the user logs into a new computer.

- Perform the initial login steps for Bluebeam. Initial Log Into Bluebeam
- Download the CTDOT Bluebeam profile. Download CTDOT Bluebeam Profile
- The user must have a ProjectWise login/password. Contact Julie Annino if you do not have a ProjectWise Username and Password.

8.3.2 Opening the Contract Plans from Projectwise

The contract plans are located in the 100_Contract_Plans folder of the project in Projectwise, as shown below:

![Figure 97 - Location of the Contract Plans in Projectwise](image-url)
1. Login into Projectwise, then browse to the 100_Contract_Plans folder of the project you are working on.
2. To open a document with Bluebeam right click on the document, and select “Open With” as shown below:

   ![Figure 98 - Open With Bluebeam](image1)

   Right click on the plan subset to open and select "Open With"

3. Select the Bluebeam icon and check “Always use this program” and select OK. The document will now be checked out of Projectwise and open with Bluebeam:

   ![Figure 99 - Open with Bluebeam](image2)

   Select Check Select

   Note: Since we checked “Always use this program”, the next time you open a pdf in ProjectWise all you need to do is double click on the file.
4. After the As-Builts are applied to the contract plans click save in Bluebeam and then select “Check In” when a projectwise dialog box pops up. If the document is not checked back into Projectwise the As-Builts will not be uploaded to Projectwise.

8.3.3 Applying Digital As-Built Stamps

8.3.3.1 Construction Started & Completed Dates

The construction started and complete date stamps must be applied to the PDF title sheet, located in the 01_General subset, as stated below:

1. Select the “ConstructionStartedAndCompletedDates”: stamp from the “CTDOT As Built Tools” tool box and place it at a conspicuous location on the title sheet:

![Figure 100 - Construction Started and Completed Date Stamp](image)

2. Enter Start and end and click OK as shown below:

![Figure 101 - Entering the Dates for the Stamp](image)

Below is an example of the placed stamp:
Figure 102 - Placed Stamp
8.3.3.2 This Sheet Not Corrected Stamp

This sheet must be placed on all PDF sheets that do not contain as-built revisions. Detail Estimate Sheets must never be revised; therefore, they always receive this stamp.

1. To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the sheet, by clicking once.

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to every sheet included in plan set, including the as-built revised sheets, and then go back and remove it from the sheets that were corrected.

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the first sheet in the plan set:

![Figure 103 - Placing the "This Sheet Not Corrected Stamp"](image-url)
2. Right click on the stamp that was placed and select “Apply to All Pages”:

**Figure 104 - Placing the Stamp on All Pages**

This will place the “**THIS SHEET NOT CORRECTED**” stamp on every plan sheet within the pdf set.

**NOTE:** You must go back and replace this note on the sheets that contain as-built revisions with the appropriate stamp.
8.3.3.3 This Sheet Corrected

This stamp must be applied to all PDF sheets that contain as-built revisions.

1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand corner of the sheet, by clicking once.

If the majority of the sheets contain as-built revisions it is easier to apply this note to every sheet included in plan set, including sheets that do not contain as-built revisions, and then go back and replace it, with the appropriate stamp, on the sheets that were not corrected.

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the first sheet in the plan set:

2. **NOTE:** You must go back and replace this note on the sheets that do not contain as-built revisions with the “THIS SHEET NOT CORRECTED” stamp.

8.3.4 Applying Digital As-Built Notes

To place an as-built revision, simply select any of the provided tools located within the as-built tool box shown below and apply it to the document that is being as-built.

![As-Built Tools](image-url)
In the following example, the Line tool was used to cross out the existing text and the Text Box tool was used to add text:

![Line Tool](image1.png) ![Text Tool](image2.png)

Figure 106 - As-Built Note Example

Do not add a note to a comment by double clicking on the comment. For example, if a line was placed the user could double click on the line and add notes to it:

![Incorrect Way to Add Text](image3.png)

Figure 107 - Incorrect Way to Add Text

If notes are added this way they do not print.

8.3.4.1 Digital As-Built Stamps and Notes Using ADOBE

The following stamp files need to be downloaded to the user’s computer and placed in this folder: 
C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\. This could be either C:\ or D:\ Drive depending on your computer. With the “User” folder being the current user’s login Username. If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous sentence, if version 10 is used replace with 10.

**Stamp Files**
- As-Built stamps.pdf

These stamps are to be placed following Section 8.3 above.

As-Built notes shall be placed on the plans in accordance with Section 8.3 using the Adobe commenting tools in the following format:

1. Text Font shall be Cambria 16, and the color Red.
2. All line work shall be line width 2 and the color Red.
8.3.5 Additional As-Built Information

Additional As-Built Information that cannot be applied to the contract plans can be uploaded to Projectwise for future use. This information shall be uploaded to Projectwise in accordance with the following:

1. Combine the additional As-Built information into (1) PDF for each discipline subset. For example if the 03-Highway and the 04-Structures set had additional As-Built information, 2 separate PDFs would need to be uploaded to Projectwise.

2. After the additional As-Built information is combined into their respective files they will need to be uploaded and attributed into Projectwise in accordance with the following:
   a. Log into Projectwise Explorer.
   b. Make sure the Interface “CTDOT_Doc_Code” is selected.
   c. Drag and drop the PDF into the 100 Contract Plans folder in Projectwise.
   d. Select the advanced wizard.
   e. Click next until you get to the attributes page shown below and assign the following attributes:
      - Discipline = CT
      - Main Category = CON
      - Sub-Category = ASB
      - Label = Subset No. and name, for example for the 03-Highway set type 03-Highways.
      - Description = Additional As-Built information for....
   f. Then click next until the document uploads.
8.3.6 Setting Documents to Final Status in Projectwise

After the As-Buils are completed it is ready for permanent storage a final status will be applied to the document as shown below:

Select all the files or one at a time and then right click and select Change State>Set Final Status.

This will lock the file so no one can delete it. If a user needs to remove the final status contact DOT.AECApplications@ct.gov
8.3.7 Construction Completion Project Polygon

If the project limits were changed in construction, the project polygon KML file shall be updated. The following shows how to do this.

1. Browse out to the 170 Row Files folder under the project in Projectwise and double click on the FDP Boundary

![Image of project polygon folder]

Figure 110 - Project Polygons

2. Open the file with Google Earth. It may say KML like below.

![Image of Google Earth with KML file]

Figure 111 - Google Earth
3. After the polygon opens, right click on Style 1 and select properties. This will allow you to edit the polygon.

![Editing the Polygon](image1)

**Figure 112 - Editing the Polygon**

4. Then adjust the polygon as necessary by dragging the red points.

![Adjusting the Project Limits](image2)

**Figure 113 - Adjusting the Project Limits**
5. Then click OK on the properties box.

![Figure 114 - Adjusting the Project Polygon](image1)

6. Then right click on Style 1 and select Save Place As

![Figure 115 - Saving Project Polygon](image2)
7. Name the file construction polygon and save it as a KML file:

![Figure 116 - Saving a KML](image)

8. Then upload this file into the 170 Row Files folder in Projectwise and label the file Construction:

![Figure 117 - Saving Polygon to Projectwise](image)
8.4 Notifications

8.4.1 Notifying Department Personnel
After the as-built information has been completed, the person responsible for the as-built revisions shall notify the appropriate Department personnel (via e-mail):

- Lead Designer
- Chief Inspector
- Central Surveys
- ROW
- Central Construction
- Bridge Maintenance (if a structure is on the project)
- Mathew Calkins and Julie Annino – AEC Applications
  DOT.AECApplications@ct.gov
Section 9 Contractor Submittals

9.1 Introduction

This section details how various contractor submittals shall be formatted, submitted, and reviewed by CTDOT for projects that are not using a Document Control Software such as SharePoint or Primavera Contract Manager.

The contractor submittals that are detailed in this section are as follows:

- Working Drawings for Permanent Structures
- Working Drawings for Temporary Structures
- Shop Drawings
- Product Data
- Submittals
- RFIs
- RFCs

The following workflows take advantage of Bluebeam and CTDOT’s Projectwise site, which allow the Contractor and CTDOT to collaborate on the Contractor Submittals in a centralized location. Projectwise also allows the Contractor to access the Department’s comments quickly after the submittals are reviewed.

Contractor Requirements

The Contractor requirements for this procedure are as follows:

- Purchase a license of Bluebeam REVU or Extreme. This can be purchased from www.bluebeam.com or various resellers.
- All submittals that require a PE Stamp are required to be digitally signed using an ADOBE CDS or AATL Signature.
- Upload all submittals into CTDOT’s Projectwise Site. Fill out the following form to have a CTDOT Projectwise username and password set up for your company: CTDOT Projectwise New User Form
- The Contractor’s instructions for this procedure can be found here: Contractor Submittal Instructions

9.2 Contractor Submittal Review Process (CTDOT/Consultant)

CTDOT/Consultant shall review the contractor submittals using Bluebeam as follows. Before starting a review make sure you have downloaded the CTDOT Bluebeam profile. This profile contains all the markup tools as well as the submittal stamp that needs to be applied to all contractor submittals.

CTDOT Newington Employees – The profile is located on the X:// Drive in the V8 Admin>Bluebeam Resources>Settings folder. Just double click on the file called CTDOT Bluebeam User.

CTDOT District Construction Employees – Save this file to your desktop and then double click on it: Bluebeam Profile

Outside Consultants/Designers – A custom stamp must be created that includes your company’s information. See Appendix D of this manual to download and edit the stamp for your firm.
9.2.1 Contractor Submittal Review

Shop Drawing/Product Data Review

The following shows how to review a shop drawing or product data contractor submittal. These submittals shall be sent directly to the designer. In the case the submittal needs to be reviewed by another designer or design unit, the link can be forwarded to them and the following steps can be followed.

1. Log into Projectwise.
2. Browse out to your project and open the 120_Contractor Submittal folder of that project.
3. Then change the state of the submittal to be reviewed to REVIEWING. To do this right click on the submittal, select Change State, and then Next. This puts the submittal in a Reviewing state, which blocks the contractor from viewing the file.

![Figure 118 - Changing the State of the Submittal](image1)

Right click on a submittal and select Change State>Next

![Figure 119 - Changing the State](image2)

Click OK you do not need to enter a comment
4. Then double click on the contractor submittal file to open and check out the file.

5. In the case a submittal needs to be resubmitted, the new submittal must include any sheets/documents from the previous submittal that were stamped “No Exceptions Noted” or “Exceptions as Noted” along with the new sheets/documents so CTDOT is always working with a complete submittal package. If the revised submittal is not a complete package, the submittal should be rejected and the contractor shall resubmit a complete package.

6. To review the drawings/document markup the drawings/document with comments using the markup tools located in the tool chest shown below.

Figure 120 – Shop/Working Drawing Review Tools
For CTDOT employees the submittal review stamp is located in the tool chest in Bluebeam and should be placed on an open area of the drawing. For Consultants Appendix D must be followed before their stamp is located in the tool chest.

8. To place the stamp, left click on the stamp in the tool chest and then place it. All shop drawing sheets must be stamped with the action stamp. Product data sheets only need to have the first sheet stamped.

9. Next select the appropriate option from the java script window and click OK.
10. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging a corner as shown below:

To resize the stamp, first click on the middle of the stamp so the yellow circles appear, then click on a corner and drag it to the size that fits.

**Figure 123 - Submittal Review Stamp**

The stamp is now resized as shown below:

**Figure 124 - Resized Stamp**
11. After the review is completed, close the file and click yes to save.

12. Repeat the review process for each drawing/document in the submittal.

13. Then save the file and close Bluebeam. Then check the document back into Projectwise by clicking on Check In in the Check In dialog box as shown below:
14. Next prepare the response back to the Contractor as required by your business unit. If a separate document is created, save that file in 120 Contractor Submittals folder and make sure the label attribute of the response matches the label of the file submitted by the contractor. Also make sure to add Response in the description as shown below:

Figure 127 - Response Document
15. Then change the state of the submittal and response to CLOSED. If the state is not changed to CLOSED the Contractor will not be able to open the stamped drawings/document. Note: You will have to follow these steps twice to change the state of the response from Open to Closed.

![Figure 128 – Changing the State of a Document](image)

Right Click on the submittal and select Change State>Next

Click OK you do not need to enter a comment

![Figure 129 - Changing the State](image)

16. For Shop Drawings, Product Data, or Other types of Submittals, the Designer shall send an email notification to the Contractor stating their review is complete.
Working Drawing Review
The following shows how to review a working drawing contractor submittal. These submittals shall be sent to District Construction.

1. Log into Projectwise.
2. Browse out to your project and open the 120_Contractor Submittal folder of that project.
3. Then change the state of the submittal to be reviewed to REVIEWING. To do this right click on the submittal, select Change State, and then Next. This puts the submittal in a Reviewing state, which blocks the contractor from viewing the file.
4. Next if the submittal needs to be reviewed by a designer, forward the designer a link to the submittal.

**Reviewing the Working Drawing Submittal**

5. Double click on the contractor submittal file to open and check out the file.

6. In the case a submittal needs to be resubmitted, the new submittal must include any sheets/documents from the previous submittal that were stamped “No Exceptions Noted” or “Exceptions as Noted” along with the new sheets/documents so CTDOT is always working with a complete submittal package. If the revised submittal is not a complete package, the submittal should be rejected and the contractor shall resubmit a complete package.

7. To review the drawings/document markup the drawings/document with comments using the markup tools located in the tool chest shown below.

---

**Figure 132 – Shop/Working Drawing Review Tools**
Submittal Review Stamp

8. For CTDOT employees the submittal review stamp is located in the tool chest in Bluebeam and should be placed on an open area of the drawing. For Consultants Appendix D must be followed before their stamp is located in the tool chest.

Designer Review

The designer shall place a Reviewed stamp on the working drawing submittal. The Action stamp will be placed by District Construction.

9. To place the Reviewed stamp, left click on the stamp in the tool chest and then place it. All working drawing plan sheets shall be stamped with the reviewed stamp. Calculations and supporting documents only need to have the first sheet stamped with the reviewed stamp.

![Figure 133 - Reviewed Stamp](image)

10. Then select the appropriate option.

![Figure 134 - Reviewed Stamp](image)
11. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging a corner as shown below:

To resize the stamp, first click on the middle of the stamp so the yellow circles appear, then click on a corner and drag it to the size that fits.

**Figure 135 - Resizing the Stamp**

The stamp is now resized as shown below:

**Figure 136 - Resized Stamp**
12. After the sheets or documents have been stamped, click save and then check the file back into Projectwise.

13. Then prepare a response back to District Construction as required by your business unit. If a separate document is created, save that file in 120 Contractor Submittals folder and make sure the label attribute of the response matches the label of the file submitted by the contractor. Also make sure to add Designer’s RESPONSE in the description as shown below:

![Figure 137 - Response Document](image)

14. Then change the state of the Designer’s response to REVIEWING. If the state is not changed to REVIEWING the Contractor will be able to open the designer’s response.

![Figure 138 – Changing the State of a Document](image)
15. Then notify District Construction that the response has been uploaded.

**District Construction Review**

After the designer has reviewed the working drawing submittal, district construction do the following:

a. Review the designer’s comments and update the comments on the drawings/documents as necessary. District has the final say on what comments the contractor should be able to see.

b. Stamp each working drawing sheet with the action stamp, stamp the first page of any calculations or supporting documents with the action stamp.

c. Create the CTDOT response back to the contractor.

16. Open the file from Projectwise.

17. To place the action stamp, left click on the stamp in the tool chest and then place it.

   Each plan sheet in a working drawing submittals shall be stamped. For calculations and supporting documents in a working drawing submittal, only the first sheet of those files needs to be stamped.
18. Next select the appropriate option from the java script window and click OK.

![Figure 141 - Submittal Review Stamp](image)

19. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging a corner as shown below:

![Figure 142 - Submittal Review Stamp](image)
The stamp is now resized as shown below:

![Figure 143 - Resized Stamp](image)

20. After the review is completed, close the file and click yes to save.

![Figure 144 - Saving the Shop Drawing](image)

21. Repeat the review process for the each drawing/document in the submittal.
22. Then save the file and close Bluebeam. Then check the document back into Projectwise by clicking on Check In in the Check In dialog box as shown below:

![Check In Dialog](image)

**Figure 145 - Check In Dialog**

23. Next prepare the response back to the Contractor as required by your business unit. If a separate document is created, save that file in 120 Contractor Submittals folder and make sure the label attribute of the response matches the label of the file submitted by the contractor. Also make sure to add Response in the description as shown below:

![Submittal and Response Files](image)
24. Then change the state of the submittal and response to CLOSED. If the state is not changed to CLOSED the Contractor will not be able to open the stamped drawings/document. Note: You will have to follow these steps twice to change the state of the response from Open to Closed.

25. For Shop Drawings, Product Data, or Other types of Submittals, the Designer shall send an email notification to the Contractor stating their review is complete.
Section 10 Digital Review and Commenting

This section details the digital review process using Bluebeam’s collaborative online review tool called “Studio”. The procedures outlined below describe how to: 1) Create a review session, 2) Invite people to a session, 3) Join a session, 4) Comment in a session, 5) Close the session, and 6) Respond to comments made in the session. Also, directions for locking the documents after the review process to create a read-only final record copy to be stored for future use are also provided.

The following link in to a Bluebeam Resources website. On this website are videos for the Digital Review process: Bluebeam Resources. These videos show an overview, but specific details are found in this document.

10.1 Introduction

A digital review is when a document is reviewed in its native digital format or as a digital copy of the original paper document. Any required markups are placed directly on the document using a computer with software designed for managing digital reviews. The documents can also be printed from the review session and the paper copy marked up; however, those markups must get transferred back to the digital copy.

Advantages of a Digital Review Compared to Conventional Paper Review

2. Digital markups are searchable and sortable, by comment, author, etc.
3. Real time collaboration review process improves turnaround time and quality of the review.
4. Real time feedback allows easier handling of large amounts of data.
5. Reduces the time required to compile and resolve comments.
7. Reduces document printing.
8. Eliminates shipping cost.
9. Easily store a permanent digital record on the cloud.
10. Overall reduction in review time.

Types of Reviews:

This manual may be used as a guide to perform a digital document review on any digital document. Below is a list of examples of the types of documents that may be reviewed:

- Preliminary Design Plans
- Structure Type Studies
- Semi-Final Plans
- Final Plans for Review
- Special provisions
- Engineering Reports

Review Process:

To help participants of a digital review more easily track the digital review process it has been split up into six Phases as listed below:

- Phase 1 – Preparation of the Digital Documents
- Phase 2 – Set Up Digital Review
- Phase 3 – Invite Attendees to Review
- Phase 4 – Digital Review
- Phase 5 – Ending the Digital Review
- Phase 6 – Resolve Comments

Each phase and its required steps will be discussed later in detail.
Digital Comments:
In this review process, all comments must be applied to the documents in the review session. Reviewers have the ability to print the digital review documents to paper and mark them up, however, when done, all must be transferred from paper to the digital documents, see Section 10.7.3. If a unit cannot print their own paper copies they should contact MaryAnn Cass by email Jackie.Rivera@ct.gov. In the email include the project number and list documents that need to be printed, and include the address of where they are to be mailed. In the case of preliminary contract plan reviews, the original digital documents, with comments, will become the final record.

All comments associated with a design submission should be applied to the digital documents. Telephone of email comments must be applied to the correct digital document by the staff member who received them. Be sure to use engineering judgment to determine the most appropriate location for the comments in the document. General project comments can be placed on the first sheet of the document using the note markup tool in Bluebeam. This process is detailed in Section 10.7.3. If any outside entities (railroads or utilities) will not participate in the digital review, their comments with your responses should be attached to the final record copy in accordance with Section 10.7.3. It is not necessary to transpose these comments individually as all comments can be attached at one time.

FOI Requests
Contract Document Digital Reviews - After a digital review session has been completed and all the comments have been resolved, a read-only copy of the review documents with the comments and resolutions will be stored in the 310_Milestone_Submissions folder under the project.
10.2 Prerequisites

1. CTDOT has standardized its digital review process using the document format PDF, and the software Bluebeam. This software was chosen for the following reasons:
   a. Includes a collaborative live review feature (STUDIO) with real time feedback, enabling all reviewers to comment on the same document at the same time out on the cloud.
   b. A license for Bluebeam is more cost effective than competitive software like Adobe Acrobat. Thus it is much less expensive to purchase and maintain.
   c. Only the Organizer of the review is required to have a licensed copy of Bluebeam. All other attendees can participate in the digital review using Bluebeam’s free version, Bluebeam VU.
   d. Bluebeam is integrated with ProjectWise. This simplifies the delivery of the original review documents as well as saves the final reviewed copies and their comments.

2. The following table lists the software required to organize and/or participate in a CTDOT digital review. Note: It is recommended that the latest version of the software be used.

<table>
<thead>
<tr>
<th>Role</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organizer – Manages review</td>
<td>Bluebeam Extreme or Revu Standard and Projectwise Explorer</td>
</tr>
<tr>
<td>Author – Produces documents</td>
<td>Projectwise Explorer</td>
</tr>
<tr>
<td>Reviewer – Reviews documents</td>
<td>Bluebeam Extreme or Revu Standard or Bluebeam VU*</td>
</tr>
</tbody>
</table>

*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT create/organize a review). When a staff or consultant is invited to a digital review and they do not have Bluebeam VU or a licensed copy of Bluebeam Revu Standard installed on their computer, a link to download Bluebeam VU will be included with the invitation. Note: An IT administrator may have to install this software on the computer.

3. All CTDOT digital review participants are required to complete the steps provided in Appendix A prior to organizing or joining a review session. Completing these steps will standardize the Bluebeam format across all CTDOT digital reviews.
10.3 Digital Review Workflow

All CTDOT digital review participants are required to complete the steps provided in Appendix A prior to organizing or joining a review session. Completing these steps will standardize the Bluebeam format across all CTDOT digital reviews.

Roles
Organizer – The organizer sets up and coordinates the review session. For in-house projects this would be the project lead and for consultant jobs this will be the Consultant Liaison.
Author – Group that produces a document(s) for the review.
Reviewer – Group that participates in the review session to review documents.

<table>
<thead>
<tr>
<th>Step</th>
<th>Role</th>
<th>Task</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase 1 – Preparation and Delivery of the Digital Documents</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1</td>
<td>Organizer</td>
<td>Coordinate the organization and preparation of the review documents. Request all Authors to upload their review documents into Projectwise.</td>
<td>Section 10.4</td>
</tr>
<tr>
<td>1.2</td>
<td>Author</td>
<td>Prepare and upload review documents into Projectwise. Notify the Organizer that this step has been completed.</td>
<td>Section 10.4</td>
</tr>
<tr>
<td>1.3</td>
<td>Organizer</td>
<td>Check that all review documents have been prepared and uploaded correctly into Projectwise.</td>
<td>Section 10.4</td>
</tr>
<tr>
<td>Phase 2 – Set up Digital Review</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.1</td>
<td>Organizer</td>
<td>Start a Bluebeam review session and then change the state of the review documents in Projectwise to “Reviewing”.</td>
<td>Section 10.5</td>
</tr>
<tr>
<td>Phase 3 – Invitation to Review</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1</td>
<td>Organizer</td>
<td>Create a Digital Review memo, which includes a link to the digital review session, and send it to all Reviewers.</td>
<td>Section 10.6</td>
</tr>
<tr>
<td>Phase 4 – Digital Review</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.1</td>
<td>Reviewer</td>
<td>Join the review session by clicking on the link provided in the review memo. Become familiar with the review session layout.</td>
<td>Section 10.7.1  and Section 10.7.2</td>
</tr>
<tr>
<td>4.2</td>
<td>Reviewer</td>
<td>Set Status to “Reviewing”</td>
<td>Section 10.7.3</td>
</tr>
<tr>
<td>4.3</td>
<td>Reviewer</td>
<td>Review the documents in the Bluebeam review session and place comments on documents as necessary. Documents can be printed, marked up, and then comments transferred the PDFs. If the documents cannot be printed out, send a request to engineering records.</td>
<td>Section 10.7.3</td>
</tr>
<tr>
<td>4.4</td>
<td>Reviewer</td>
<td>When finished reviewing, in Bluebeam, Set Status to “Finished”</td>
<td>Section 10.7.3</td>
</tr>
<tr>
<td>4.5</td>
<td>Reviewer</td>
<td>Send a Review Comment Memo to the Review Organizer</td>
<td>Section 10.7.3</td>
</tr>
</tbody>
</table>
### Phase 5 – Closing the Digital Review

|   | Organizer   | Close the Bluebeam review session and check the documents back into Projectwise. | Section 10.8 |

### Phase 6 – Resolve Comments

|   | Organizer   | Notify the Authors that they can review the markups on their review documents in Projectwise. Provide them with a link to the folder in Projectwise. | Section 10.9.1 |
|   | Author      | Open the specific document(s) from Projectwise. | Section 10.9.2 |
|   | Author      | For each comment on your document, type a final resolution. | Section 10.9.2 |
|   | Author      | After all resolutions are applied to comments, Notify the Organizer that you applied your resolutions. |  |
|   | Organizer   | Change the state of the review documents to “Review Complete” to make all review documents read only after the resolutions have been applied. | Section 10.10 |
|   | Organizer   | Send out a Completion of Review Session Memo to all the personnel associated with the review session that the all comments have been resolved on the documents located in Projectwise. | Section 10.10 |

### 10.4 Phase 1 – Digital Document Preparation

#### 10.4.1 Organization

Below are the guidelines by which the review documents should be organized:

**Preliminary Contract Document Reviews – PD, SF, FPFR, etc.**

1. **Plans** - Must be in discipline subsets. The review Organizer is responsible for assigning each Author a subset number in accordance with Section 4.1. Note: CTDOT Standard Subsets cannot be added to a review session because they are combined in a PDF Package (Portfolio).
2. **Special provisions** – Each discipline shall combine all of their special provisions into one (1) PDF document. Each discipline’s special provisions will remain separate throughout the review session; they will not be combined with the other discipline’s special provisions.
3. **Other Documents** – Shall be individual PDF documents.
4. All Authors must upload their documents into the 310_Documents_Submission folder under the project in Projectwise.

**Other Reviews**

1. The only requirement for the organization of other types of reviews is that the documents must be in PDF format.

#### 10.4.2 Preparation and Format

Authors shall prepare their digital documents in accordance with the following guidelines:

**Preliminary Contract Document Reviews – PD, SF, FPFR, etc.**

1. Plans:
   a. Must be in PDF format
   b. Plans must be in discipline subsets
   c. Plans must be sized 34” x 22”
   d. Do not need watermarks, sheet numbers or to be digitally signed.
2. Special provisions:
a. Each discipline shall combine all of their special provisions for review into one (1) PDF document.
b. Sized 8.5” x 11”

3. Other Documents:
   a. Must be in PDF Format

Other Reviews

1. Documents:
   a. Must be in PDF Format

10.4.3 Uploading Digital Documents

Authors shall upload their digital documents into Projectwise in accordance with the following:

For Preliminary Contract Document Reviews – PD, SF, FPFR, etc.

1. Launch Projectwise and log in.
2. Browse out to the project this review is for and open up the 310_Milestone_Submissions folder and the specific review folder: If the three subfolders are not in the project contact Mathew.Calkins@ct.gov

Figure 149 - Projectwise Project
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then you will be able to select the correct Interface.

4. Select Advanced Wizard

![Figure 150 - Uploading Documents into Projectwise](image1)

![Figure 151 - Advanced Wizard](image2)
5. Click next until the attributes screen appears as shown below. Enter the correct attributes and then click next until the document uploads.

Figure 152 - Attributing a Document
For Other Reviews

1. Launch Projectwise and log in.
2. Browse to the folder where the digital documents are to be stored.
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a time into Projectwise as shown below:

   Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then you will be able to select the correct Interface.

   ![Figure 153 - Uploading Documents into Projectwise](image)

4. Select Advanced Wizard

   ![Figure 154 - Advanced Wizard](image)
5. Click Next until the attribute screen appears shown below. Enter the correct attributes for the review documents and then click next until the document uploads. Make sure a good label and description are entered.

6. Notify the Organizer that the documents have been uploaded into Projectwise.
10.5 Phase 2 – Set Up Digital Review

The Organizer shall set up the review session in accordance with the following: Note: The example below is for initiating a Semi-Final review but can be followed for other types of reviews.

1. Launch Projectwise Explorer from the shortcut on your desktop or the start menu.
2. Browse out to the project’s 310_Milestone Submissions folder. (For other reviews browse out to the folder in Projectwise where the documents are located. Note: The document does not need to be in Projectwise to use Bluebeam’s Studio feature.)

![Figure 156 - Preliminary Design Documents Folder](image-url)
3. Next select all the documents that are to be included in the studio session, right click, and select Start Studio Session:

Right Click on the documents and select "Start Studio Session"

Figure 157 - Start Studio Session
4. Using the naming guidelines from the table below, type in the applicable review session name in the box entitled “Session Name”.

<table>
<thead>
<tr>
<th>Review</th>
<th>Review Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preliminary Design (30%)</td>
<td>Project #XXXX-XXXX PD Review</td>
</tr>
<tr>
<td>Structure Type Study</td>
<td>Project #XXXX-XXXX Structure Type Study Review</td>
</tr>
<tr>
<td>Semi-Final (60%)</td>
<td>Project #XXXX-XXXX SF Review</td>
</tr>
<tr>
<td>Final Plans for Review (90%)</td>
<td>Project #XXXX-XXXX FPFR Review</td>
</tr>
<tr>
<td>Other</td>
<td>Include Project number if necessary and give a good description of the review</td>
</tr>
</tbody>
</table>

Also, as shown in the figure below, make sure that all the options are checked. Note: Setting the Session Expires date is optional. If set, this date can always be changed after the session is created.

Figure 158 – Initiating a Review Session
5. In the next dialog box click copy invitation as shown below. The invitation will be copied to the clipboard of the computer and then can be pasted into an email or memo.

![Image of Session Invitation dialog box]

**Figure 159 - Adding Email Address to Studio Session**

Next paste the invitation into a blank Word Document or email. The following is an invitation that has been pasted into an email. Note how the session URL appears in blue. Then you can copy the URL from the blank document or email into a formal memo.

![Image of email with session URL]

**Figure 160 - Session URL**
6. After the session has been created go back to Projectwise, Select all the documents that are included in the session.

Figure 161 - Select Documents to be Included in Bluebeam Review Session

7. Then change the state of the documents to “REVIEWING” as shown below:

Figure 162 - Changing the State to Reviewing

Then click OK next on the box that pops up. The documents will now be in the **Reviewing** state.

Figure 163 - State of Documents
10.6 Phase 3 – Invitation to Review Session

The Organizer shall invite Reviewers to the review session in accordance with the following:

For Preliminary Contract Document Reviews – PD, SF, FPFR, etc.

The invitation to the digital review will be a PDF version of a review memorandum that includes the following:

1. A table of all documents that are in the review session.
2. Links to relevant documents that are not included in the review session but still need to be referenced. These documents shall be located in Projectwise and Projectwise links shall be included. (Not shown in the example below)
3. A link to this manual (Digital Project Development Manual)
4. A link to the Review session. To do this, paste the invitation that was copied when you created the review session.

The PDF of the review memorandum shall be emailed to all Reviewers; this should include the Principal, Supervisor and TE3 level of the reviewing unit where applicable. It is the Organizer’s responsibility to compile a complete distribution list so the review invitation gets sent to the applicable personnel. Below is an example of a memorandum for a preliminary design review:

Figure 164 - Sample Review Memo

The Organizer shall also send out a reminder notification to all the reviewers two weeks prior to the end of the review session.

For Other Reviews

Invitations for less formal reviews may not require a memo. It is recommended that an email be sent which includes the links to this manual and the review session.
10.7 Phase 4 – Digital Review

10.7.1 Joining a Review Session

To join a review session, either click on the link provided in the review memorandum for a preliminary design review, or for less formal reviews, click on the link in the email. Below is an example of an email for a preliminary design review (semi-final). Remember the link to the review session is included in the memo that was emailed to all the reviewers.

1. Open the email from the Organizer and open the review memorandum.

![Email Example for Review Session](image)

Figure 165 - Review Memorandum
2. Click on the link to the Review Session.

**Figure 166 - Link to the Review Session**
3. Click Allow on the box that pops up in Internet Explorer. Ignore the text written in the webpage as shown below:

![Image of Internet Explorer window asking to allow a website]

To join a session click Allow

Ignore this text

Figure 167 - Accessing the Review Session

4. Bluebeam will now launch. If this is the first time in a review session, a Studio Account must be created. To do so click on Create Account and then enter in a State email address and a password. In the Name box type in the First Initial then Last name and unit. See below for an example.

![Image of Studio Account creation screen]

If you do not have an account click create account

Figure 168 - Creating a Studio Account

![Image of Studio Account login screen]

Type in email address

Type in Password

Type in User Name

Select Remember password

Click OK

Figure 169 - Studio Session Account
If this is not the first time in a review session, enter the studio login information as shown below: If you forgot your password click lost password and an email will be sent to you.

Enter your studio session email and password and click OK

Figure 170 - Review Session

5. If this is your first time into a review session you must import the CTDOT Bluebeam Profile, See Appendix A
10.7.2 Review Session Layout

Below is the typical layout in the review session. On the right tab, there are the tool chest for commenting, the attendees of the session, and the documents in the session. On the bottom, there are the list of comments.

![Review Session Layout](image)

**Figure 171 - Review Session Layout**

All comments that are made get saved instantly to the Bluebeam review session; these do not need to be manually saved. Each user can only delete their own comments and can leave and rejoin as many times as they want as long as the review session has not been closed. The review session will be closed by the Organizer in accordance with the date on the review memo.
10.7.3 Reviewing

This section shows the procedures for reviewing and commenting on documents in a digital review. Reviewers may print digital review documents to paper by going to File>Print and mark them up; however, they must transfer these comments onto the digital review documents in accordance with this section. If a unit cannot print their own paper copies they should contact MaryAnn Cass by email Jackie.Rivera@ct.gov. In the email include the project number and list documents that need to be printed, and included the address of where they are to be mailed.

In the case of preliminary contract plan reviews, the original digital documents, with comments, will become the final record.

All comments associated with a design submission should be applied to the digital documents, including any email or phone call comments. These types of comments must be applied, by the staff member who received the email or phone call, to the correct digital document, use engineering judgment to determine the most appropriate location.

General Project wide comments can be placed on the first sheet of the document using the note markup tool in Bluebeam as shown below: Using the note tool you can copy and paste text from any source such as an email or a Word document. This allows larger project wide comments to be applied to the plans.

Figure 172 - Note Markup Tool
**Note about Commenting in a Review Session and Supervisor Approvals**

In most cases, the unit that reviews a document has an internal approval process whereby the supervisor finalizes the comments from staff members. The workflow described in this Chapter does not specify or dictate an approval process within each unit; rather, it outlines the review procedures once the review comments have been compiled from each unit. Therefore, it is important that only the reviewing unit’s final comments be added to the review session. Once the session ends, the comments made in a review session will be considered final.

The following shows a few options for a supervisor approval procedure, but the digital review process is flexible for any procedure a reviewing unit develops. The only restriction is the final comments must be placed on the digital documents located in the review session before the reviews session ends:

1. A lower level employee can join the session and comment on the documents in the review session. Then the supervisor can join the session and filter out their subordinates comments for their review. If there is an issue with a comment the supervisor will have to direct the lower level employee to fix that comment. If there are not any issues with the lower level employee’s comments then nothing has to be fixed. After this supervisor review, a lower level employee will join the session and fix the applicable comments. In section 10.1 of this manual there is a list of advantages to using this digital review process. With this option, all of these advantages are realized.

2. A lower level employee can join the review session and save a copy of the review documents to their computer. Then they can markup the documents offline and have their supervisor approve those comments. After the supervisor approves the comments, those comments can then be imported into the documents in the review session. In section 10.1 of this manual there are a number of advantages to this digital review process. With this option, advantages 3 and 4 are eliminated due to the comments made offline.

3. A lower level employee can join the session and print the documents in that review session. Then they can markup the prints and have their supervisor approve the comments. After the approval, a lower level employee can transfer the comments to the digital documents in the review session. In section 10.1 of this manual there is a list of advantages to this digital review process. With this option, advantages 3 and 4 are eliminated due to the comments made offline.

**Notes about Outside Entities that will not Participate in a Digital Review**

If an outside entity such as a railroad or utility company will not participate in a digital review it is still important to add their comments to the final record document in Projectwise. It is encouraged to have these entities participate in the digital review and AEC Applications is available to provide support and technical assistance in these efforts.

The following details how the comments from a non-participating entity and your responses to those comments shall be attached to the final record document in Projectwise:

1. Create a PDF document that includes the non-participating outside entity’s comments and your responses to those comments.
2. Then add the pages from that document to the end of the final record document in Projectwise in accordance with section 10.9.1.
Reviewer

1. First set your review status to *Reviewing* by clicking on the drop down shown below:
   Note: If you leave the session and return your status will stay as Reviewing.

   ![Figure 173 - Set Status to Reviewing](image)

2. Next select a document to review from the studio session tab. The document will open up and can be reviewed.

   ![Figure 174 - Selecting a Document to Comment On](image)
3. Select a commenting tool from the tool chest and mark up the plans. If you do not have the CTDOT Review Tools show below, follow Appendix A to have them imported in the Bluebeam Profile. Below are the commenting tools a CTDOT user will have available to them in Bluebeam.

![Bluebeam Commenting Tools](Figure 175 - Bluebeam Commenting Tools)

Custom tools can also be created. Contact DOT.AECApplications@ct.gov for custom tool development.
MUST READ BEFORE PLACING COMMENTS
The following shows best practice for applying text notes in a review session.

There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow, cloud, rectangle, etc.). Each type can have a note attached to them. The text tools already have a note when you type text, but the non-text tools can also have a note attached to them. To attach a text note to a non-text tool place the comment and then double click on that markup. Then you can type in your note. The text note box must be closed after the comment is made by clicking on the X in the top right corner of the note. The example below shows a note being attached to the cloud tool the correct way:

```
1. Place Cloud  2. Left click on the cloud so the yellow circles show  3. Double click on the cloud and type text
```

![Diagram showing the correct way to add text to a non-text commenting tool](Image)

**Figure 176 – Correct Way to Add Text to a Non Text Commenting Tool**

General Project wide comments can be placed on the first sheet of the document using the note markup tool located in the tool chest. Text can be copied and pasted into the note tool as necessary.
4. After you have completed your set your status to *Finished*.

Note: You can still enter the session if your status is set to Finished. You can also change your status back to *Reviewing* if necessary. This status is for the Organizer so they know which Reviewers have completed their reviews.

5. Create a review comment report of your comments. First filter out the comments so only your comments are displayed as shown below:

![Figure 177 - Set Review Status](image)

**Figure 177 - Set Review Status**

(1) Click Filter

(2) Then click this icon

(3) Then select your name

![Figure 178 - Filtering Comments](image)

**Figure 178 - Filtering Comments**
6. Now that the comments are filtered by your name create a comment report as shown below:

![Figure 179 - Creating a Comment Report](image)

Next type in a title for the comment report that includes Project No, What review it is plus the word “Comments”, and what document this comment report is for. See below for an example:

**Project ####-#### Semi Final Review Comments 03-Highways**

Make sure all the settings are set as shown below and click OK:

![Figure 180 - Comment Report](image)
7. The comment report will now be created and opened in Bluebeam, leave the comment report open in Bluebeam. We will be copying this report into the comment report memo.

8. Next save the following review comment memo to your computer: Review Comment Memo.

9. Open the memo and fill in the correct information.

10. Then copy all the pages from the comment report as shown below:

![Figure 181 - Copying the Comment Report Memo](image)
11. Then paste the pages into the memo as shown below:

12. Save the memo and process this memo as your unit requires.
10.8 Phase 5 – Closing the Digital Review

The Organizer will be responsible for closing the review. The review session will be closed per the date on the review memorandum.

1. Log into Projectwise and browse out to the review documents folder.
2. Then select the documents that are in the session that is to be closed, right click on the documents, select Change State>Next: **If this step is not performed the session cannot be closed. This will place the documents in the CLOSE REVIEW state.**

3. Then open up Bluebeam and join your session.
4. Then Click Finish to close a Bluebeam Review Session as shown below:

![Figure 183 - CLOSE Review State](image1)

![Figure 184 - Terminating a Session](image2)
5. Make sure all the reviewers in the list below are selected (they will be by default) and the Save (Overwrite Existing) button is checked and click OK.

**Figure 185 - Terminating a Session**

6. Click OK in the figure below.

**Figure 186 - Overwriting Existing Documents**

7. Close Bluebeam Revu and check in each document to Projectwise. Note: A check in box will pop up for each document in the review session.

**Figure 187 - Checking a Document Into Projectwise**

8. Notify the Document Authors that the session has been closed so they can resolve the comments on their documents.
10.9 Phase 6 – Resolve Comments

This section shows how the comments from the review session will be resolved by the Document Authors. After the comments have been resolved in the PDF documents located in Projectwise the Document Author shall notify the Organizer that they have finished applying their resolutions to the documents.

Note: Comments cannot be resolved until the review session has been finished. The Review Organizer will notify the Document Authors when the session has been finished. If the document authors go into the documents located in Projectwise before the session is finished there will be no comments on the documents.

10.9.1 Resolving Comments

All comments on the review documents shall be resolved by the Document Author directly on the digital PDF review documents using Bluebeam. The following shows the steps for resolving comments.

1. Open your document(s) from Projectwise.
2. Next select a comment in the comment list and right click. The select Reply.

Figure 188 - Comment Resolutions
3. In the box that pops up, type in a final resolution in the following format:

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.

Resolution – Type in resolution...No Change to Plans

The resolutions applied to the plans shall be the final resolution decided by the Document Author’s unit. There shall only be one resolution for each comment.

Below is an example of a resolution:

![Figure 189 - Typing in a Resolution](image)
Below is an example of how the resolutions will look in the comment list.

![Figure 190 – Resolutions](image)

4. Next attach a PDF document that includes any non-participating entities comments with your responses to the review document. This should be done by adding that PDF document to the end of the review document as shown below:

![Figure 191 - Attaching Comments](image)
5. Browse out to the PDF document you want to add and then select to insert after the last page:

![Insert Pages dialog box with options to select after or last page and click OK]

Select After and Last Page and then click OK

Figure 192 - Adding Comments

6. When all the resolutions have been applied, make sure to save the documents and check them back into Projectwise.

7. Notify the Review Organizer that you have completed your resolutions.

8. Send out Completion of Review Memo to all the personnel associated with the review session indicating that the review session is over and all comments have been resolved on the documents in Projectwise. Link to: [Completion of Design Review Memo](#)
10.10 Locking the Review Documents after the Review

The Organizer shall change the state of the documents to make them document read-only after the resolutions have been applied to the review documents.

To make the documents read-only, change the state of the documents in Projectwise to “Review Completed” as shown below:

1. Select the document(s) and change the state of the documents to “Review Completed” as shown below:

![Figure 193 - Changing the State to Review](image)

(1) Right click on the documents and select “Change State>Next”

![Figure 194 - Review Complete State](image)

Notice State column, the documents are now in the Review Complete state.
2. Then right click on all the documents again and select Change State > Set Final Status. This will lock the documents.

Figure 195 - Setting Final Status
Section 11 Design Phase Project Scheduling

An Engineering working group evaluated several scheduling software options to support the mission statement. Microsoft Project 2010 was selected because it offers the following features and advantages:

- Accommodates any number of milestones and tasks (i.e., easily scalable),
- Graphically displays series and parallel tasks,
- Provides baseline and tracking Gantt charts,
- Displays the critical path,
- Ability to link notes and documents, and
- Interfaces with Outlook, Excel, SharePoint and other Microsoft products.

Microsoft Project 2010 shall be used to develop design phase schedules meeting the following minimum requirements:

1. Includes all the activities identified by the Minimum Requirement Schedule Template; more detailed templates and project-specific schedules are encouraged,
2. Baseline schedule,
3. Task Indicator columns are used to link applicable instructional and reference documents,
4. Explanations for changes in task durations are added as task notes,
5. Tracking View/Gantt chart functions are used,
6. Task-level progress is tracked regularly,
7. Files are stored in the ProjectWise project container as indicated by the Digital Project Development Manual, and
8. Microsoft Project files are maintained and current, with projected schedules in accord with the obligation plan.

Base templates were developed by a committee that included Engineering Management and Subject Matter Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs are as follows:

- **Bridge Design** – Kevin Blasi and David Gruttadauria
- **Consultant Bridge Design** – Derick Lessard and Marc Byrnes
- **Highway Design** – Scott Bushee, Jordan Pike, and Vitalij Staroverov
- **Consultant Design State Roads** – Nilesh Patel and Meredith Andrews
- **Traffic Projects Design** – Barry Schilling and Michael Chachakis
- **Traffic Studies & Safety** – Erika Lindeberg, Daniel Veronesi and Colin Baummer
- **Facilities Design** – Eric Feldblum and Jesse Benson

The SMEs are responsible for developing and maintaining division specific project templates and corresponding task libraries in ProjectWise. They shall be the first point of contact regarding discipline specific template and guidance document inquiries and maintenance.

For questions, suggestions and issues pertaining to Microsoft Project and the Scheduling Directive, please contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov) or John Dudzinski (john.dudzinski@ct.gov)
The table below details the minimum tasks included in the template:

### Table 2 - List of Minimum Tasks

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Project XXXX-XXXX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Initiation</td>
<td></td>
</tr>
<tr>
<td>• Prepare and Submit PPI</td>
<td></td>
</tr>
<tr>
<td>• Prepare and Approve RPM</td>
<td></td>
</tr>
<tr>
<td>• Secure Funding/Authorization</td>
<td></td>
</tr>
<tr>
<td>Preliminary Design</td>
<td></td>
</tr>
<tr>
<td>• Survey</td>
<td></td>
</tr>
<tr>
<td>• NEPA/CEPA</td>
<td></td>
</tr>
<tr>
<td>• Develop PD through Design Approval</td>
<td></td>
</tr>
<tr>
<td>• Design Approval</td>
<td></td>
</tr>
<tr>
<td>Final Design</td>
<td></td>
</tr>
<tr>
<td>• Prepare Semi-Final Design Submission</td>
<td></td>
</tr>
<tr>
<td>• Prepare Final Design Submission</td>
<td></td>
</tr>
<tr>
<td>ROW Coordination</td>
<td></td>
</tr>
<tr>
<td>• Prepare and Submit Final Accepted Property Maps</td>
<td></td>
</tr>
<tr>
<td>• Acquire Properties</td>
<td></td>
</tr>
<tr>
<td>Permit Acquisition Process</td>
<td></td>
</tr>
<tr>
<td>• Permit A</td>
<td></td>
</tr>
<tr>
<td>o Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>o Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
<tr>
<td>• Permit B</td>
<td></td>
</tr>
<tr>
<td>o Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>o Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
<tr>
<td>• Permit C</td>
<td></td>
</tr>
<tr>
<td>o Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>o Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
</tbody>
</table>

FDP
DCD
ADV
11.1 Microsoft Project File Set Up

The following steps show how to set up a Microsoft Project file:

1. Open ProjectWise Explorer by going to Start> All Programs> Bentley> ProjectWise V8i (SELECT series 4), and click on ProjectWise Explorer as shown below:

![Figure 196 – Launching Projectwise](image)

2. Then double Click on CTDOT and then sign into ProjectWise with your username and password. If this is your first time logging into Projectwise, you will be asked to create a working directory, click Yes:

![Figure 197 – Logging Into Projectwise](image)
3. Browse to Documents>04.00 Engineering Libraries>Scheduling Directive. Select the applicable division’s Scheduling Documents folder. The below example presents where the Minimum Requirement Schedule Template is located:

![Schedule Templates](image1)

**Figure 198 - Schedule Templates**

4. Right click on the most applicable template and select Copy

![Copying a MS Project Schedule](image2)

**Figure 199 - Copying a MS Project Schedule**
5. The next step is dependent upon if a project is in the Project Initiation Phase or has progressed to Preliminary Design Phase. Project Initiation is typically complete when Funding and Authorization is received, and a ProjectWise project container is created. If a ProjectWise container has not been created, contact Julie Annino in AEC Applications.

**Projects in Project Initiation Phase**

a. If the project is in Project Initiation the MS Project schedule should be pasted to the respective discipline specific Initiation Phase Scheduling ProjectWise folder:

![Discipline Specific Initiation Phase Scheduling folders](image)

**Projects in Preliminary Phase**

b. If the project is in preliminary design phase the schedule should be saved to the ProjectWise 140_Project Administration folder under the project.

![Project 140_Project Administration Folder](image)
6. To paste the project file, right click on the folder and select Paste and then Yes.

7. Then click Advanced Wizard and click OK.
8. Then click next until you get to the attributes screen shown below, then assign the attributes as shown below:

   - Select these attributes.
   - Discipline = Your discipline

Figure 202 - Save schedules to the 140 Project Administration Folder

Figure 203 - ProjectWise Attributes
9. Then click next until the file uploads.
10. Next open the project file.
11. Then click on the File menu, select Info, select the Project Information dropdown and then Advanced Properties as shown below:

![Figure 204 - Setting Advanced Project Properties](image)

12. In the dialogue box that pops up, fill out the information as shown below:

![Figure 205 - Project Information](image)

1. Some information must be provided after Proj. Initiation, such as Proj. No. & PM Name
13. Next set the project start date by selecting the **File** menu > select **Info**, then select the date as shown below:

![Setting the Start Date](image)

**Figure 206 - Setting the Start Date**

11.2 Basic MS Project Function

This section presents the following schedule basic terminology and functions:

- Scheduling Terminology
- Task Relationships (Predecessors and Successors)
- Adding, Renaming, Indenting and Deleting a Task
- Adding/Adjusting Durations
- Lead and Lag Times
- Adding Hyperlinks
- Combining Multiple Projects

11.2.1 Scheduling Terminology

The most common scheduling view is the Gantt chart view, which illustrates a project schedule using task names, durations, start and finish dates on the left, and bar charts presenting these dates and durations to the right.

![Basic Terms](image)

**Figure 207 - Basic Terms**

**Task Indicator Column** - Present task Notes and Hyperlinks.

**Milestone** - A major schedule date, such as an FDP.
Parent Task - Shown as a Grey Bar, signifies it is a Parent Task. Its duration is populated by the Child Tasks.

Critical Path - Shown in Red, signifies the task relationships that control major milestone dates.

Non-Critical Task - Shown in Blue, signifies sub-tasks that do not control major milestone dates.

11.2.2 Task Relationships (Predecessor and Successors)

Predecessor is a task which has a start or finish date that affects the start or finish of another task.

Successor is a task which has a start or finish date that is affected by another task.

There are different ways of defining task relationships, these are

- **Finish-to-Start**: This is the default dependency in Microsoft Project in which the successor cannot begin until the predecessor is complete. A Finish-to-Start task relation is denoted by FS, or simply, as the predecessor’s Task ID. A Task ID is found on the column to the far left.

  ![Figure 208 - Finish to Start relation](image)

- **Start-to-Start**: The successor cannot begin until the predecessor begins. The successor task can start at any time after predecessor begins. Start-to-Start relationship is designated by SS.

  ![Figure 209 - Finish to Finish relation](image)

- **Finish-to-Finish**: the successor cannot be completed until the predecessor is completed. The successor can be completed at any time after the predecessor is completed. Finish-to-Finish task relation is denoted by FF.

  ![Figure 210 - Start to Finish relation](image)
• **Start-to-Finish**: the successor cannot be completed until the predecessor begins. The successor can be completed at any time after the predecessor has started. The Start-to-Finish task relation is denoted by SF.

![Figure 211 - Start to Finish relation](image)

The schedule should have a Predecessors column where task relationships can be defined. To define a task relation, enter the Task ID and the Task Relationship in the associated task’s Predecessor Cell. For example, in the Figure below the PPI is a predecessor and the RPM is a successor task. The PPI must Finish before the RPM can Start. This relationship is denoted in the RPM Process row’s Predecessors cell, as the number 2. The number 2 represents the Predecessor’s Task ID. The absence of a task relationship abbreviation means that the relation is a Finish-to-Start or FS. A FS is the standard task relationship and therefore the abbreviation is not presented, unless it is accompanied by a Lead or Lag time, as discussed in a later section.

![Figure 212 - Linking tasks](image)
If the **Predecessors** column is not shown in the template, double click in the "Add New Column" cell and start typing “predecessor,” and from the short list click on **Predecessors** to add it to the current columns. If Add New Column is not shown right click on any column label and select **Insert Column** and then start typing in Predecessors, as presented below:

**Figure 213 - Add new column**

**Figure 214 - Adding predecessor column**
11.2.3 Adding, Renaming, Indenting and Deleting a Task

Adding a Task
To add a task, right click on the task which will follow the new task and select Insert Task. For example, to add a new task between NEPA/CEPA and Survey, right click NEPA/CEPA and select Insert Task, as shown below:

![Figure 215 - Adding a Task](image)

Renaming a Task
Tasks can be renamed by double clicking on the task to be edited. In the pop up window under General tab you can edit the task name. (Do Not Rename the Base Template Tasks in Bold)

![Figure 216 - Renaming a task](image)
Outdenting & Indenting

Outdenting and Indenting provides schedule customization. Outdenting moves a task to the left of the task column and indenting moves a task to the right. Indenting a task makes it a ‘child’ of the preceding, outdented ‘Parent’ task. Parent task durations are populated by their accumulative child task durations, therefore, parent task durations should not be manually entered. To set your task as a child or “sub-task”, select the row you would like to modify and click the Indent Button in the main toolbar area shown:

![Outdent and indent](image)

**Figure 217 - Outdent and indent**

Deleting a Task

A user may delete, enter zero, or enter any small duration for a task if it is irrelevant. By entering zero for the duration the MS Project will view the task as a milestone, if a report is generated the report will present all zero duration tasks as milestones. This may confuse report reviewers. A small duration may push back critical milestone dates. It is therefore recommended that project managers manually delete and revise predecessor and successor relations, as described below. To delete a task right click on it and select delete task. (Do Not Delete the Base Template Tasks in Bold)

![Deleting a task](image)

**Figure 218 - Deleting a task**
When a schedule is started the user should remove tasks that do not relate and estimate all other pertinent task durations. **It is critical to note if the task being deleted is a predecessor.** You can determine this by following the lines stemming from a task in the Gantt chart. If a task is erroneous and must be deleted, but is also a predecessor for other tasks that should not be deleted, the successor task must be corrected. Failing to update a new predecessor will likely disrupt task connectivity.

For example, if a project does not require a Preliminary Hydraulic Analysis, the step should be deleted. However, the Hydraulics Analysis is a predecessor for the ABC Analysis; therefore the ABC Analysis’ predecessor task should be updated. In this case the Utility Coordination will be the new predecessor. See the task relationship and Gantt chart prior to task deletion:

![Figure 219 – Before task deletion table](image)

![Figure 220 – Before task deletion Gantt chart](image)

See Task relationship and Gantt chart after task deletion:

![Figure 221 – Post task deletion and predecessor update table](image)
After the Hydraulic Analysis has been deleted and the new predecessor has been assigned, MS Project automatically reconfigures the schedule to show the new critical path. The critical path is shown in red and highlights the task relationships that determine a project's finish date.

11.2.4 Adding and Adjusting Durations

All tasks require duration estimates that may vary as projects progress. To set a duration click the Duration Cell to the right of the task and enter the task's estimated period and the applicable unit, as presented below:

- Mons: for months
- Wks: for weeks
- Days: for days
- Hrs: for hours
- Mins: for minutes

If the duration unit is already entered, then the duration value may directly entered, without including the unit. **Do not modify durations for parent tasks.** Parent tasks are signified by having a gray bar in the Gantt chart area and a maximize/minimize arrow. Parent task durations are automatically calculated by their subtask durations.
If a parent duration is manually entered, select the parent task and re-select Auto Schedule. This will recalculate the appropriate parent duration, based on its child tasks. See below:

![Image of Auto Schedule](image)

**Figure 224 - Auto Schedule**

### 11.2.5 Lead and Lag Times

In defining a task relation, a task may have to be delayed or started early.

- The **Lead** time will tend to push your duration and a **plus** sign is used.
- The **Lag** time will tend to shorten your duration and a **minus** sign is used.

To add a Lead or Lag time: type in the task relation type, then the predecessor task number, a plus or minus, and the amount of delay or early start.

For example, Task 18: DCD, is 6 weeks after task 17: FDP, this can be described as 17FS+6wks

![Image of Task relation](image)

**Figure 225 - Task relation**
This can also be set by right clicking on a task and selecting Information. Then go to the **Predecessors** tab as shown below, and enter the predecessor ID or Task Name, the relationship type and then a positive duration for a lead time or a negative duration for a lag time in the Lag column.

![Figure 226 - Task relation in Project Information](image)

### 11.2.6 Adding Notes and Hyperlinks to a Task

#### Adding Task Notes

As stated in the Directive: “Explanations for changes in task durations are added as task notes.” Notes are reserved to clearly indicate when a specific Project Task duration is adjusted from the baseline. The note should be placed in the respective task’s indicator column. The note should state:

- The date of the entry,
- The person writing the note,
- Justification for the task duration adjustment and
- **Recommended**: Recipient Notification.

The **Recipient Notification list is left up to the Project Managers discretion**. The purpose is to outline a step where project team members who may be interested or are directly impacted by a duration change, are notified. Once a note is drafted and the duration is adjusted, it is recommended that a notification email be sent to the relevant recipients and that the correspondence is saved to the subject project’s 140_Project Administration folder in ProjectWise. The recipients **may** typically include:

- AEC’s Project Management Unit – [Bruce.Bourgoin@ct.gov](mailto:Bruce.Bourgoin@ct.gov) or [John.Dudzinski@ct.gov](mailto:John.Dudzinski@ct.gov)
- Finance, such as the Office of Capitol Planning.
- Design Engineers within the Project Manager’s division.
- The group involved with the duration change or the group affected by the change, if applicable. For example, if the 6 month estimated duration for a project survey needs to be pushed back, the respective survey supervisor who is involved with the task should be included as a recipient in the notification email.
The purpose of the recipient list is to improve communication between units and to harvest project data. Meaning, AEC will collect a repository of duration change notes in order to continuously reevaluate and improve schedule templates.

To add a note right click on a task and select Notes... as shown below:

![Figure 227 - Adding Notes](image)

Then type/insert your notes in the popup window.

The other option to access the notes window is to double click on the task and in the Task Information window and click on the Notes tab.

**Adding Hyperlinks to a Task**

As stated in the Directive: “Task Indicator columns are used to link applicable instructional and reference documents.” For all templates, hyperlinks shall be used to link a task to a division specific Schedule Task Library folder located in the Scheduling Directive folder. Contact your SME or AEC Applications for ProjectWise folder and template document management.

For example, a Permit Task should provide a link to a corresponding ProjectWise folder that contains the permit’s regulatory document, suggested points of contact or experts, pre-written memorandums, etc... These documents must be added, actively maintained and updated. Division SME’s and AEC shall be the active maintainers of the division library modifications. When a document is incorrect or has been superseded it is critical that users report this to a unit’s SME or to AEC so documents can be updated and maintained. It is suggested that users go through their SMEs to hyperlink documents, but the procedure is explained below.
To add a Hyperlink, right click on the task that you want to add a link to and select **Hyperlink**

![Figure 228 - Adding Hyperlink](image)

Then in the following window, insert web address\navigate to a file.

![Figure 229 - Add link/browse to a file](image)

You may use this to point to a file

Web link

Then click OK

To remove a link right click on the link (Task)> Hyperlink> Edit hyperlink > Remove link

![Figure 230 - Removing a link](image)

Then click here

To access a hyperlink hold the ctrl key and left click the hyperlink icon located in the Indicator column.
11.2.7 Combining Multiple Projects

It is critical that project managers can combine project schedules to better manage several schedules from the same file. MS Project provides this ability through the Subproject combine function. As outlined in Section 8, schedules must be stored in the project container: 140_Project Administration folder. However, to use the combine function, MS Project schedules must be exported from the ProjectWise folder to a local server drive, such as the X-Drive. Schedules located in a local network can then be combined using the subproject tool. Exporting is only recommended when a user wants to use the combine tool.

The following steps show how to combine Microsoft Project files:

1. Browse to the ProjectWise Project container’s 140_Project Administration folder. Right click the Project Schedule and select Export, as shown below:

   ![Figure 231 - Schedule Export](image)

2. Highlight Export and Click Next as shown below:

   ![Figure 232 - Export Option](image)
3. Browse to the network folder where you will keep the schedule file image. This network file will likely be in the division specific X-Drive>all_data-folder.

**NOTE: DO NOT DELETE THE EXPORTED FILE**

The floppy disk means that the file has been exported so the schedule is now read only. A user can still access the Project file by **double clicking** it and opening the file as **Read Only**.

![Figure 233 - Exported File](image)

4. Create a new “Master” MS Project file that will be used as the container for the combined Subprojects. This Master Schedule file can be stored in the local network drive (such as the X-Drive) or on ProjectWise. Browse to the local network schedule (the one stored in the X-Drive) and click **Insert** as shown below:

![Figure 234 - Subproject](image)

The schedule has been inserted into the Master Schedule, where it can be actively updated and maintained. Initially, sub-tasks will be hidden, but they can be shown by clicking the project’s outline symbol.
A user can view the most updated schedule via the ProjectWise file by right clicking the schedule file and selecting **Update Server Copy** as shown below:

5. This step updates the ProjectWise schedule from the local network image file that is maintained by the user’s Master schedule. This allows any person to view the most-up-to-date project schedule directly from ProjectWise.

6. To **Import** a project schedule back into ProjectWise the user must right click on the ProjectWise schedule and click **Import**. As shown below:
7. If you look back to the local server where the project image file had been saved, you will notice that it is no longer there, this is because the file has been imported back into ProjectWise. Now the file can once again be managed directly from ProjectWise. If a user wishes to maintain their schedule continuously from their master schedule, they should avoid importing the schedule. Once a file is imported the user must re-export and re-add the schedule to their master schedule.

11.3 Tracking the Project

11.3.1 Baselining the Project

Each project file must have a baseline set at the start of Preliminary Design. The baseline is essentially a stamp of the schedule at the start of the Preliminary Design phase. The purpose of the baseline is to gage how much a schedule varies from the initial baseline. Projects shall not be re-baselined unless there is a major scope change. Re-baselining requires Engineering Administrator approval.

1. To set the baseline, under the Project tab select set baseline and select Set Baseline from the dropdown as shown below.

![Figure 238 - Set Baseline Dropdown](image)
2. In the dialog box that pops up, keep the default values and click OK.

![Image of setting baseline](image)

**Figure 239 - Setting a baseline**

### Re-Baselining

If **Re-baselining** is needed and is approved by the Engineering Administrator, the baseline will be set in accordance with the following:

1. Go to **Projects > Set Baseline > Set Baseline**.
2. Then select **Set Interim plan**, select **Baseline** from the copy drop down button, then select **Baseline 10** for the into dropdown list.

![Image of re-baselining steps](image)

**Figure 240 - Re-Baselining**

3. Next, go to **Project > Set Baseline> set Baseline**.
4. Then in the dialog box that pops up just click OK to save a new Baseline.

![Set Baseline dialog box](image)

**Figure 241 - Re-Baselining**

5. When a pop up window asks you if you want to overwrite click yes

![Microsoft Project dialog box](image)

**Figure 242 - Re-Baselining**

6. After the project has been re-baselined add a note to the top left Identifier cell located in the Project No. row. The note should include the details outlined in the Adding Notes and Hyperlinks to a Task section. The recipient list should include all parties affected by the base-line adjustment.

![Microsoft Project Gantt Chart](image)

**Figure 243 - Re-Baselining Note**

After the project has been re-baselined change the view to a Tracking Gantt view.
1. In the left dark grey bar shown below, right click and select Tracking Gantt.

Notice the Gantt shows two bars stacked over each other. The grey bar is the baseline and the one on top is the actual duration. If there is a slip in a task schedule it will be shown as an offset.

---

**Figure 244 - Changing to a Tracking Gantt**

---

**Figure 245 – Tracking Gantt view**
2. Next to change the table of tasks to the tracking mode, click on the left upper corner cell to select the entire schedule, then right click and select tracking.

The table of tasks will now be in the tracking mode,

3. Then click save.

11.3.2 Recording Task Progress

The project manager will be required to record the project progress by keeping an up to date record of the % complete for each task in the project. This shall be recorded in 25% increments.

The following shows how to record the progress of a task:

1. Click on a task.
2. Then in the task menu select the appropriate % complete as shown below:

   - Click on a task.
   - Then in the task menu select the appropriate % complete as shown below:

   ![Image of task update tools]

   **Figure 247 - task update tools**

   **Important Note:** When the task is completed, do not select 100% complete. You will need to type in the actual finish date for that task. If 100% complete is selected, Microsoft Project will calculate the actual finish date instead of recording the physical date the task was completed.
In the tracking Gantt, the task will show the percent complete of the task as shown below:

![Figure 248 - Updated task view](image)

Also when a task is not started and/or finished on time, it will show as a slipping bar as in the following figure.

![Figure 249 - Tracking View](image)
11.4 Generating Reports and Summaries

Microsoft Project provides different forms of reports and visual summaries. MS Project has three reporting options:

1. Standard Reports
2. Custom Reports
3. Visual Reports

**Standard Reports**

Standard Reports are reports predefined by Microsoft on; Overview, Current, Costs, assignments and workload.

Under *Overview* the following is reported:

- Project Summary
- Top-Level Tasks
- Critical Tasks
- Milestones
- Working days

Under *Current* the following is reported:

- Un started Tasks
- Tasks Starting Soon
- Tasks In-Progress
- Completed Tasks
- Should have Started Tasks
- Slipping Tasks

Under *Cost* the following is reported:

- Cash Flow
- Budget
- Overbudget Tasks
- Overbudget Resources
- Earned Value

Under *Assignments* the following is reported:

- Who does what
- Who does what when
- To-do List
- Overallocated Resources

Under *Workload* the following is reported:

- Task usage
- Resource Usage
To access these report options go to **Project > Reports**

![Figure 250 - Report options](image)

**Custom Reports**

A custom report has the ability to customize the report based on templates in the following categories:

- Task
- Resource
- Monthly Calendar
- Crosstab

To access custom report tool, go to **Project > Reports** > and double click on **Custom**

![Figure 251 - Custom Reports](image)
Then the report to be edited is first selected from the list of available custom report. Next, click the Edit button. The dialog will show the current report’s setting and all the available report settings.

![Customizing a report template](image)

Figure 252 - Customizing a report template

Other than the Definitions tab you may utilize details and sort tabs for further customization.

**Visual Reports**

Unlike the standard/customized reports which are text based, visual reports present the report graphically. Visual reports are pre-formatted excel pivot-tables and pivot-charts as well as Visio pivot-diagrams.

To access go to Projects tab > Visual Reports

![Visual Reports](image)

Figure 253 - Visual Reports
Section 12 Electronic Engineering Data (EED)

12.1 Introduction

12.1.1 Purpose
The intent of this section is to provide standards and guidelines to promote consistent, uniform, and useable deliverables for CTDOT construction projects. It is not the intent of this section to add unnecessary additional responsibilities to the designer, but rather to have the projects delivered in a consistent manner following best practices and industry standards used in the today's CAD environment.

12.1.2 Definition of EED
Electronic Engineering Data (EED) refers to the Computer Aided Design (CAD) files and the Digital Civil Engineering data files (from applications like OpenRoads and InRoads) that were used to create the pdf contact plans. These files include:

- Geospatially correct 2D project location polygon
- 2D and 3D geospatially located CAD files
  - MicroStation (DGN) Design Models
- InRoads Data
  - Coordinate geometry - Horizontal and Vertical alignments (ALG) files
  - Roadway Surfaces - InRoads digital terrain models (DTM) files
- OpenRoads Infrastructure Consensus Models (ICM) & i-Models
  - Coordinate geometry
  - Digital Terrain Models
  - Storm Drainage, Structure and Pipe Data – Subsurface Utility Engineering (SUE)

In the future, EED may contain additional information such as asset data (signs, signals, guiderail, etc.).

In conjunction with an emerging project delivery method or technology initiative, the Department may provide bidders and contractors with:

- CAD files of the Base Technical Concepts in conjunction with alternative contracting methods (e.g., Design-Build, Construction Manager/General Contractor and Construction Manager at Risk).

12.1.3 Implementation Phases
The requirements for EED will be implemented in three phases. A phased structure was developed to facilitate the transition of the Department into the 2D/3D modeling arena. This guide has been divided to detail the files submittal types for all phases. The following sections outline the data requirements based on the Project type for each phase of implementation.

12.1.3.1 Phase 1
Phase 1 will focus on the practice of submitting proposed MicroStation 2D CAD, InRoads geometry files and a 2D project location polygon. These files are to be free of any extraneous data and match the contract plans. All projects designed using InRoads SS2 will follow the data requirement in Section 12.4.
12.1.3.2 Phase 1A

- **Note:** The original Phase 2 requirements have been replaced by Phase 1A goals. Phase 1 requirements remain in place.

Phase 1A will add the goals of submitting curb to curb 3D roadway top surfaces using the Department’s current modeling software, InRoads SS2. These 3D surfaces will not be required submissions; the designers are encouraged to develop the models which can be utilized not only during the construction phase but the design phase as well. These projects are designed in-house on the internal network or by consultants on an external network. All projects designed using InRoads SS2 should follow the data requirements in Section 12.5. If there are design submissions in this phase they should have the 2D models to be complete from curb to curb for the entire project, along with the Phase 1 requirements.

12.1.3.3 Phase 3

Phase 3 will change the data delivery files type using OpenRoads technology (OpenRoads Designer and beyond). In the upcoming years all new roadway projects designed at CTDOT will require the use of OpenRoads Technology. All projects designed using this technology will follow the data requirement in Section 12.6. For these future projects 3D models will include finished (or “top”) design surface and any subgrade excavation surfaces within the grading limits for the entire project. Phase 3 will also include Phase 1 requirements.

12.1.4 Why and When Should a 2D/3D Model be Developed?

Nationally the civil industry is quickly recognizing business improvements and lower costs by changing field operations to incorporate the use of EED. One of these practices is the utilization of 2D/3D modeling for the development of model based digital design data. The concept of model centric design, and the generation of digital design data for use in construction, involves the following key steps:

1. Collection and development of geospatially located survey data for an accurate existing conditions model to be used for design, and also to be delivered for use in bidding on the project.
2. Utilization of the survey model in design, with design software capable of 3D model output.
3. Proposed output from design of critical digital deliverables for use in bidding, construction and inspection purposes on the project.
4. Utilization of digital deliverables in constructing the project in an automated fashion.
5. Field collection of as-constructed and inspection measurements and observations using modern positioning technology, relative to the engineered model data.
6. Archiving and preservation of digital model data for future use, including asset management.
FHWA has promoted the adoption of this technology through their Every Day Counts 2 and 3 initiatives. According to FHWA, “Three-dimensional (3D) modeling in transportation construction is a mature technology that serves as the building block for the modern-day digital jobsite. The technology allows for faster, more accurate and more efficient planning and construction.”

For more information on please visit the U.S. Department of Transportation, Federal Highway Administration, EDC2 Website titled 3D Engineered Models website at:

https://www.fhwa.dot.gov/construction/3d/about.cfm

Digital 3D models of a highway project can convey a greater level of design intent than a 2D model; therefore, design projects should be developed in 3D when it is practical to do so. Essentially, if the designer is using surfaces (existing and proposed) to develop contract plans, then a 3D model shall be delivered. The following are guidelines to help determine projects in which 3D models may be beneficial:

- Cross sections will be included in the final plan set.
- Reconstruction is proposed within the project limits. If the reconstruction is only a component of the overall project (e.g., mill and overlay scope of work with a section of reconstruction) only the reconstruction area should be designed in 3D unless an accurate surface was obtained of the entire project.
- Major roadway rehabilitation (structural enhancements that both extend the service life of an existing pavement and/or improve its load-carrying capability).
- Complex storm water and drainage in order to check for clearances under roadway subbase and clash detection (i.e. utility conflicts).
- Intersections
- Subsurface utility information that is field located.
12.2 Project Types and Phases

This section defines the types of projects that EED will be delivered, along with the contract plans, at FDP. To determine what requirements are to be delivered in each phase, classify the type of project from Table 3 – EED Project Types and then use Table 4 – Project Deliverables to identify the deliverables.

<table>
<thead>
<tr>
<th>Project Type 1 – No Earth Work 2D Projects</th>
<th>Project Type 2 – Site Earth Work 3D Site Projects</th>
<th>Project Type 3 – Roadway Earth Work 3D Roadway Projects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bridge Deck/Superstructure Replacement</td>
<td>Bicycle/Pedestrian Facility (Multiuse Trails)</td>
<td>Grade Crossing - Major Improvement</td>
</tr>
<tr>
<td>Bridge Restoration/Rehabilitation</td>
<td>Bridge Replacement W/Realignment Of Approaches</td>
<td>Intersection Improvement - Minor</td>
</tr>
<tr>
<td>Bridge Substructure/Superstructure Repairs</td>
<td>Drainage - Major</td>
<td>Intersection Realignment</td>
</tr>
<tr>
<td>Concrete Barrier Rail</td>
<td>Facility Construction (Site Work)</td>
<td>New Interchange</td>
</tr>
<tr>
<td>Drainage - Minor</td>
<td>Hazardous Waste Removal</td>
<td>Operational Lane</td>
</tr>
<tr>
<td>Facility Rehabilitation</td>
<td>Retaining Walls/Slope Stabilization</td>
<td>Realignment</td>
</tr>
<tr>
<td>Fixed Objects Modification</td>
<td>Wetland Replacement/Restoration</td>
<td>Widening - Major (4r Projects)</td>
</tr>
<tr>
<td>Grade Crossing - Minor Improvement</td>
<td></td>
<td>Widening (3r Projects) - Minor</td>
</tr>
<tr>
<td>Guiderail Improvements</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Illumination</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intelligent Trans Systems</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Landscaping</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maintenance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Noise Barriers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resurfacing By Contract</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roadside Safety Improvements</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Traffic - Paint &amp; Epoxy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pavement Markings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Traffic - Signal Installation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Traffic - Signal System Improvement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Traffic - Signing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Utility Projects</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 3 – EED Project Types
| Table 4 – EED Project Deliverables |

<table>
<thead>
<tr>
<th>CAD Files</th>
<th>Project Type 1 No Earth Work</th>
<th>Project Type 2 Site Earth Work</th>
<th>Project Type 3 Roadway Earth Work</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Phase 1</td>
<td>Phase 1A</td>
<td>Phase 3</td>
</tr>
<tr>
<td>Proposed MicroStation File</td>
<td>R</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>Existing Ground MicroStation File</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Project Polygon</td>
<td>R</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>Geometry ALG File</td>
<td>D</td>
<td>D</td>
<td>G</td>
</tr>
<tr>
<td>Top Surface Curb to Curb DTM File</td>
<td>G</td>
<td>G</td>
<td>G</td>
</tr>
<tr>
<td>Existing Surface DTM File</td>
<td>R</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>Geometry Data</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Top Surface Data Terrain</td>
<td>R</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>Subsurface Data Terrain</td>
<td>R</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>OpenRoads Terrain</td>
<td>R</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>Existing Surface Data Terrain</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Storm Drainage Data SUE</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
</tbody>
</table>

R = Required  
D = Discretionary (Required if used during design)  
G = Phase 1A Goals (Submission is at the discretion of the designer)
12.3 Contract Plans and EED Conflicts

In all cases the EED will be issued as “For Information Only” purposes and the contract plans shall govern. An EED Notice to Contractor will be issued with each contract informing the potential users of this information as such.

12.4 Phase 1 Requirements

Note: Also see Section 12.8 EED Phase 1 Quick Start

Phase 1 will require the delivery of MicroStation 2D CAD models, InRoads alignments and existing ground surfaces. CTDOT uses Bentley software products for all their computer aided design needs, with MicroStation (.dgn format) being the foundation to all computer modeling. Therefore it is critical that MicroStation EED files be submitted to the CTDOT and conforms to the criteria outlined in this section.

**Figure 254 - Phase 1 EED Deliverables**

**12.4.1 Existing Survey**

**12.4.1.1 3D Ground Model(s) (.dgn)**

- All elements shall be placed using CTDOT’s customized MicroStation Task Manager or be generated by InRoads Survey Tools. This will ensure that all CAD graphics have the correct attributes (color, weight, line style, level).
- Must be compatible with CTDOT’s current SELECTSeries DDE.
- Elements must be placed in real world modified state plane coordinates (see Section 3.0 of CTDOT’s Location Survey Manual, June 1997) and be geospatially correct
- Only one design model per dgn file; no drawing or sheet models are to be used

All elements representing existing topography features shall be drawn according to the current CTDOT Survey standards, CTDOT’s Location Survey Manual, June 1997. These MicroStation file(s) shall contain a single 3D design model including both 3D and 2D elements of the existing survey. 2D elements included but are not limited to ROW lines and control lines. 3D element includes tangible elements such as edges of pavement, shoulders, curbs, gutters, sidewalks and retaining walls.
12.4.1.2   Existing Survey Surface File (.dtm)
Existing Digital Terrain Models represent existing ground conditions at the time that surveying data was collected. This original ground DTM represents the undisturbed ground surface prior to construction. There may be several existing DTM’s depending on the length of the project and the number of project site locations. The existing surface dtm will adhere to the specifications outlined in CTDOT’s Location Survey Manual, June 1997.
See Section 12.5.4 for more information.

12.4.2   Proposed Master Design Models (.dgn)
CTDOT uses Bentley software products for all their computer aided design needs, with MicroStation (.dgn format) being the foundation to all computer modeling. Therefore it is critical that MicroStation EED files be submitted to the CTDOT and conforms to the following criteria:
- All elements shall be placed using CTDOT’s customized MicroStation Task Manager or be generated by InRoads using the CTDOT preference files (CT_civil.XIN). This will ensure that all CAD graphics have the correct attributes (color, weight, line style, level) and follow CTDOT’s CAD standards.
- Must be compatible with CTDOT’s current SELECTSeries DDE.
- Elements must be placed in real world modified state plane coordinates and be geospacially correct
- If a 3D model is developed during design, it should be exported to a 2D model. Any 2D files generated from a 3D file must be in direct correlation to the 3D parent file.
- Only one design model per dgn file; no drawing or sheet models are to be used

12.4.2.1   Proposed Master Highway Models
This 2D Design Model DGN will include geometric line work such as centerlines, and proposed right of way lines. This file will also include right of way dimensions, roadway dimensions and centerline annotation. All features that are to be quantified shall be included in this file (i.e. guide rail, fences, etc.).

<table>
<thead>
<tr>
<th>Level of Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patterned Riprap Channels</td>
</tr>
<tr>
<td>Patterned Riprap Slopes</td>
</tr>
<tr>
<td>Patterned Pavement Removal</td>
</tr>
<tr>
<td>Patterned Milling</td>
</tr>
<tr>
<td>Erosion control Matting for Channels</td>
</tr>
<tr>
<td>Erosion control Matting for Slopes</td>
</tr>
<tr>
<td>Processed Aggregate</td>
</tr>
<tr>
<td>Pavement for Railing</td>
</tr>
<tr>
<td>Sodding</td>
</tr>
<tr>
<td>Turf Establishment</td>
</tr>
<tr>
<td>Planting Details (may be in a separate model)</td>
</tr>
<tr>
<td>Project Polygon</td>
</tr>
</tbody>
</table>

Figure 255 LOD Prosed Master Highway Model for Areas
### Level of Detail

<table>
<thead>
<tr>
<th>Sedimentation Control Fences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut limit</td>
</tr>
<tr>
<td>Fill limit</td>
</tr>
<tr>
<td>Fence</td>
</tr>
<tr>
<td>Front face of landscape wall</td>
</tr>
<tr>
<td>Single PCBC</td>
</tr>
<tr>
<td>Double PCPC</td>
</tr>
<tr>
<td>Temporary PCBC</td>
</tr>
<tr>
<td>Cut Pavement</td>
</tr>
<tr>
<td>Parking lot</td>
</tr>
<tr>
<td>Driveway</td>
</tr>
<tr>
<td>ROW – graphical representation of an InRoads alignment.</td>
</tr>
<tr>
<td>Centerline and Baseline – graphical representation of an InRoads alignment.</td>
</tr>
<tr>
<td>Guide Rail – The end anchor should be placed in the correct location. The smart line is to be offset from EOR so it can be graphically seen (Connecticut Standard Details for placement will supersede plan placement).</td>
</tr>
</tbody>
</table>

Figure 256 - LOD Proposed Master Highway Model for 2D Smartlines

#### 12.4.2.2 Proposed Master Structure/Bridge Models

The lead structural designer shall submit to the CTDOT a single 2D design model, per site and project, in a single 2D DGN file for every project that contains a new footing (including new box culverts). Each 2D design model shall include all components associated to the particular site and project.

The single 2D DGN file and its corresponding model shall conform to the following formats and include the following components:

- All components must be referenced into a single model
- Elements shall be placed using CTDOT’s customized MicroStation Task Manager.
- Components modeled in MicroStation shall be Feature Model Elements.
- All elements shall be geospatially correct.
- All elements shall be placed at 1:1 scale.

The master structural model shall include but not be limited to the following components:

<table>
<thead>
<tr>
<th>Level of Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure excavation earth and rock</td>
</tr>
<tr>
<td>Pervious structure back fill</td>
</tr>
<tr>
<td>Granular fill</td>
</tr>
</tbody>
</table>

Figure 257 - LOD Structure Elements Earth

#### 12.4.2.3 Proposed Master Environmental Compliance Models

The master environmental compliance model shall include a single DGN file with one 2D design model per file, per location, per project. All features that are to be quantified shall be included in this model.
12.4.2.4 Proposed Master Traffic Models
The master traffic model shall include one 2D design model per site. This model shall include all items that are to be quantified.

12.4.2.5 Proposed Master Miscellaneous Models
These models could be (but not limited to staging plans and or other disciplines not listed above that have items to quantify.

12.4.3 Project Polygon (Geo-Spatial Boundary)

- Note: This is the only EED file that is required before FDP.

A Project Polygon (geo-spatial boundary) shall be submitted at the completion of Design Approval. This will replace a cursory project polygon created at design development by the project sponsor. Any changes to that boundary during final design or construction warrant a resubmission of the Project Polygon after Design Approval, at DCD or Construction Completion.

See section 13 for more information.

12.4.4 Coordinate Geometry Files (.ALG)
If used, an InRoads (.alg) file shall be submitted per discipline. Submit only final alignments. Do not include preliminary or alternates information. The .ALG files shall:

- All centerline and baseline horizontals with a maximum of one vertical geometry alignment per horizontal alignment (including structures).
- All geometry contained in these file shall have names representative of the designed alignments and features found in the plans (Centerline = Route_84_ Eastbound).
- All coordinate geometry information must be provided in the native InRoads (*.alg) format.
- Engineering discretion shall be used in determining which geometry elements shall be displayed in the master highway model.

<table>
<thead>
<tr>
<th>Level of Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal alignments for all roadway centerlines/baselines</td>
</tr>
<tr>
<td>Type 2 Projects only - Vertical alignments for all roadway centerlines/baselines</td>
</tr>
<tr>
<td>Horizontal alignments for all proposed ROW</td>
</tr>
<tr>
<td>Special alignments used for drainage purposes, skewed driveways or stage construction</td>
</tr>
<tr>
<td>Alignments used for design features such as edge of roads, sidewalks &amp; retaining walls</td>
</tr>
<tr>
<td>Structure centerlines of bearings</td>
</tr>
<tr>
<td>Structure centerlines of girders</td>
</tr>
</tbody>
</table>

Figure 258 - LOD ALG Files
12.5 Phase 1A Goals

12.5.1 Existing Survey Ground File(s) (.dgn)
See Section 12.4.1

12.5.2 Proposed Master Design Files (.dgn)
See Section 12.4.2

12.5.3 Coordinate Geometry Files (.ALG)
See Section 12.4.3

12.5.4 Digital Terrain Models (DTM)
A Digital Terrain Model (DTM) is a three-dimensional topographic model which mathematically and graphically represents the existing and proposed surfaces. It consists of a triangulated surface with features. A feature is a named set of points in a Digital Terrain Model (DTM). There are five feature types which define the structure of the feature and controls how it affects the triangulated model. Each of these feature types has a feature style or styles, which controls how they are displayed.

- Random - “spot” points which have no direct relationship with other points
- Breakline - groups of points with a direct linear relationship
- Exterior - Surface boundary extent; closed and only one per surface
- Interior - defines undefined areas; closed and no limit to number
- Contour - groups of points with a direct linear relationship and same elevation

Any DTM used to generate final contract plans must be submitted. For Phase 1 Type 2 projects this will include all surfaces curb to curb for the entire project. These projects would also be the type which in most situations will require the inclusion of Item 9.80 Construction Staking. Files must meet the following criteria to be submitted with the EDD for CTDOT projects:

- InRoads uses DTM data to produce contours, display the existing and proposed ground lines in profile and cross section grids, and in the calculation of cut and fill quantities. Supplied surface files must be in the native InRoads .dtm format.

- Project model deliverables shall include at a minimum, two proposed DTMs and an existing DTM. One proposed surface shall be a finished grade DTM, and the other shall
be a top of subgrade DTM. It is important to note that the subgrade data is available with the top surface DTM but when the top surface gets exported using LAND XML for use with AMG technology the subgrade data gets automatically dropped. For this reason a separate subgrade surface needs to be delivered.

<table>
<thead>
<tr>
<th>Level of Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D design has no overlaps of breaklines or visual inconsistencies of features.</td>
</tr>
<tr>
<td>Surface features are continuous over their entire length, not broken into multiple pieces.</td>
</tr>
<tr>
<td>2D contract plans match the surface models.</td>
</tr>
<tr>
<td>No vertical faces are present (all vertical surfaces are to be offset a minimum of 1/12 in – 1/8 in to be accepted into the AMG software).</td>
</tr>
<tr>
<td>Accuracy clash detection, spot check x, y and z coordinates.</td>
</tr>
<tr>
<td>In critical areas (i.e. intersections), contours should be displayed at construction equipment tolerance intervals (typically 1” or less) to insure smooth surfaces for automated machine control/guidance purposes.</td>
</tr>
</tbody>
</table>

**Figure 260 - LOD DTM Files**

### 12.5.4.1 Existing

Existing Digital Terrain Models represent existing ground conditions at the time that surveying data was collected. This original ground DTM represents the undisturbed ground surface prior to construction. There may be several existing DTM’s depending on the length of the project and the number of project site locations.

### 12.5.4.2 Design

Proposed Digital Terrain Models represent the project design as generated by InRoads using the horizontal alignments, vertical alignments, templates, roadway definitions and surfaced editing tools.

A top surface for each corridor will need to be created representing at minimum the proposed finished grade **curb to curb** as part of the design data deliverables. All proposed DTM surfaces shall be defined by a breakline density interval (frequency of cutting templates) of no more than five feet, and at every event location. In tightly constrained or critical drainage areas, or on the outside of sharp horizontal curves, the break line interval may need to be reduced to two feet or less.

### 12.5.4.3 Substratum

All files created to represent the approximate Substratum surfaces will also need to be supplied. Substratum surfaces are used to represent assumed existing subsurface layers, such as rock, sand, clay etc.

### 12.5.4.4 Subgrade (Structure)

If underground structures are involved multiple subgrade surfaces will need to be generated to include all bottoms of footings, granular fill, box culverts, piers, walls, abutments, sign supports and bottom of excavation.
12.5.4.5 Proposed Master Storm Drainage Models

The Storm Drainage Model DGN file will be either 3D using InRoads Storm and Sanitary or 2D using StormCAD. The master Storm Drainage Models shall include but not be limited to the following:

<table>
<thead>
<tr>
<th>Level of Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pipes</td>
<td>Double line representing the inside Diameter at invert elevations</td>
</tr>
<tr>
<td>Culvert ends</td>
<td>2D cell placed at invert elevations</td>
</tr>
<tr>
<td>Endwalls, Riprap Splash Pads and Scour Holes</td>
<td>2D shape at invert elevation</td>
</tr>
<tr>
<td>Catch Basins</td>
<td>2D cell placed at top of grate elevation</td>
</tr>
<tr>
<td>Paved Apron</td>
<td>2D shape at grate elevation</td>
</tr>
<tr>
<td>Manhole</td>
<td>2D cell placed at top of frame elevation</td>
</tr>
</tbody>
</table>

Figure 261 - LOD Storm Drainage Using Storm and Sanitary

<table>
<thead>
<tr>
<th>Level of Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pipes</td>
<td>Double line representing the inside Diameter at elevation 0</td>
</tr>
<tr>
<td>Culvert ends</td>
<td>2D cell placed at elevation 0</td>
</tr>
<tr>
<td>Endwalls, Riprap Splash Pads and Scour Holes</td>
<td>2D shape at elevation 0</td>
</tr>
<tr>
<td>Catch Basins &amp; Structures</td>
<td>2D cell placed at elevation 0</td>
</tr>
<tr>
<td>Paved Apron</td>
<td>2D shape at elevation 0</td>
</tr>
<tr>
<td>Manhole</td>
<td>2D cell placed at top of elevation 0</td>
</tr>
</tbody>
</table>

Figure 262 - LOD Storm Drainage Using StormCAD

12.6 Phase 3 Requirements

12.6.1 Overview of Phase 3

Phase 3 will consist of delivering a full 3D model of the entire project, slope limit to slope limit. This will be accomplished using Bentley’s OpenRoads Designer (ORD). This software allows the designer to create a 3D model much more easily than the current production software, InRoads Select Series 2.

The deliverables for Phase 3 will just be the MicroStation dgn file itself. All of the engineering data is written to the dgn including the coordinate geometry, surfaces, and CAD line work. The dgn is simply saved as an i-Model which can be consumed by the GPS field equipment directly with no conversions necessary.

Bentley is currently developing the production version. After the release of ORD and testing, CTDOT will be adopting ORD as the production software sometime later this year.

12.6.1.1 Existing Survey Ground File
Details coming soon

12.6.1.2 Proposed Master Design Files
Details coming soon

12.6.1.3 Coordinate Geometry Files
Details coming soon
12.6.1.4 Integrated Civil Models
Details coming soon

12.7 Submission Procedures

12.7.1 Submission Dates
All required EED documents shall be delivered:
- At FDP
- At award of Contract (includes all addenda)
- After design initiated change orders, that the lead design deems necessary to supply to the contractor.

12.7.2 EED Delivery Manifest
The EED delivery manifest must be delivered to the CTDOT with every EED submittal. A blank copy can be found by clicking on the following link: EED File Manifest. This form will include general project information; the datum used for the ground survey; file names and specific information about each EED file being submitted. The contact information for the lead designer and lead surveyor must also be provided.

12.7.3 Projectwise File Location
Each discipline will upload their EED files in a zip folder into the 01.0 - Projects - Active\XXXX-XXXX\240_Contract_Development\ folder where XXXX-XXXX is the project number. For uploading documents to ProjectWise see Section 6.

12.7.4 EED Notice to Contractor (NTC)
The Notice to Contractor (EED Notice to Contractor) must be filled out by the lead designer with the correct project number in the last line of the notice. This NTC informs the Office of Construction and the contractors that the EED will be available, along with the contract plans, at advertisement. The NTC also states that all EED files are for information only. This will be submitted along with the specifications at FDP.

For uploading documents to ProjectWise see Section 6.

12.7.5 Converted Data
AEC will convert MicroStation CAD files (dgn) into a dxf format, InRoads alignment files (alg) into xml, and InRoads surface files (dtm) into xml. These conversions are necessary to be utilized in the GPS field equipment and automated machine guidance/control equipment. It will be AECs responsibility to zip all files, both native and converted, and upload to the 100_Contract_Plans (PDF) folder in ProjectWise. Contracts will be notified so that the EED zip file can be posted along with the contract plans, specifications, and estimates on the State’s contracting portal at advertisement.

The converted data is being provided by CTDOT to insure that inspectors and contractors are utilizing the same set of data.
12.7.1 Addendum and Design Initiated Change Orders

Changes to the EED that require edits to the CAD models, surfaces or alignments shall be submitted along with submission of the revised contract plans.

For uploading documents to ProjectWise see Section 6.

A new zip file will be created containing the renamed updated files and uploaded to ProjectWise. AEC will then be notified that the amended files are complete.

12.8 EED Phase 1 Quick Start

Note: EED is due with the FDP plans at FDP. The only exception is the project polygon. This is required to be submitted at Design Approval, DCD, and when any Change Order that affects project polygon. See section 13 for more information on project polygon locations.

1. Ensure that the MicroStation Design Models meet the requirements of Section 12.4.2 for your discipline. 3D CAD models will be exported to 2D CAD models.
   a. All graphical elements are at the correct geospatial location and are on the correct level.
   b. Models are free of all cross sections, profiles, construction lines for design purposes.
   c. Models are free of annotation that should reside in the cut sheets.
   d. Models have clean reference attachments, only needed reference files & no redundant references.
   e. Models are a 2D design model, not a sheet or drawing model
   f. Files contain only one model

2. Ensure that the InRoads Coordinate Geometry file(s) meets the requirements of Section 12.4.3.
   a. Only final alignments included (do not include preliminary or alternates information).
   b. Alignments names and descriptions are intuitive.
   c. Each horizontal alignment has only one child vertical alignment.

3. At FDP:
   a. Check that the EED Checklist criteria is met.
   b. Fill out EED File Manifest for all files (native data only).
   c. Upload the MicroStation dgn and InRoads alg (if applicable) in a zip folder into the ProjectWise folder 01.0\Projects - Active\XXXX-XXXX\240_Contract_Development\ where XXXX-XXXX is the project number. For uploading documents to ProjectWise see Section 6.

4. Send a link to AEC Applications at ronald.tellier@ct.gov that the files are ready.
## 12.9 EED Checklist

<table>
<thead>
<tr>
<th>Check List</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MicroStation Design Models</strong></td>
<td></td>
</tr>
<tr>
<td>☐ All graphical elements are at the correct geospatial location.</td>
<td></td>
</tr>
<tr>
<td>☐ All graphical elements are placed on the correct CT DOT Level.</td>
<td></td>
</tr>
<tr>
<td>☐ Files are free of all cross sections, profiles, construction lines for design purposes.</td>
<td></td>
</tr>
<tr>
<td>☐ Files are free of annotation that should reside in the cut sheets.</td>
<td></td>
</tr>
<tr>
<td>☐ Files have clean reference attachments, only needed reference files &amp; no redundant references.</td>
<td></td>
</tr>
<tr>
<td>☐ All 3D files have lines and elements at the proper elevation (no spikes).</td>
<td></td>
</tr>
<tr>
<td>☐ Files are a 2D or 3D design model, not a sheet or drawing model</td>
<td></td>
</tr>
<tr>
<td>☐ Files contain only one model</td>
<td></td>
</tr>
<tr>
<td><strong>Coordinate Geometry</strong></td>
<td></td>
</tr>
<tr>
<td>☐ Only final alignments are included (preliminary and alternate information has been removed).</td>
<td></td>
</tr>
<tr>
<td>☐ Alignments names and descriptions are intuitive.</td>
<td></td>
</tr>
<tr>
<td>☐ Each horizontal alignment has only one child vertical alignment.</td>
<td></td>
</tr>
<tr>
<td><strong>Surface Models</strong></td>
<td></td>
</tr>
<tr>
<td>☐ Visualized breakline features and they appear to be consistent and match the 2D MicroStation file.</td>
<td></td>
</tr>
<tr>
<td>☐ Visualized breakline features, no vertical faces are present; breaklines appear to be horizontally offset.</td>
<td></td>
</tr>
<tr>
<td>☐ Visualized both the contours and triangles in a 3D file. Looked at it from the top and front, side, and isometric view. No irregular dips, spikes or voids in the surface are apparent.</td>
<td></td>
</tr>
<tr>
<td>☐ Triangles were viewed on top of the proposed design file. The triangles do not cross obvious breaklines such as centerlines, edges of pavement, edges of shoulders, etc.</td>
<td></td>
</tr>
<tr>
<td>☐ Contours were viewed to ensure the low points line up with the proposed drainage structures and structure flowlines match the proposed surface.</td>
<td></td>
</tr>
<tr>
<td>☐ If automated machine control/ guidance will be used during construction, at intersections or other critical areas, contours should be viewed at a 0.1 foot interval to ensure the model is accurate enough for automated machine control/ guidance use.</td>
<td></td>
</tr>
</tbody>
</table>
12.10 Electronic Data Definitions

3D Model – Models includes all engineering data which is geospatially positioned and graphically displayed on project related datums and are used to describe the existing conditions or proposed design of a capital project. This can include multiple DTM surfaces and related Graphics Information. The “Model” is what is generally what is referred to as the deliverable for projects which anticipate using AMG.

Automated Construction and Inspection – Automated Construction & Inspection include all technologies used for the construction and inspection of capital projects, and require the input of reliable EED to operate effectively. Examples of this may include Automated Machine Guidance, Automated Stakeout & Inspection, and Intelligent Compaction operations.

Automated Machine Guidance (AMG) – AMG uses computers and survey technology on construction equipment to automate the calculation and interpolation between a proposed digital terrain surface (or a control alignment with templates) and survey geospatial positioning. This interpolation provides visual horizontal and vertical guidance to the operator of the construction equipment. AMG is also referred to as Machine Control or Automated Machine Operations.

Automated Stakeout & Inspection – Use of computers and survey technology to automate the calculation and interpolation between a proposed digital terrain surface (or a control alignment with templates) and survey geospatial positioning. This interpolation provides horizontal and vertical guidance to the operator of the equipment, for the stakeout of proposed work or positional verification or measurement of completed work.

CAD Model (design) – Master Design CAD dgn file. The model usually consists of one dgn file (for large projects there may be more than one) that contains all of the proposed design work. There are separate models for each discipline that is doing design for the project (Highways, Traffic, Bridge, etc.) This model is referenced into the individual cut sheets and clipped to the correct size.

CAD Model (existing) - Master existing CAD dgn file. The model usually consists of one dgn file (for large projects there may be more than one) that contains all of the existing survey. This model will also contain other information such as the datum used and control tie box information.

CAD files – refers to any CAD files that are not defined as a CAD model (see above). Examples of these files would be the title sheet, miscellaneous details, detailed estimate sheet, plan sheets, etc. Plan sheets would have CAD models referenced into them but would not contain any design work in the file itself.

Digital Terrain Model (DTM) – A DTM is a digital map representation of a three dimensional topographic surface. (Also referred to as Digital Elevation Model DEM, or a Triangulated Irregular Network TIN). DTMs are visualized electronically by draping a surface over triangulated points which are generally determined along breaklines where changes occur in the slope of the surface. The points are defined geospatially by coordinates and elevation values. In the civil engineering industry, DTMs can represent existing natural terrain of the earth’s surface, or proposed terrain intended to represent a completed surface. DTMs can portray triangulated and/or non-triangulated features, shapes and solids.

Documents & Publications – Includes reports, manuals, contract proposals, specifications or other publications which record or document decisions, standards, policies, procedures or other legal requirements related to capital projects.

Electronic Engineering Data (EED) – Includes all types of design project related engineering data which is used for the defining, developing, designing, documenting, spatially locating.
constructing, and historical recording on a CTDOT Project. This includes Documents and Publications, Geospatial Data, Digital Terrain Models, and Graphics Information.

**Elements** – Elements are points or lines which are described geospatially in two or three dimensions.

**Features** – Features consist of points and lines which may be connected to form geospatial objects, and can be used to form the ground surface displayed in a DTM. Features can be either 3D triangulated (including elevations) or 2D non-triangulated (without elevation). Features store attribute information about the symbology, level, and text.

**Finished Grade DTM** – FG DTM shall include the entire proposed project surface area which will be disturbed by construction operations out to all limits of work. The FG DTM shall be a true representation of the entire finished surface that the Designer intends to be built. The outer limits of a project’s DTM shall include all disturbed/modified terrain surfaces that require excavation or fill of greater than 6” from the existing ground surface over a 1,000 sqft area.

**Geospatial Data** – This information identifies the geographic position and characteristics of natural or proposed constructed elements, features and boundaries and how they are positioned related to the earth’s surface.

**Graphics Information** – Graphical representations of project information portrayed either by raster or vector images. Files include graphical representations of points, lines or shapes, text annotation, and images. CAD files are generally in MicroStation DGN formats, and include all associated reference files. Graphics are generally published in PDF format.

**GPS** – Global positioning system, the Global Positioning System (GPS) is a space-based satellite navigation system that provides location and time information in all weather, anywhere on or near the Earth, where there is an unobstructed line of sight to four or more GPS satellites. It is maintained by the United States government and is freely accessible to anyone with a GPS receiver.

**GPS Rover** – GPS device that collects the data in the field. Typically consists of a receiver (antenna), a fixed rod and a data collector. The receiver can also be mounted to a vehicle.

**LOD** – Level of detail.

**RTK** – Real Time Kinematics, Real Time Kinematic (RTK) satellite navigation is a technique used in land survey and in hydrographic survey based on the use of carrier phase measurements of the GPS, GLONASS and/or Galileo signals where a single reference station provides the real-time corrections, providing up to centimeter-level accuracy.

**RTN** – Real Time Network is similar to RTK yet it uses a network of base stations located on maintenance garages, the internet, satellites and host server software. Though fairly new to the U.S., these types of networks have been very successful in Europe and Asia where networks span entire countries where utilization is spreading beyond surveying to mapping, utilities, emergency response, agriculture, forestry, public safety, transportation, machine control for construction, environmental, and scientific research.

**RTS** – Robotic Total Station. This equipment utilizes the same software as the GPS rovers but does not rely on satellites for locations. RTS equipment localizes to a project area by calibrating using control points set by traditional survey techniques.
12.11 Benefits

Construction operations which may produce the greatest productivity gains by the use of EED are for material excavation or placement. Construction items which optimize the efficiency and accuracy of AMG are earth excavation, fill and subbase courses. These items are all volume measured and their quantities can directly be calculated from the terrain models for the existing surface, the finished grade surface, and the top of subgrade surface.

Other construction installations which would benefit most from providing EED for stakeout and inspection verification are bridge substructures, public and private utilities, curbing, sidewalks, commercial driveways, signs, lighting & signal posts, and pile driving. Bridge superstructure and substructure layout could be modernized to provide contractors with 2D or 3D spatial descriptions (features) of all structural elements and critical control lines. This information could be used by AMG for the excavation of the footings, backfills up to finished grades, by pile drivers to position proposed pile locations, by carpenters to automate the layout and building of concrete forms, by steel workers to automate the positioning of steel supports and for installing of reinforcement, and by DOT Inspectors to verify the correct spatial locations.

Projects which do not contain 3D DTMs can also benefit from using supplied EED. Sign or guiderail replacements, or pavement striping contracts could benefit from locations derived by GIS approximated or GPS field measured 2D coordinates for positional locations. Using geospatially described locations (coordinates) or station-offsets provided by alignment files instead of record plan scaled stations and offsets will provide more clearly defined designer intent as to the location of the items.

General:
- Greater ease of design implementation at time of construction.
- Enhanced quality of constructed facilities.
- Greatly reduces the need for construction staking which in turn reduces survey costs
- Contractor and agency labor savings when measuring and documenting as-built quantities and pay-quantity management.

Design:
- Increased accuracy and data intelligence going into design.
- Enhanced visualization capabilities during the design process.
- Identify clashes and constructability issues prior to construction.
- Greater accuracy for quantity computations

Construction:
- Points or alignments of features can be used by Contractors to locate items in the field by using Total Stations or GPS/RTK survey equipment (available in CT).
- Breaklines, features and other alignments included with digital terrain models (DTMs) are used by Contractors for Automated Machine Guidance (AMG) operations. Use of GPS for AMG allows for the most efficient operation of earthwork machinery, less operator time is required for construction, idle time and rework.
- Uniform compaction
- Check constructability
- Track stage construction
- Improved Safety for the inspectors and contractor personnel
- Equipment resource savings
- Machine idle time can be reduced when there is less waiting for excavation and embankment staking and clarifications.
- Finish grading iterations are lessened or nullified because of GPS accuracy, therefore resulting in a reduction of machine hours.

- Earthwork construction tasks are shortened because:
  - Contractors can mobilize to the site and begin work without waiting for surveyors to position grade stakes for the initial lifts.
  - Checking grades and rechecking spot locations immediately versus calling and scheduling a survey crew.
  - Time saved in layout and grade checking can be devoted to machine movement and cycle time efficiency.
  - Reduction in rework - Jobsite grade and location errors are more easily spotted and corrected with GPS technology than with reliance upon 2 dimensional drawings and surveyor’s grade stakes.
  - Construction field managers can make decisions more quickly and accurately because position and grade information is provided in real time.

Construction Inspection:
- Accurate quantity take off for pay-items (point locations, areas, volumes)
- Pay-items are easily tracked
- A single person can locate and document exact x,y,z positions providing real-time verification of an item being inspected or a point location being disputed.
- Reduction of conflict resolution time.
- Electronic as-built data can be produced and easily incorporated on the electronic contract plans either during construction (“live” as-builts) or post construction.
Section 13 Project Location (Geo-Spatial Boundary or Route ID and Mileage)

A Project Polygon (geo-spatial boundary) shall be submitted to ProjectWise at project milestones of DA (Design Approval) and DCD (Design Completion Date) by the lead designer and at Construction Completion by the Inspector. The Design Approval submission will replace a cursory project polygon created at project development by the project sponsor. The DCD submission will replace the Design Approval submission at DCD. The construction Completion submission is required if the DCD polygon does not reflect the project’s completed limits. The inspector shall obtain the DCD polygon and modify the limits to represent as-built conditions if required at construction completion.

The Project Polygons will be used in the Department’s Project Web-GIS feature layer to identify spatial location, each section of State and Local Roads contained within the boundary for FHWA FMIS reporting, and future CIM (Civil Integrated Management) of roadway assets. The Project Polygon will also aid in the ROW (Right of Way) Web-GIS mapping process. The Design Approval Polygon shall not be public facing on any CTDOT Web-GIS mapping.

13.1 Project Polygon Requirements

**Capital Projects that include Location Survey**

*Note: If a project has multiple sites, a project polygon file shall be created for each site.*

Project Polygon Milestone Deliveries:
- DA (Design Approval):
  - The Project Polygon shall include the entire project extents per site and include all existing and proposed ROW boundaries and portions of local affected roads. The polygon shall be drawn up to and following the ROW lines, then it shall cross the roads at the project limits. The following figure shows a Design Approval Polygon. Note: The Polygon does not include slope limits.

![Figure 263 - Design Approval Project Polygon](image)
DCD (Design Completion Date):
  - The Project Polygon shall include the entire project extents per site and include all ROW boundaries and portions of local affected roads. The polygon shall be drawn up to and following the right of way lines. When Rights and/or Defined Easements extend beyond the ROW, these lines shall be followed. The polygon shall cross the roads at the project limits.

Construction Completion:
  - The inspector shall obtain the DCD polygon and modify the limits to represent as-built conditions if required at construction completion. See Section 8.3.7 for more detail.

Capital Projects without Location Survey
This type of project could involve, but not limited to the following:
  - Guard rail replacement
  - Rumble Strips
  - Barrier replacement
  - Pavement rehabilitation
  - Illumination
  - Signing

The project limits will be identified By Route ID and Mileage. AEC Applications will get the route and mileage from the project’s Design Report. Note: An option to get authoritative mileages for the Design Report can be to reference in a WMS (web mapping service) into Micorstatoin. See section 13.4 for instructions.
13.2 Creating a Project Polygon for Projects with Location Survey

The following steps explain how to create and submit the Project Polygon file(s). If the project consists of multiple “sites,” a separate file shall be created for each polygon.

1. Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be referenced. This can usually be found within the ground survey file title block. If there is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.

2. In House CTDOT Users: Create a new MicroStation design file using the 2D_Poly_83FT seed file located in the W: Drive. See folder address below:

   W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\n
   **Note:** If your project is NAD 27 FT still use the 83FT seed.

   ![Figure 265 – CTDOT CAD resource folders](image)

   **Consultant Users:** Download the seed files using this link: [2D_Poly_83FT Seed File](#)

3. Reference the Highway Design file into the newly created file using true scale off and 1:1

   ![Figure 266 – MicroStation reference file settings](image)
4. Verify that the tentative coordinates of this file match the referenced design (using stationing, grids, etc.). If your project is in NAD 83FT the coordinates should match and you can proceed to step 5. If they do not match check that the scale of the reference is 1:1.

If the coordinates still do not match, the project is probably in NAD 27 FT and the reference files will have to be moved so the coordinates are correct. To move the reference file do the following:
   a. Select Reference File.
   b. Select Move Reference:

   ![Figure 267 - Move Reference](image)

   c. Next when it prompts you to “Enter point to move from”, in the Key-In Box key in **XY=0,0** and click Enter.

   ![Figure 268 - Key In](image)
d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the Key-In Box key in DL=400124.9,500038.9.

Figure 269 - Move to Key In

Now the tentative coordinates of this file should match the referenced design (using stationing, grids, etc.).

5. Set the MicroStation active level to “TOOL_Prelim_Proj_Polygon” for the Project Polygon (Note: if this level is not yet available, use “SV_PARCEL_DATA”)
6. Then place a closed polygon(s) using the shape tool or the smart line tool.
7. Then turn on the fill on the polygon.
8. After the polygon has been placed, turn off all reference displays and fit the polygon to the view.
9. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml file to Google Earth.
   Do this by choosing: File> Export> Google Earth.
10. Google Earth should then automatically open and zoom to the Project Polygon(s) vicinity.
13.3 Project Polygon File(s) Submission

The Project Polygon file(s) shall then be uploaded into ProjectWise in accordance with the following:

Note: If a project has multiple sites, a project polygon file shall be created for each site.

1. Log into ProjectWise
2. Browse to your project’s 170_ROW and GIS Files folder. If this folder does not exist under the project email DOT.AECApplications@ct.gov
3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select: View>Toolbars and select interface
4. Drag and drop the file into Projectwise and use the Advanced Wizard.
5. Continue to click Next in the Advance Wizard until you get to the Attributes screen and assign the attributes.
6. Click Next until the file uploads.
7. After the files have been uploaded into Projectwise email DOT.AECApplications@ct.gov

Figure 270 – ProjectWise project polygon folder example
13.4 Project Route ID and Mileage for Projects without Location Survey

The following steps show how to get the route ID and Mileage for a project from within.

1. **In House CTDOT Users:** Create a new MicroStation design file using the 2D_Poly_83FT seed file located in the W: Drive. See folder address below:

   W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

   ![Figure 271 – CTDOT CAD resource folders](image)

   **Consultant Users:** Download the seed files using this link: [2D_Poly_83FT Seed File](#)

2. Next go the raster manager and navigate to File>Attach>WMS

   ![Figure 272 - Attaching the WMS](image)
The attach file dialogue should appear. **In-House Designers** Browse to W:\XWMS and select the Interstate Milepoints and the Non-Interstate Milepoints layer. Note this will have to be done one at a time. Then click Attach in the Raster Attachment Options Dialogue. **Consultant Designers** the WMS files can be found here: [XWMS Files](#)

![Figure 273 - Attaching WMS](image1)

![Figure 274 - Attaching WMS](image2)
4. You will need to zoom in to see the Route Numbers and Milepoints.

Figure 275 - Route and Mileage
Section 14 Project Information Management – Under Development

This section details how project locations, project assets, project asset work codes, and other project information is managed throughout the life cycle of the project. The project location and the assignment of assets to a project are managed in ATLAS. The project asset work codes and other project information is in managed in the Composite Project Database (CPD).

The first section goes over the Proposed Project Information process (PPI), which includes locating the proposed project, filling out the PPI form, and how a proposed project container in Projectwise is created.

The second section goes over how to manage the project location and project information after the proposed project receives is recommended project number.

14.1 Digital Proposed Project Information Process

14.1.1 PPI Project Location and Asset Selection

The following details how to locate a proposed project and select the applicable assets on the project using ATLAS.


2. Then at the top right of the screen click Login and enter your email and password. If this is your first time logging in, select “Click here to sign up”.

3. Next navigate to the area on the map where the proposed project is located.
4. Then click on Asset Maintenance and select Add/Edit Construction Project Work Area.

Figure 277 - Locating a Proposed Project

5. Then in the Town dropdown, select Use Work Area and click next.

Figure 278 - Locating a Proposed Project
6. Next pick how to locate the project in accordance with the following and click Next:
   - By Administrative Area — District or Statewide Projects. Stop Sign replacements, warning sign replacements, etc.
   - Related to bridge(s) and/or signal(s) — Bridge joint or bearing projects affecting multiple bridges or traffic signal head upgrades affecting multiple signal locations, etc.
   - I’ll Draw a polygon — Intersection improvement projects, bridge replacement projects, roadway improvement projects, etc. These projects could be at multiple locations.

In the example below a polygon is going to be drawn for the proposed project.

![Figure 279 - Locating a Proposed Project](image-url)

Pick the appropriate select and click Next
7. Then draw a polygon for the proposed project by left clicking. To close the polygon double click when you are on your last point. If the polygon needs to be adjusted you can redraw the polygon before you click GO.

This polygon should be drawn close to the State ROW line. Use engineering judgement for where you think the ROW line is. Future enhancements to ATLAS will have all the state ROW lines on a layer.

8. Then click Go.
9. When the polygon is drawn ATLAS will return any road segments and any assets that are located within that polygon. On the next screen deselect or select the applicable road segments and assets, then click next. By default the local roads are not selected.

![Figure 282 - Locating a Proposed Project](image)

10. Then on the next screen click Go.

![Figure 283 - Locating a Proposed Project](image)
11. On the next screen you will see the proposed project number that ATLAS assigned to the project and list of assets and road segments included in this project. Then click Done.

![Proposed Project number]

**Figure 284 - Locating a Proposed Project**

14.1.2 Editing PPI Project Location and Assets

The following details how to edit the location or Assets of a Proposed Project.

2. Then at the top right of the screen click Login and enter your email and password.

![Logging into ATLAS]

**Figure 285 - Logging into ATLAS**
3. Then turn on the Proposed Project Local Work Area layer as shown below.

4. Next navigate to the area on the map where the proposed project is located.
5. Then select the Identify tool.

6. Then draw a rectangle that includes part of the project.
7. On the next screen choose the applicable option.
   - To add or remove a road segment or asset select “Roads and Assets”
   - If the polygon needs to be extended or shortened select “Redraw Area”

8. Based on what was selected in step 7, either select or deselect the assets or redraw the polygon. Then click through the screens until the project location is updated.

### 14.1.3 Proposed Project Information Form

After a proposed project has been located a Proposed Project Information Form (PPI) will automatically be created in CPD. This section shows how to fill out this form and submit for review and approval. If you do not know the proposed project number follow section 14.1.2 and when you get to step 7 click on the CPD link. This will automatically get you to that project in the CPD.

1. Go to the CPD Website: [http://dot-sdccts303v/PW_CompositeData/MainMenu.aspx](http://dot-sdccts303v/PW_CompositeData/MainMenu.aspx)
2. Then click on Proposed Project Information.

Figure 290 - Proposed Project Information
3. Select the PPI number that needs to be updated.

![Figure 291 - Updating a PPI Form](image)

4. Next fill in any of the fields in the form and click the save project data button.

![Figure 292 - Saving Project Data](image)

When this button is clicked a Projectwise project container will be created under the 01.2 – Projects – Proposed area in Projectwise. This will take about 5 minutes to show up in Projectwise. This folder will be used to store any document during the proposed project phase of the project. This folder is also where the completed PPI form will uploaded for signature.

![Figure 293 - Proposed Project Area in Projectwise](image)
5. The following steps show how to complete the PPI form for capital planning. Note: If an asset needs to be added or removed this must be done in ATLAS. Go to ATLAS by clicking on the ATLAS Link.

![Figure 294 - Updating Assets for a PPIF]

6. First fill out the General Information.

![Figure 295 - PPI Form General Area]

7. Then fill out the Environmental Classification, Cost Estimate Information, Schedule Information, and add any comments.

![Figure 296 - PPI Form]
8. Then verify the proposed road section information. If information needs to be edited, click on Select and edit the information.

<table>
<thead>
<tr>
<th>Route/Road</th>
<th>State/Local</th>
<th>MP Start</th>
<th>MP End</th>
<th>Miles</th>
<th>ADT</th>
<th>Interstate</th>
<th>Func Class</th>
<th>NHS</th>
<th>Towns</th>
<th>MPO</th>
<th>COG</th>
<th>Urban Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select GRISWOLDVILLE AV</td>
<td>Local</td>
<td>0</td>
<td>0.06</td>
<td>0.06</td>
<td>6700</td>
<td>N</td>
<td>5</td>
<td>N</td>
<td>Newington</td>
<td>Capital Region</td>
<td>Capital Region</td>
<td>Hartford, CT Urbanized Area</td>
</tr>
<tr>
<td>Select LOUIS ST</td>
<td>Local</td>
<td>0.476</td>
<td>0.51</td>
<td>0.034</td>
<td>N</td>
<td>N</td>
<td>7</td>
<td>N</td>
<td>Newington</td>
<td>Capital Region</td>
<td>Capital Region</td>
<td>Hartford, CT Urbanized Area</td>
</tr>
<tr>
<td>Select 15-N</td>
<td>State</td>
<td>74.704</td>
<td>74.956</td>
<td>0.162</td>
<td>35100</td>
<td>N</td>
<td>3</td>
<td>Y</td>
<td>Newington</td>
<td>Capital Region</td>
<td>Capital Region</td>
<td>Hartford, CT Urbanized Area</td>
</tr>
<tr>
<td>Select 15-S</td>
<td>State</td>
<td>74.785</td>
<td>74.964</td>
<td>0.169</td>
<td>16600</td>
<td>N</td>
<td>3</td>
<td>Y</td>
<td>Newington</td>
<td>Capital Region</td>
<td>Capital Region</td>
<td>Hartford, CT Urbanized Area</td>
</tr>
<tr>
<td>Select 174-N</td>
<td>State</td>
<td>0</td>
<td>0.076</td>
<td>0.076</td>
<td>14300</td>
<td>N</td>
<td>4</td>
<td>N</td>
<td>Newington</td>
<td>Capital Region</td>
<td>Capital Region</td>
<td>Hartford, CT Urbanized Area</td>
</tr>
<tr>
<td>Select S-N</td>
<td>State</td>
<td>27.204</td>
<td>27.366</td>
<td>0.162</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Newington</td>
<td>Capital Region</td>
<td>Capital Region</td>
<td>Hartford, CT Urbanized Area</td>
</tr>
</tbody>
</table>

Figure 297 - PPI Form Road Section Area

9. Then fill out the Asset information. Select if there is a pavement treatment and enter any bridge work codes if there is a bridge on the project by clicking on Select next to the bridge.

**Assets**

**Pavement Treatment:**

- Yes
- No

**Bridge Assets**

<table>
<thead>
<tr>
<th>Bridge No.</th>
<th>NBI</th>
<th>Culvert</th>
<th>Length (ft)</th>
<th>Suff. Rtg</th>
<th>Struct. Def.</th>
<th>Func. Obsol.</th>
<th>Work Type</th>
<th>Work Codes</th>
<th>No.</th>
<th>CC Date</th>
<th>Wk. Type</th>
<th>Wk. Codes</th>
<th>No.</th>
<th>FDP</th>
<th>ECC Date</th>
<th>Wk. Type</th>
<th>Wk. Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>DP309</td>
<td>Yes</td>
<td>No</td>
<td>127</td>
<td>93.7</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Traffic Sign Assets:
No Signals were found

Sign Structures:
No Signs were found.

Figure 298 - PPI Form Asset Area

10. After the form is completed print the form to PDF. First click on the printer and then print.

Figure 299 - Printing to PDF
11. Then select the Bluebeam Printer and click Print.

![Figure 300 - Printing to PDF](image)

12. Then save the file to your computer.

13. Next open the file and add the following four signature fields for approvals.

![Figure 301 - PPI Form Approval Area](image)

14. Then upload the PPI form into the corresponding proposed project folder in Projectwise. Fill in the label and description attribute fields with PPI Form for the label and a project description in the description field.

![Figure 302 - PPI Form Upload](image)

15. Next have the form digitally signed by the submitter, Principal Engineer, Manager, and Engineering Administrator by sending a Projectwise link to the PPI form.
14.1.4 Proposed Project Document Storage

All documents created during the proposed project stage shall be stored under that proposed project’s container in Projectwise in the 01.02 – Projects – Proposed area.

Figure 303 - Proposed Project Area in Projectwise

After the proposed project moves through the Recommended Project Memorandum (RPM) process and an official project number is assigned to that project, all the documents in the proposed project area shall be moved to the 600_Project Initiation Documents folder under the project container in the 01.0 – Projects – Active area in Projectwise.

Figure 304 - Project Initiation Documents in Projectwise
14.2 Project Asset Form (PAF) – Under Development

The project asset form (PAF) is used to manage project information after the RPM process through construction. This form manages the following information:

- Project Assets through the use of ATLAS
- Project Asset Work Codes

At RPM the Project Assets and Asset work codes will be transferred to the PAF from the Proposed Project Information Form (PPIF).

The PAF is required to be continuously updated as changes happen through the duration of the project.

The following details how to update the PAF.

1. Go to the CPD Website: [http://dot-sdcotts303v/PW_CompositeData/MainMenu.aspx](http://dot-sdcotts303v/PW_CompositeData/MainMenu.aspx)
2. Then click on the Project Asset Form Button:

![Figure 305 - Project Asset Form](image)

3. Next pick the project that needs to be updated:

![Figure 306 - Project Asset Form](image)
4. Then update the Project Asset Area in accordance with the following:
   - Updating Asset Works Codes: Click on Select next to the appropriate asset and then fill in the work codes.

   ![Figure 307 - Asset Work Codes](image)

   Figure 307 - Asset Work Codes

   - Adding or Removing an Asset from the Project: Send an email to DOT.AECApplications@ct.gov detailing the asset and if it is added or removed.

5. After the PAF has been updated click on the Save Project Data button at the top right of the form.

   ![Figure 308 - Project Asset Form](image)

   Figure 308 - Project Asset Form
Appendix A - Initial Bluebeam Settings

Initial Log into Bluebeam
These steps only need to be completed the first time using Bluebeam or when the user logs into a new computer.

1. Open Bluebeam by selecting the desktop icon:

2. Then Open Bluebeam by double clicking on the shortcut.

3. Click on REVU in the top left hand corner and click Preferences as shown below. If you cannot find the settings icon in the top right, go to the Edit menu and select Preferences.

![Figure 309 - Bluebeam Preferences](image)
4. Set the General options first.

Figure 310 - General Options

5. Click on Interface and then File Access and make sure the box is checked as shown below: If ProjectWise is not listed click the plus sign, click Load, enter your Projectwise Username and password and click OK.

Figure 311 - Projectwise Integration
6. Next go to the Window option and select WebTab. Then uncheck the box below.

Figure 312 - Bluebeam Preferences
Downloading the CTDOT Bluebeam Profile

1. Download this file and save it to your desktop: CTDOT Bluebeam Profile
2. Double click on the profile in the zipped folder on your desktop.

![Double click on this file](image1)

**Figure 313 - Importing the Bluebeam Tools**

Bluebeam Stamps

The following steps are for CTDOT Engineering only.

1. Select Markup>Stamp>Change Stamp folder as shown below:

![Change Stamp Folder](image2)

**Figure 314 - Changing the Stamp Folder**

2. Next browse out to this folder on the X: Drive and select your discipline

   \`X:\\V8_Admin\Bluebeam Resources`
3. Now your unit’s stamps will be available for use when Markup>Stamps is selected:
Appendix B - Usability of PDF Documents

Usability of PDF Documents
This section contains information about viewing digital contract documents.

Structure of Digital Plans

Final Design Plans, Addendums, and Design Initiated Change Orders

The contract plans are split up into discipline subsets, which are multiple sheet PDF documents digitally signed by the Designer. Addendums and Change Orders are also submitted as discipline subset, with only the changed sheets. For example, an Addendum that affects the 03-Bridge Subset will require the submission of a 03-Bridge_A1 subset.

Digital Plans are located in the 100_Contract_Plans folder in Projectwise. Below is an example of a project’s discipline subsets in Projectwise:

<table>
<thead>
<tr>
<th>Label (Set Defined)</th>
<th>Description</th>
<th>Main Category</th>
<th>Sub-Category</th>
<th>Sub-Category Description</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>002_General</td>
<td>01_General_rev.pdf</td>
<td>CON</td>
<td>FPL</td>
<td>Plans_01 - Final Plans (Adj)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>002_Infrastructure</td>
<td>02_Infrastructure.pdf</td>
<td>CON</td>
<td>FPL</td>
<td>Plans_02 - Final Plans (Adj)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>002_Highway</td>
<td>03_Highway_A01</td>
<td>CON</td>
<td>ADF</td>
<td>Plans_03 - Addenda</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>003_Highway_A01</td>
<td>03_Highway_A01.pdf</td>
<td>CON</td>
<td>PPS</td>
<td>Plans_03 - Final Plans (Adj)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>004_Hydraulic</td>
<td>04_Hydraulic.pdf</td>
<td>CON</td>
<td>ADF</td>
<td>Plans_04 - Final Plans (Adj)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>005_Landscape</td>
<td>05_Landscape_rev1.pdf</td>
<td>CON</td>
<td>FPL</td>
<td>Plans_05 - Final Plans (Adj)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>006.Structures</td>
<td>06_Structures.pdf</td>
<td>CON</td>
<td>FPL</td>
<td>Plans_06 - Final Plans (Adj)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>007_Highway.Std</td>
<td>std_Highway_A1.pdf</td>
<td>CON</td>
<td>STD</td>
<td>Plans_07 - Standard Drawings</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>007_TRAFFIC.Std</td>
<td>std_traffic_rev.pdf</td>
<td>CON</td>
<td>STD</td>
<td>Plans_07 - Standard Drawings</td>
<td>Acrobat PDF</td>
</tr>
</tbody>
</table>

Figure 317 - Discipline Subsets in Projectwise

As-Built’s

As-built’s will be placed directly on the PDF Subsets using Bluebeam.

Functionality of PDF Digital Plans

The PDF digital plans have the following functions when the digital contract plans are created in accordance with this manual:

- Turn levels on and off
- Search for all text on the documents.
- PDF plans are measurable
Digital Plan Levels

The plans have the ability to have their levels turned off and on. This can allow for easier viewing of the contract sheets. See below for turning levels on and off:

![Figure 318 - Turning Levels On and Off](image-url)
Searching Digital Plans

The plans can be searched for any text located on them. This can be useful if searching for a certain pay item.

See below for searching the PDF Plans for text.

Figure 319 - Searching for Text in PDF Plans
Measuring on the Digital Plans

The plans have the ability to be measured in PDF. This is helpful because a paper set does not need to be created for on desk measuring.

See below for measuring in PDF.

Figure 320 - Measuring Tool
Digital Specification

The FDP specification package will be one PDF document and located in the 110_Contract_Special provisions folder. This package includes all special provisions, Notice to Contractors, Wage information, etc.

The Addendum special provisions prepared in the same way as the FDP specification package and will also be located in the 110_Contract Special provisions folder.

The Design Initiated Change Order special provisions will be contained in one PDF document located in the 110_Contract Special provisions folder when they are released to the Contractor.

Some useful features on the digital specification package are:

- Search for any text in the document, see Searching Digital Plans
- Bookmarks for each section in the specification package

Figure 321 - Bookmarks in the Spec. Package
Document Compare Tools

Bluebeam has the two tools for comparing documents: (1) Compare Documents and (2) Overlay Pages. Compare Documents will compare two documents and create a third document that clouds all the changes. Overlay pages will create a third document where the pages of document A will become one color and the pages of document B will become another color. When the pages are overlaid you will be able to see the changes from the difference in these two colors. Both of these tools can be used for single and multipage PDF documents. The following shows how to perform a document compare and how to use the overlay page tool.

Document Compare

1. Open the Revised document first and then open the original document that you want to compare from Projectwise or your computer.

2. Next go to Document>Comparison>Compare Documents as shown below:

3. In the window that pops up you will notice the two documents that were just opened. Click OK to run the document compare as shown below:

Figure 322 - Compare Documents
1. Open the Revised document first and then open the original document that you want to compare from Projectwise or your computer.

2. Next go to Document>Comparison>Overlay pages as shown below:

3. In the window that pops up you will need to select which pages of each document you want to overlay. To do this double click on a file, then in the window that pops up type the pages you want to overlay. The example below shows pages 1-28. Once you select the pages you want to overlay click OK.
To set which pages to overlay double click on a file

Type in which pages to overlay then click OK
Appendix C - Using the Set File

Note: Steps 1-5 of Appendix A must be followed to create and use the Set File feature in Bluebeam.

Opening the Set File

Double click on the set file from Projectwise and open as shown below: This may take a while please be patient. Note: The first time opening a set file will take longer than any subsequent times.

Viewing the Plans Sheets within a Set File

All the plans sheets will be combined and shown on the left hand side of the screen in a thumbnail view. To view a sheet, simply click on that sheet and it will open up.
Marking Up a Set File

1. Open up the set file. You will notice on the left hand side of the screen will be thumbnails of all the sheets in the set file.

Figure 329 - Sheets in the Set File
2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it. You will notice that sheet opens up on the right:

Figure 330 - Marking Up a Sheet
3. Next to markup the document we must unlock it (Check Out of Projectwise). To do this, right click on the lock and select Check Out.

![Checking Out a Document](image)

**Figure 331 - Checking Out a Document**

4. Notice the lock changes to a Check and you will be able to markup the document.

![Checking Out a Document for Editing](image)

**Figure 332 - Checking Out a Document for Editing**
5. To mark up the plans use the tools located in the tool chest shown below:

![Figure 333 - Marking up the Plan Sheets](image)

- Click on the tool chest
- Markup the plans using the CTDOT As Built Tools
- As Built Example

**Figure 333 - Marking up the Plan Sheets**
6. When finished, click Save and then right click on the Check and select “Check In”.

Figure 334 - Saving Markups and Checking Into Projectwise
Searching a Set File

The Set feature in Bluebeam allows you to search across the entire set file. The following shows how to search a set file:

1. Click on the Search Set file icon and then type in what you want to search for as shown below:

![Image of Bluebeam interface with search set file function highlighted]

**Figure 335 - Searching the Set File**
Printing the Entire Set File

Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions. Printing the entire set will print all the sheets in the set file. Printing the latest revisions will print the most up to date sheets and not print the previous revisions. Printing the previous revisions will only print the sheets that were changed by a revision.

The following shows how print a set file:

1. Select the print set file icon and select the desired option:

Select the arrow on the print icon and select the desired option.

Figure 336 - Printing a Set File
Appendix D – Consultant Submittal Review Stamps

Consultant Designers can import the Bluebeam User Profile using the following link. This profile imports all the commenting tools in the correct format.

Download the profile from this link: CTDOT Bluebeam User Profile. Just double click on the file located in the zip file and the profile will be imported.

After the profile is imported the following must be done:

1. Delete the Submittal Review stamp that is in the tool chest as shown below:

   ![Image](image_url)

   **In the tool chest select the Submittal stamp and click the delete icon**

2. Next Consultant Designers will need to save the following stamps to their computer and edit it to add their company name and address. The following will show how to do that:

3. This file contains the Designer’s Review stamp and Action Stamp. Save these stamp files to your computer in a folder somewhere called Blubeam Stamps. Note: The stamp files will be a PDF- Consultant Submittal Review Stamp
4. Open the stamp files using Bluebeam.

5. Update the Company Name and Address on both the Action stamp and the Designer’s Review stamp as shown below:

After the company name and address is updated it should look like the following:

Figure 338 - Updating Stamp for Company Name and Address

Figure 339 - Updated Stamp
6. After the stamps have been updated click save.
7. Next go to Markup>Stamp> and Select Change Stamp Folder.

8. Browse out to where the stamps had been saved and click OK:

9. Now when you click on Markup>Stamp the stamps will be in the list.
10. Next go into the tool chest and open the “Recent tools” as shown below:

![Figure 342 - Bluebeam Recent Tools](image)

11. Now place the stamps on any PDF document by selecting it in Markup>Stamp as shown below:

![Figure 343 - Placing a Stamp in Bluebeam](image)
12. After the stamps have been placed you will see them in the recent tools. Drag them from the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown below:

In the tool chest drag the recently placed stamp and drop it into this tool bar

Figure 344 - Adding the Custom Stamp to the Tool Chest

13. Then Save Profile so the stamps will always be in the Tool Chest.

Go to View, then click on the arrow and then save profile

Figure 345 - Saving Bluebeam Profile